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OneConnect Administration

Access OneConnect

This article explains how to access OneConnect -

OnePlan's integration platform.

To access OneConnect, navigate to https://
my.oneconnect.ai/. The login process will be the

same as your OnePlan account.

OneConnect Terminologies

This article provides a list of essential terminologies

used within OneConnect.

Term Definition
Tenant A Tenant is a term
used to describe
an Office 365

Organization.

Consists of two
points of connection
(Connectors), an
integrator, and at
least one strategy.

Integration

A web service that
can be considered
as middleware.
Basically, the
automated process
to bring

the two programs/

Integrator

connections together.

Notes

When you're
logged into
OneConnect,
the list you
see are all of
the
Integrations
deployed for
your Tenant.

For instance,
if a customer
has a specific
business
requirement
that is out of
the standard
use-case for
an
Integration,
an Integrator
could be
created to
accomplish
the task.

Term

Connector

Connection

Source
Connection

Definition

A section within an
integration that allows
users to access the
program by using a
method of
authentication.
Additional settings
and features may be
available as well
within the Additional
Options dropdown.

A Connection

is an instance
of a Connector.
They contain
Authentication
information for a
Connector in an
Integration.

A source connection
is the location of
where the data is
being grabbed from.
A source connection
can change based
on the strategy

that is being used.
OnePlanPublish
strategy has the
source connection of
OnePlan. l.e., We are
grabbing the values
within OnePlan and
bringing them into
the other program
the integration is
connected to.

Notes

E.g. the
SharePoint
Connector
has
Operations
that can
perform the
following
actions: Get
List ltems,
Create List
Items.
Operations for
Connectors
will vary for
each product,
but typically
there are
common
Operations so
that any given
Connector
can be linked
together for
an Integration
to perform
work.

@ OnePlan
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Term

Destination
Connection

Schedule

Strategy

Scheduled
Strategy

Event

Operation

Definition

A destination
connection is the
location of where the
data is being brought
into. OnePlanPublish
strategy has

the destination
connection of any
program other than
OnePlan. l.e., We are
grabbing the values
from the source
connection (OnePlan)
and bringing the
values into the other
program (destination
connection).

A Schedule defines
when a Strategy
should run. They can
be configured to run
hourly, daily, weekly,
monthly. You can also
specify specific times,
and days of the week.

A strategy is a set of
operations combined
to complete an action.
No action is taken

on these sets of
operations; however,
they can be a useful
tool to assist with
debugging errors that
may occur.

A scheduled strategy
is a strategy that

will run either
automatically on
scheduled intervals or
can be run by using
the lightning bolt icon
with the value of *
(asterisk) within the
Item ID field.

An eventis a
strategy that has
been triggered either
through OnePlan, or
by using the lightning
bolt icon with a
value other than *.
Most often the value
entered should be
related to a Plan

ID from the Source
connection.

An Operation

is defined in

a Connector or
Integrator, and is
used to perform a
specific task.

Notes Term

Incremental
Deltas
Full Deltas

E.g. sync'ing

ServiceNow

incidents to a

SharePoint

list. Or

sync'ing

Visual Studio Filters

Team

Services

epics to

Project Online

projects.
Field
Mappings
ltem
Mappings

E.g. getting a

list of projects

from Project

Online.

Definition Notes

Some strategies have
the capacity to bring
in items that have
been modified within
a window of time,
this can be seen

in Azure DevOps,
Project for the Web,
Smartsheet, etc. The
modified date must
be available to be
queried at the “plan
level”, if the plan
does not have a
modification date,
then it will not be
picked up by the
strategy.

Some strategies do
not have the capacity
to query a modified
date for their items
due to the nature of
the integration. This
can be seen in both
SQL, and Tabular
Data integrations.
Even if the strategy
is marked to run only
incrementally, the full
strategy will be run.

Filters for scheduled
strategies and events
are in different
locations. If a filter for
a scheduled strategy
is set, and the
strategy is then run
as an event, the filters
previously set will not
apply in this case.

This is how
information is going
to transfer from

one program to the
other. Only a single
mapping can occur
at a time, this
means | cannot map
the same value to
multiple locations in
the other program or
vice versa.

This is a collection
of tables that will
show where plans
and tasks from

one program are
connected to within
the other program.
This can appear as
a GUID, or as plain
text.

12
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Term

Relay

Legacy
(Basic)
Authentication

Modern
Authentication

Multi-Factor
Authentication
(MFA)

Definition

Can be thought

of as a software
application that can
securely expose other
services within a
clients’ network to
the public cloud. A
relay should only be
used for clients who
have programs that
are not accessible via
the internet. If the
clients’ employees
require a VPN to get
into their company’s
program, there is a
high probability that
they will need a relay.

Legacy authentication
is the process/ability
to log into a site using
only a username and
password.

Modern
Authentication is the
process/ability to log
into a site using
additional credentials
beyond username
and password. Most
commonly seen as

a Client ID &amp;
Client Secret, this
provides an additional
level of security and
is also considered

as more secure than
traditional username
and password
combinations.

Multi-Factor
Authentication is
considered a multi-
step login. If

the username

and password are
correctly entered,
then an extra step
must be taken for the
login to be processed
successfully. Because
of this, OneConnect
does not support
accounts that have
MFA to be used
within the integration.

Notes

For more
information,
see Whatis a
Relay?

Get Around the OneConnect
Home Page

This article provides an overview of the
OneConnect home page.

Integrations | 0ssive |
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Navigation Ribbon

The navigation ribbon is located at the top of the
screen.

From left to right, the icons and menus are as
follows:

1. Office.com Waffle Icon El: Click on this waffle
icon to go to Office.com.

2. OneConnect Logo [EEESINE: Click on the
OneConnect logo to go to my.oneconnect.ai
(return to home).

3. OneConnect Group Menu Sl Click on
the drop-down to access a list of OneConnect
groups that you have access to.

* Add Group: Click to create a new
OneConnect group.

» Other Groups: Click to connect to a different,
existing OneConnect group.

4. Settings Icon E: Click to access the
OneConnect settings menu.

» Settings: Click to update OneConnect
settings.

« Users: Click to add and manage users in
your OneConnect group.

» Alerts: Click to set up alerts/notifications.

» Apis: Click to manage the Api settings.

* Relays: Click to manage the Relay settings
for your OneConnect environment.

5. Help Icon : Click to access OneConnect help
content. When you click the Help icon, a drop-
down menu will open:

» Get Training: Click to go to the Integration
section of the support portal.

* Get Support: Click to go create a new
Zendesk ticket or request.

@®OnePlan 13
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6. User Profile BES®E: Click to access the User
Profile drop-down menu.
* Log out: Click to log out of the current
account.
» Switch account: Click to switch to a different
account.

Strategy Dashboard

Once logged into OneConnect, you will see your
Strategy Dashboard. The Dashboard will give a
synopsis of the number of scheduled strategies
running in your OneConnect environment, which
are then broken down into the state of their last
scheduled run. The states available are Success,
Processing, Failure, or Pending.

D4,
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» Success: The number of strategies that have run
successfully.

* Processing: The number of strategies that are
currently running.

* Failure: The number of strategies that have
failed.

* Pending: The number of strategies that are listed
in the Schedules page but have yet to be run or
are marked as disabled.

Integration List

Beneath the Dashboard will be the integration list.
This is every installed integration that has been set
up in your environment/group. Each row indicates
its own separate integration.

9

Each integration list item will have:

1. lcon Pair @ B: This will list the Icons of
the Programs that are involved within the
integration.

2. Integration Title orfirzndsmasteet - The title of
the integration. The title is normally generic;
however, the title can be customized while
inside of the integration.

3. Enabled Status @: This indicates if the
integration is enabled or disabled.

4. Schedule Status @: This indicates if the
strategies have run successfully or not.

5. Edit Icon < : Click to view and edit the
integration properties. You can also edit the
filters, schedules, mappings, and more.

6. Schedule Icon =: Click to view and edit the
integration properties, opened to the Schedules
page.

7. Delete Icon : Click to delete the integration
from OneConnect.

OneConnect Settings

This article explains the OneConnect setting
options.

General Settings

..............

1. Here is where the Microsoft Global Admin can
Grant Admin Consent for the organization and
their users for the use of OneConnect (specific
integrations might require further consent).

2. The name of the OneConnect group can be
changed.

3. The time zone can be applied here.

Users Settings

Within this tab, the list of individual users/accounts
that have been granted access to the individual
OneConnect group will show here. Any individual
who has Administrator access can add users, view
access requests, change the role of each user, and
remove access to the group.

Alerts Settings

.......
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If specific users wish to be notified on failed
strategies, add the email, and click on the On
Failure toggle so the toggle shows as blue,
then click Apply. See Enable Job Failure Email
Alerts [18] for more information.

Manage Integration Mapping
Settings

Anything that has to do with syncing information
between the two programs in question will be found
here.

OnePlanand Project for theWeb .~ oneln ( 1 ) Qhuﬁ ...........
Connect Onetan o rectfor the Web ithProjcts nd Tsks

Filters (for events)

The filters page located in the Mappings dropdown
is specifically only for events. Events are triggered
either through the Connected Systems icon within

OnePlan, or by inputting a plan id when running a

strategy.

When filtering on a field, that field MUST be
mapped in the Field Mappings section.

FiltrExpression

Tables

This section will show the tables that are mapped
between the two programs. This is done in the
backend and cannot be modified.

Table Mappings

£ Prfectons ne O i

Fields

Field Mapping is where you specify which values in
one program go to the other program, and if that
data only flows in one direction, or bi-directionally
between the two programs. Field mappings are
usually broken down between their respective
tables (this can be resources, plan level items,
backlog level items, etc.).

Each section can have their own fields to be
mapped. It is currently not possible to map one
value to multiple locations on the same table.

Each column represents a single program within
the integration. The dropdown options will give

the program field name that is desired to map to
the other program field name. For the values to
transfer correctly, the values need to match the
other programs options. To control the direction/flow
of data, click on the arrows in between the fields
until the desired direction has appeared.

,,,,,,,,,,,,,,

Items

To see which plans from program one are
connected to program two, this is where you can
see the connection. Depending on the integration,
there is the ability to connect items manually
between the two programs, or to delete a mapping
from no longer being synchronized. This can be at
both the Plan level and the Backlog level.

The number in each column represents the Plan Id
(or equivalent) for that column's program.

@®OnePlan 15
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Item Mappings

Values

Most programs have different names for similar
values (Not Started vs. New for example). To
ensure that the value will come over from both
programs without errors, value mapping is a go to
spot to change New in program one to Not Started
in program two (and vice versa) so when syncing
the values back and forth, there will be no issues.

K

NOTE

Values that are being edited/
modified need to be mapped in the
Field Mappings section.

For the value mapping, there will be two columns
(each column represents a program in the
integration), and within each column there are their
own set of sections (these sections imitate the Field
Mappings setup).

Take note of which field you wish to modify and
navigate to the appropriate section and click on the
blue plus button to create a new value mapping. A
new window will appear.

The Field dropdown will reflect the column/program
options.

The Source Value text field will be manually
entered. Please note that these values will be case
sensitive.

The Destination Value text field will be what the
second program receives as the new value. This
value is also case sensitive and must be a valid
option for the second program.

Value Mappings

Manage Integration Schedules
Settings

This is where you can set any available strategy
for the integration to run on a schedule. Some
integrations will pre-populate the most common
schedules in use, while others do not. Please
navigate to the information page of your integration
to find out which options are available to you for.

0000000
0000000

0000000

Edit the Schedule

To edit a strategy, click on the Pencil Icon to open
the Edit Strategy window. From here you can:

* Enable or Disable a strategy from being
scheduled.

» Set the Schedule Type: Hourly, Daily, Monthly,
or None.

+ Days of Week the strategy will be executed.

* The Times of Day the strategy will be scheduled
to begin.

» The Time Zone the strategy would trigger at.

» The Delta Type: Full sync, or Incremental sync.

» Deltas Range will determine how an incremental
sync will grab data.

Apply Filters to the Schedule

Filters will limit which plans will be processed and
brought over to the other program. If a filter is to be
used, the field being filtered MUST be mapped in
the Field Mappings section.
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Look at Logs for the Schedule

One way to see the logs of the scheduled strategies
is to click on the log icon.

Execute a Strategy At-Will

If you wish to run the strategy at-will, click on the
lightning icon, and then click execute.If desired,

the strategy can be run against a single item (also
known as an event). Click on the lightning icon, and
within the text box, add the Item Id, and then click
execute. Please note that events do not follow the
same filters as a scheduled strategy.

Remove the Strategy from the
Schedules List

To remove the strategy from the Schedules list,
click on the Trash Icon. This will not delete the
strategy from the integration. To re-add the strategy
to the Schedules list, click on Add Schedule.

Add Another Strategy to the
Schedules List

Click on Add Schedule, to choose what strategy is
desired to add to the list. From here the strategy
settings can be set and click Save.

Review Your Logs

You can see the logs of the scheduled strategies is
to click on the log icon.

Review Integration Logs

This article explains how to view the event logs and
schedule logs for an integration in OneConnect.

The Logs tab in the OneConnect Admin Center

is where you can find out more information on
your strategies, especially if a strategy has failed.
When a strategy fails, if notifications are set up
for the clients OneConnect group, the people on
the notification list will be emailed that one of their
strategies failed.

Strategy Status Meanings

When reviewing integration logs, there are three
statuses captured for when a strategy runs:
Failure, Success with Exceptions, and Success.
The following table details what each of these
statuses means.

Status Value Description

No items have been processed. Strategy
failed before processing data. Please
review logs for additional insights into the
failure.

Failure

Success with
Exceptions

Some but not all items were successfully
processed. The logs include the list of
items that failed to process. If the same
item has failed multiple times in a row, it
is encouraged to process that item as an
event to gain further insights into why the
plan item has failed.

Success All items were processed without failure.

Complete success.

Statistics Logs

This page gives the number of times the jobs
(strategies) have run for the entire lifecycle of the
integration. The duration of the jobs. the average
runtime. The number of items, tables and rows that
have been processed. The overall % of successes
vs. the overall % of failures.

Event Logs

This page shows the logs of all the strategies

that have run on a specific plan(s). Often, this is
done through the Connected Systems icons within
OnePlan or when a specific plan id is used when
using the Lightning Bolt Icon within the Schedules
tab. Logs are kept for 3 days. When an event fails,
no email notification is sent out.

Schedule Logs

This page will show all the scheduled strategies
that have run over the past 3 days. Scheduled

logs occur when the strategy runs on the intended
schedule, and if using the Lightning Bolt icon in
Schedules tab (and no plan id is entered in the text
window).
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Project Online to Jira Project Oiine m o sra

>>>>>>

Reinstall
Strateqy state Sawso % Complete

""""" S —— Uninstall
If you wish to uninstall the integration from the
o OnePlan group, this is where you can start the
process. This is a self-automated process, all that
is needed is to click the Start button.

Manage Integration Advanced o e & -
Settings
This article explains the advanced integration -
settings in OneConnect.
=1
OnePlan and Project fortheWeb ~~ ~  OnePlan G) mwmm.mmh

R == Enable Job Failure Email Alerts

ddddddddd This article explains how to enable alerts in
OneConnect to send a message when a job runs

into a failure.

nmx
Migrate NOTE
If a client wishes to move an integration from one You must have Admin privileges to
OneConnect group to another, they can change the enable this feature.

OneConnect group from the Groups dropdown, and
then select Migrate.

The list of available OneConnect groups is

dependent on if they are added to the OneConnect 1. In OneConnect, select the Settings icon kil >
Alerts. The Alerts settings will open.

group.
2. In the Emails field, enter the email address of
N all users who should receive integration Failure
,,,,,, alerts.
. 3. Toggle the On Failure switch to Enabled.
‘ 4. Click Apply.
e - o,

|
Reinstall =

Sometimes errors occur during setup, and a
reinstall is necessary. No further steps are needed
besides clicking the Start button. The process is
self-automated from there.

18 @®OnePlan



Integrations

What is a Relay?
About

The Azure Relay service facilitates hybrid
applications by enabling you to securely expose
services that reside within a corporate enterprise
network to the public cloud, without having to
open a firewall connection, or require intrusive
changes to a corporate network infrastructure.
Relay supports a variety of different transport
protocols and web services standards.

The relay service supports traditional one-way,
request/response, and peer-to-peer traffic. It
also supports event distribution at internet-scope
to enable publish/subscribe scenarios and bi-
directional socket communication for increased
point-to-point efficiency.

In the relayed data transfer pattern, an on-premises
service connects to the relay service through an
outbound port and creates a bi-directional socket
for communication tied to a particular rendezvous
address. The client can then communicate with the
on-premises service by sending traffic to the relay
service targeting the rendezvous address. The
relay service then "relays" data to the on-premises
service through a bi-directional socket dedicated

to each client. The client does not need a direct
connection to the on-premises service, it is not
required to know where the service resides, and
the on-premises service does not need any inbound
ports open on the firewall.

For more information, click here.

Requirements

A server will need to be setup inside your network
(or possibly in your DMZ) that will host the WCF
relay application. The minimum specs for this
server are:

» Windows Server 2016 (Virtual or Physical)
* .net4.6.1

» 2 cores, 8gb ram

32 gb hard drive

Outbound to the following ports: 5671, 9350, 9351,
9352 (TCP)

IP addresses will be provided before the
installation.

Using an internet proxy is acceptable.

Relay Installation

This article explains how to install OneConnect
relays. See What is a Relay? [19] for more
information on relays.

Relay Download

1. Log into OneConnect.

2. Click on the Gear icon. This will expand the
available settings options.

3. Select Relays. A page with all the available
relays is made available.

4. Click on the toggle to include the integration
programs that will be used.

K

NOTE

If the integration includes
OnePlan, there is usually no
need to include the OnePlan
side. However, please feel
free to contact your support
team to find out if the OnePlan
side to the relay is needed.

5. Click Download.

Download Notice

The Relay Agent installer that is generated may
need to be “unblocked” after downloading to avoid
security warnings.

To “unblock” a file, right-click it in Windows
Explorer, choose Properties from the context menu,
check the Unblock checkbox in the lower right-
hand corner of the resulting dialog, and click OK

or Apply.
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ie] OneCannectConnectorsRelay.Agent | =| 2]

Select Installation Folder ¥ 4 )

The installer wil ivstall DneConnect Conneclors. Relay. Agent to the following foldsr
To instal in this folder, chek "Nesd". To install to & diferent folder. enter it below or click "Browse"".

Type of fie;  Compressed {ppped) Folder {zip) Foder
: with = oy E [E:\ngm\FIe9\\»\-";:|esoﬁ\DmE‘mm.EMm.Hebyﬁgem\
Location [

Sre 216 MB (22 573,300 bytes)

Sire on sk 215 MB (22 653 B48 bytes)

Created Testerday. Ocicber 28, 2015, 25457 FM

Wcifiued Tesenday, October 25, 2015, 25527 FM

Pocwssed:  Yeglerday, Octobar 28, 2019, 25527 PM 7. Click Next.

Atbuss.  [Readonly [JHdden S 4

Secuty T Fi - ties i Aol =l Confirm Installation
compuber and might be ook ed 1o iy
sl proted thes compader

The installer is ready bo nstall OneConnect Connechors, Felay Agent on wour computes
Chick "Meod™ o stait the instalation.

& [ | ]

Relay Installation

1. Extract contents of
OneConnect.Connectors.Relay.Setup_{versi
on & date}.zip.

2. Open folder of extracted zip.

3. Run
OneConnect.Connectors.Relay.Setup.msi.
4. Click Next.

M OneConnect.Connectors Relay.Agent | =[]

OneConnect. Connectors Relay Agent Setup Wiz. ..

Welcome to the f.)
o

The instalier will guide vou thiough the tleps reguined to instal DneConnect Cornecton: Rielay Apent
o polx compuies

WARNING: Thés compabes program i protecied by copyeght law and inbssmational reatiss.
Unasudhorized duplbcation o detsbution of this program, o any portion of i, may resull in severs civl
L th ¥ peossble urder the k.

o ke, and will be to

5. (Optional) Change installation folder.
6. Click Next.
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@ NOTE
During the installation process

a prompt will display, shown in
the screenshot.

i)

Installing
OneConnect Connectors Relay Agent

OneConnect Connectors. Relay Agent iz being installed.

Please walk.

OneConnect.Connectors.Relay.Agent

o OneConnect.Connectors.Relay.Agent |"‘!°! L

Installing ," )

OneConnect Connectors Relay Agent k-

Relay Configuration

Service Namespace”
Shared Access Kay*

[ Concel | [ Coninue

@ NOTE
Sometimes the ‘Relay

Configuration’” modal will be
displayed behind but can be
accessed in the Task bar.

8. Fillin the ‘Relay Configuration’ prompt’s
+ Service Namespace: *-oneconnect-relay
(*provided by OnePlan)
» Shared Access Key:* (*provided by
OnePlan)
9. Click Continue.

s OneConnect.Connectors.Relay.Agent

Installation Complete f. )

OreCannect Canmvectors Relay Agent has been successhully installed.

Click "Cloze" to exit

11. You can confirm the Relay Agent is running
by opening Services.msc as shown in the
screenshot.

Installation Notice

Initial Installation Log: During installation a log file
is generated and can be found in the same location
as the installer.

Logging Information: Other logging information,
such as relay startup or relay errors can be found in
the installation directory under \Logs.
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Uninstall and Update a Relay

Only a single relay can be installed in a server at a
single time. Because of this, uninstalling a relay will
be necessary to update to a newer version of the
relay.

1. Take a Backup of the Relay Configuration
Files. Take a backup of the
OneConnect.Connectors.Relay.Agent.exe.confi
g file from the current relay folder. The current
relay folder will be where the relay was
installed from the initial installation steps.

2. Uninstall the Existing Relay. Using the
computer's Add/Remove Programs tool, locate
OneConnect Relay Agent and uninstall the
program.

3. Reinstall the Relay. From here, follow the
Relay Installation [19] instructions.

4. Update Relay Configuration Files. Once the
new relay has been installed, navigate to the
relay folder, and compare the
OneConnect.Connectors.Relay.Agent.exe.confi
g files from the old relay configuration files. For
pathing values or service account information,
overwrite these values from the old
configuration to the new one.

This is to ensure that any environment-specific
values are not overwritten with the default
configuration values from the newly installed
relay. The values in question will look like
pathing values, especially anything that is
referring to <appSettings> nodes. An example
is provided below:

<add key="EnvironmentSpecificSetting_PathT = "

5. Save any changes made, and start the new
relay.

OnePlan Integration settings

This article explains the Integration settings in the
Admin pages of OnePlan.

Go to the Admin pages, select Integration in the
navigation. These settings are available when the
Advanced Settings are enabled.

Authentication Keys

Any authentication keys that have been added,
such as for reporting or integration will show on this
page. You can't see the actual keys themselves,
just the name.

Click Delete ™ to remove a key if needed.

Authentication Keys
App Name

bk

Reporting

To create a new authentication key:

1. Click Add Key * . The Add Key form will open.
2. Enter a name for the new key. Then click ADD
to create.

Add Key

After the key d, be sure to copy and store in safe location. You will not be able

to recover the key

<add key="EnvironmentSpecificSetting_Shoul

<add key="EnvironmentSpecificSetting_BaselP eVadhentieion-kerauillrfotisiple Boms />

NOTE

Knowing exactly what values
should be set can be
confusing if you do not know
what you are looking for,

we suggest reaching out to
Support to go over the values
in question to verify what
should be changed or not.

K

the Authentication Keys list. Copy and save the
key in a secure location. The key will become
encrypted when you reload the Admin pages.

Authentication Keys
App Name
Reporting

|| New Key 1 d7gn2pXi2UipYGLDHj4XTKqO2QTcFzCD

To allow integration to this tenant, please make sure you are logged in with a tenant admin and click here
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Events

Any events that have been added will show. If an
integration has already been built/configured, you
may add an additional event.

To create a new event:

1. Click Add Event * . The Add Event form will
open.

2. Complete the Add Event form. Click ADD to
create the new event.

+ Target: The target is where the event going
to be installed at. Options include WorkPlan,
Process Flow, Resources, and Status
Reports.

+ Type: Type is when the event will run.
Options include Before Save and After
Save.

« Triggers: Triggers determine when the event
will kick it off. Options include Add, Update,
Delete, Submit, and Approve/Reject

« Url: URL is the URL the event will to go to
when it runs. Enter the URL.

+ Strategy: If the event is for an integration
and runs a OneConnect strategy or another
item name, enter the strategy name.

+ Integrationld: If the event is for an
integration using OneConnect, enter the ID
of the integration.

Add Event

Integrations

All integrations set up in your environment are listed
in the Integrations section.

Click Delete 1 to remove an integration if needed.

ntegrations
System List

Microsaft Teams Plan

To add a new integration into your environment,

click Add Integration * . You will be redirected to
our integration platform, OneConnect.

Reporting
Add the url to your odata feed to enable powerful
reporting in OnePlan.

Reporting Info

https://oneplangagraph.azurewebsites net/odata/c65a995d-7140-40bf-b31a-2903a00:
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Integrations troubleshooting

Is it possible to utilize
filters on the SynchLookups
strategy? (OnePlans Plans and

SharePoint List Integration)

At this point in time, filters will not work on the
SynchLookups strategy.

The SynchLookups strategy should only be

used when bringing in values from a single

choice list from SharePoint into a blank (empty)
OnePlan Choice field that is mapped in both the
(SPLists - Plans) and in the (ListForLookups -
LookupTable). Running this strategy will populate
the blank OnePlan choice field with the options
from the SharePoint side.

Filtering should be used on
the SharePointToOnePlan strategy.

1. Click on the filter icon associated with the
SharePointToOnePlan strategy.

2. Click on the SPList(s) - Plans to expand the
filtering section.

3. Click the Add Rule button, this will create a
new line with four fields where you can add
your new filter.

ssssssss

........................
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To filter based on a null value (blank or with no
choice selected for the list item in SharePoint) in
the first field (a drop-down):

1. Select the SharePoint Choice field name.

2. Inthe second field, select the < > from the
drop-down.

3. In the third field (labeled Value), leave it blank.

4. Click the Save. This will populate the Filter
Expression field.

5. Click the Close button at the bottom of
the Filters window. The next time the schedule

runs, the filter will activate and only the list
items.

SharePointToOnePlan

yyyyyyyyyyyyyy

Why is the the “Include in app”
toggle in Power Bl greyed out
on all my Power Bl workspaces
for all service accounts?

Issue

The “Include in app” toggle in Power Bl is greyed
out on all Power Bl workspaces for all service
accounts.

Cause

Microsoft released an update to Power Bl that
controls inclusion in Apps from the main screen.

Solution

1. Click on Update App to get into the Update
App configuration screen.

2. Click on step "2. Content" and then "Add
content" and add the new report to the
Content list below.

3. Then click on step "3. Audience" and make
sure the newly added report is not hidden (it
seems to be marked as hidden by default).

4. Then you publish the app and the new report
will now appear in the App.
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Why is the “Include in app”
toggle in Power Bl is greyed
out?

Issue

The “Include in app” toggle in Power Bl is greyed
out.

Cause

There was an update to Power Bl that was
deployed 08/24/2022 and you can no longer control
inclusion in Apps from the main screen.

Solution

The column is still there so you can see if a report
is included in the app, but you can't change it there
anymore. The new steps are this:

1. Click on Update App, to get into the Update
App configuration screen.

2. Click on step 2. Content and then Add
content. Add the new report to the Content list
below.

3. Click on step 3. Audience and make sure the
newly added report is not hidden (it seems to
be marked as hidden by default).

4. Publish the app. The new report will now
appear in the app.

Why are my Power Bl reports
not refreshing?

Power Bl Failure to Update the data
Reports not connect to source credentials in
refreshing. the server Power BI.

due to
(Power BI expired 1. Log into Power BI.
Reports credentials. 2. Go to the OnePlan
Processing Workspace.
Error: (503) Locate the
Server. affected data set
Unavailable)

(orange icon).

3. Select the More
Options icon
(vertical dots) >
Settings.

4. Expand the
Data source
credentials
heading.

5. Select Edit
Credentials for
Cds and OData.
Update the
credentials.

Why is Committed Effort

not synching from the
OnePlan Resource Plan to the
Committed Effort field in the
project General tab? (Power

Apps)

| Problem | Cause | Solution

Problem Cause Solution
Committed Committed Create new fields that
Effort is not Effort and use the correct data
syncing from Percent type (decimal).
the OnePlan Complete
Resource fields are 1. Create new
Plan to the using Percent
Committed incorrect data Complete and
Effort field in types (whole Committed
the project numbers). Effort fields as
General tab. decimals.
2. Add the new
fields to the Form.
3. Run the OnePlan
to Power Apps
sync operation to
refresh the data.

Common Integration Errors

This article lists and describes common integration
errors that may occur. These errors are general and
can happen with any integration.
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(Protocol) The communication object,
System.ServiceModel.Channels.Servic
eChannel, cannot be used for
communication because it is in the
Faulted state.

This error indicates an issue with the Azure Relay.

There are relay credentials entered within the Relay
Options section of the configuration of one of the
Integration Connectors and that relay is turned off
or not working properly.

If a relay was entered for debugging purposes,
remove the credentials and click Save. Re-run the
strategy.

If a relay is required for on-premises integrations,
then check the server hosting the relay and make
sure the relay is running and there are no error
messages logged.

Strategy '{Strategy Name}' was not
found.

The integration does not have a strategy with that
name.

Remove or update the schedule and pick a different
strategy.

Can't create plan: Please make sure
'Name' field is mapped or is set in the
direction of OnePlan!

This is an error that relates to creating plans
in OnePlan. The OnePlan Name field must be
mapped in order to create plans in OnePlan.

Update the field mapping and map the OnePlan
Name field.

Error: Column 'System.{Field Name}'
does not belong to table {Table

Name}.

There is a field name used in a filter that is
not mapped. Every field used in filters must be
mapped.

Update the field mapping and map the missing
field(s).

Error: The underlying connection
was closed: A connection that was
expected to be kept alive was closed

by the server.

This error indicates an API timeout issue. A call
was made to an API and that API did not return the
call within a set timeframe. In most cases, this issue
is related to a single item that is being processed. If
the strategy is scheduled to run again, then the item
will be processed again as it is in an error state due
to the timeout. If the same item fails many times,
then it is possible that the specific item has a data
issue. In that case review the data for that item.

Detected a long running operation,

review may be needed.

This error indicates an API timeout issue. A call
was made to an API and that API did not return the
call within a set timeframe. In most cases, this issue
is related to a single item that is being processed. If
the strategy is scheduled to run again, then the item
will be processed again as it is in an error state due
to the timeout. If the same item fails many times,
then it is possible that the specific item has a data
issue. In that case review the data for that item.

Error: The operation has timed out

This error indicates an API timeout issue. A call
was made to an API and that API did not return the
call within a set timeframe. In most cases, this issue
is related to a single item that is being processed. If
the strategy is scheduled to run again, then the item
will be processed again as it is in an error state due
to the timeout. If the same item fails many times,
then it is possible that the specific item has a data
issue. In that case review the data for that item.

The remote server returned an error:
(502) Bad Gateway

This error indicates an API timeout issue. A call
was made to an API and that API did not return the
call within a set timeframe. In most cases, this issue
is related to a single item that is being processed. If
the strategy is scheduled to run again, then the item
will be processed again as it is in an error state due
to the timeout. If the same item fails many times,
then it is possible that the specific item has a data
issue. In that case review the data for that item.
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The remote server returned an error:
(403) Forbidden. Status: ProtocolError
QueryUrl: https://
oneplangagraph.azurewebsites.net/api
Iconfig

Authentication Key to the OnePlan Group was
deleted. Generate a new OnePlan Authentication

Key and save those credentials in the OnePlan
Connector.

This error can also indicate an API timeout issue. A
call was made to an API and that API did not return
the call within a set timeframe. In most cases,

this issue is related to a single item that is being
processed. If the strategy is scheduled to run again,
then the item will be processed again as it is in an
error state due to the timeout. If the same item fails
many times, then it is possible that the specific item
has a data issue. In that case review the data for
that item.

Server Error in ‘I’ Application: Object
reference not set to an instance of an

object.

This error indicates that there may be a
configuration issue in OnePlan. Verify that the
Microsoft Teams App is installed in OnePlan.

Common Microsoft Product

Integration Errors

This article lists and describes common integration
errors that may occur with Microsoft products.

Integrations that connect to a Microsoft Product
including by not limited to: M365 Planner, Power
Apps, Tabular Data, Project Online, Project for the
Web, SharePoint Online.

The sign-in name or password does
not match one in the Microsoft
account system.

This error occurs when using an account that

has Multi Factor Authentication enabled or if the
username/password combination is incorrect.

Please make sure that a service account configured
in OneConnect does not have Multi Factor
Authentication (MFA) enabled. Please also verify
that the username and password are correct.

Common Azure DevOps

Integration Errors

This article lists and describes common errors that
may occur with the Azure DevOps integrations.

VSTS Connection: Error at (2-6)
Response status code does not
indicate success: 401 (Unauthorized).
at
System.Net.Http.HttpResponseMessa
ge.En ureSuccessStatusCode() at
ProjectConnect.Connectors.VSTS.Tfs
Client. estConnection() in
D:\a\1\s\ProjectConnect.Connectors.V
STS\ fsClient.cs:line 103

This error indicates that the Azure DevOps
Personal Access Token expired or is revoked.

Please make sure that you are using an access
token that is valid.

For more information, please see Use personal
access tokens from Microsoft.

TF50316

Azure DevOps has several naming conventions.
This error indicates that those naming conventions
are violated.

For more information, please see Naming
restrictions and conventions from Microsoft.

VS403074

The Work Item Type does not exist in the Inherited
Process template.

For more information, please see Add and manage
work item types from Microsoft.

Error: TF401326: Invalid

field status 'InvalidType' for

field 'Microsoft.VSTS.Common.{Field
Name}'.

The value used in OnePlan does not match the
available values in Azure DevOps.

@ OnePlan

27


https://learn.microsoft.com/en-us/azure/devops/organizations/accounts/use-personal-access-tokens-to-authenticate?view=azure-devops&amp;tabs=Windows 
https://learn.microsoft.com/en-us/azure/devops/organizations/accounts/use-personal-access-tokens-to-authenticate?view=azure-devops&amp;tabs=Windows 
https://learn.microsoft.com/en-us/azure/devops/organizations/settings/naming-restrictions?view=azure-devops
https://learn.microsoft.com/en-us/azure/devops/organizations/settings/naming-restrictions?view=azure-devops
https://learn.microsoft.com/en-us/azure/devops/organizations/settings/work/customize-process-work-item-type?view=azure-devops
https://learn.microsoft.com/en-us/azure/devops/organizations/settings/work/customize-process-work-item-type?view=azure-devops

Integrations

OnePlan should either have the value updated, or
there needs to be Value Mapping configured in
OneConnect. (to map between the list of values in
OnePlan and the list of values in Azure DevOps).

TF51011: The specified iteration path
does not exist. The error is caused by
«'{lIteration Path Value}'».

The iteration path in Azure DevOps no longer
exists, or it is in the middle of the iteration path list
(I.E., Path Two was chosen within: Path One/Path
Two/Path Three).

Common Project Online
Integration Errors

This article lists and describes common errors that
may occur with the Project Online integration.

System.Web.Services.Protocols.Soap
Exception [GeneralNotLicensed]
(20024): ProjectServerError(s)
LastError=GeneralNotLicensed
Instructions: Pass this into
PSClientError constructor to access

all error information

The service account configured in OneConnect to
connect to Project Online does not have a license
for Project Online. Please make sure you assign at
least a Plan 3 type of license to the account.

[CheckOutCheck]: {OnePlan ID}:
Currently checked out by {User
Display Name} ({User Email}),
skipping.

The plan (named in the error) is currently checked
out by the user in OnePlan. That person or
someone else must check the plan back in for the

item to sync data back to OnePlan or be updated
with the values within OnePlan.

Common Tabular Data and
SharePoint Integration Errors

This article lists and describes common errors
that may occur with Tabular Data or SharePoint
integrations.

Error: Exception while retrieving
DataTable for {File Name}: The file
type for is not supported.

The file specified in the Tabular Data configuration
cannot be accessed or the or the file type was

not of CSV format. Please verify that the file is
accessible (use a browser with the path). Please
note that only csv files are supported.

Exception while retrieving DataTable
for {FileName}: List ‘{Folder Path
Value}’ does not exist at site with URL
‘{SharePoint Site URL}".

The folder path being used is more than one level
deep. The file must reside within a folder that is one
level deep (I.E., Documents). The file cannot be in /
Documents/Folder One or deeper.

Common M365 Planner

Integration Errors

This article lists and describes common errors that
may occur with the MS365 Planner integration.

Cannot perform runtime binding on a
null reference.

The M365 Planner strategy is scheduled to run.
This type of integration cannot be scheduled. These
strategies should be removed from the Schedules
list and only be triggered as an event within the
Connected Systems button in OnePlan.

Common Jira Integration Errors

This article lists and describes common errors
that my occur with the Jira integrations (Epics or
Projects)

Jira Epics

[UpsertEpic]: Make sure 'Project Name
(Epic)' field is mapped!

The OnePlan plan does not have a value in the Jira
Project Name field populated.
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Jira Projects

[UpsertProject]: Jira Project Type
value not found!

The OnePlan plan does not have a value in the Jira
Project Type field populated.

Common Dynamics and Power

Apps Integration Errors

This article lists and describes common errors
that may occur with Dynamics and Power Apps
integrations.

Error: Invalid URI: The format of the
URI could not be determined.

This is caused by mapping a large number of fields
in Field Mappings. There is a maximum number

of characters that can be processed, so if there
are a lot of field mappings with long names, this
error can trigger. Please review the mapped fields,
use shorter names or remove some of the field
mappings.

Common OneConnect Errors

This article provides access to detailed descriptions
of common errors that may occur with our various
OneConnect integrations.

Common Integration Errors [25]

Common Microsoft Product Integration Errors [27]
Common Azure DevOps Integration Errors [27]
Common Project Online Integration Errors [28]

Common Tabular Data and SharePoint Integration
Errors [28]

Common M365 Planner Integration Errors [28]
Common Jira Integration Errors [28]

Common Dynamics and Power Apps Integration
Errors [29]
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Teams Integration

Auto-Create Connected Teams
from OnePlan

BY Microsoft

This article explains how to auto-create a new aRmin@EExIE431 TER.onimicraseftcom
Team with each new OnePlan project. Permissions requested

. . Review for your organization
Using this method allows you to create: y 9

G) OnePlan

» A plan-level OnePlan tab within a new team,

which only shows OnePlan data relevant to This application is not published by Microsoft or

your plan. See Create a Plan-Level Team from Yourargenization,

OnePlan [30]. This app would like to:
* A group-level OnePlan tab within a new team, v Read and write all groups

which gives you full access to OnePlan from v/ View users' basic profile

Teams. See Create a GI’OUp-LeVe| Team from “/ Maintain access to data you have given it access to

OnePlan [31].

If you accept, this app will get access to the specified resources for
all users in your organization. No one else will be prompted to
review these permissions,

Be sure that your OnePlan group has been set up

Accepting these permissions means that you allow this app to use

and that you have admin access before beginning your data as specified in their terms of service and privacy
. statement. You can change these permissions at
thIS process. https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here

Enable OnePlan for Teams
Cancel Arcept

1. Go to the Admin pages > Microsoft Teams.
2. Click Enable Permissions.

Create a Plan-Level Team from
OnePlan

1. Within the Details tab of your plan, click the
Teams icon. The Select Option pop up will
open.

|support Customer using Mobile D

< o[ 5

B ©

©

s}

3. Click Accept to enable OnePlan for Teams.

]

® > 8

b

[S]

2. Click Connect to connect your OnePlan plan
to Teams. Once the integration is done setting
up, the Connected System pop up will open.

30 ®OnePlan



Integrations

Select Option

* ® New ke - Craate a new item in destination system

==

3. Click Open Item to go to the new connected
Teams Team.

Connected System
i o Status: Connected

Connected to Microsoft Teams

A new Team is created with the same name as
your OnePlan plan. There is also a OnePlan tab in
the Team General channel. This OnePlan tab gives
access only to the connected plan data. You cannot
access other plans or areas from this view.

& Joorcretes team @ | s -

Create a Group-Level Team from
OnePlan

1. Go to the Admin pages > Microsoft Teams.
2. Click Click Here to create a new group-level
team in your Teams instance.

In Teams, a new Team is created with the same
name as your OnePlan group. There is also a
OnePlan tab in the Team General channel. The
OnePlan tab gives access to all plans and relevant
areas in your OnePlan group.

Connect OnePlan to Existing

Teams or Teams Channels

This article explains how to add OnePlan to an
existing Teams instance, or to an existing Teams
Channel.

It is easy to connect OnePlan to your Teams
environment. There are a few ways to add OnePlan
into existing Teams:

* You can add the OnePlan Work Plan as a tab
directly to an existing team for tailored access to
only the relevant work plan. See Add a OnePlan
Work Plan as a Channel Tab in Teams [32].

* You can add the OnePlan app to the left rail
navigation for full access to all OnePlan areas.
This is really a fused interface where you can
access all OnePlan has to offer, right from
Teams. See Add OnePlan to the Left Rail in
Teams [33].
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* You can also add a OnePlan app tab directly to
an existing team for full access to all OnePlan
areas. See Add OnePlan as a Channel Tab in
Teams [33].

Add a OnePlan Work Plan as a
Channel Tab in Teams

1. Go to the desired work plan in OnePlan. Click
the user menu, then Share With. The Shared
Url form will open.

2. Select the entire URL. Save the URL for later
use, such as in a notepad file.

Shared Url x

Shareable Url https://my.oneplan.ai?Configld=7d1a4c10-c626-41f4-b576-3ee3

3. In the desired Team, click Add a tab. The Add
a tab form will open.

EE—
= 82 ST
: o .e
) $° g
m e

4. Select Website.

Add a tab X
Turn your favorite apps and files into tabs at the top of the channel search Q
More apps

Recent v

Tabs for your team

elrje] |-

Tasks by OneNote Wiki Stream Whiteboard Website OnePlan

Planner an...

Document Excel Forms. Lists PDF Power BI PowerPoint

Library

SharePoint SharePoint Visio Word

Pages
More apps
L]
365
15Five r f

. projecis J

15Five 360 Tours 365Projects. ACV adam.ai Additio Adobe
Acrobat

S I RN <A

§3 Manage apps

5. Name the tab, and paste your OnePlan work
plan URL from step 1 into the URL field. At the
end of the URL add "&hideui=true". Then click
Save.

Website About X

Tab name

OnePlan @
URL*

000000000001 &Planld=642e8d80-af62-4282-9abb-0224410e5436 AT ()

*Make sure you're only linking to sites that start with 'https//" and contain trustworthy web content.

=5

That way, you and your team can stay secure.

B Post to the channel about this tab Back

The OnePlan work plan has been added as a tab in
teams.

Tome | e o Ot
> [sopportcntom - B
|« ® —
B
a
= - - - -
e | P —
E o
e =] : =
° —
=]
= ° —_—
o~ | ° —_—
== ° —_—
=] L
== ° —_—
= ° pu—
=a
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Add OnePlan to the Left Rail in Teams

1. Click the Apps icon. The Apps window will
open.

OnePlan for Teams

The OnePlan app is now available in the left rail
navigation of Teams. Click the OnePlan icon to
access to all plans and relevant areas in your

2 OnePlan group.

e £ o

»® >80 0 < e00>gH
LR RN TRN'} g £

3. Click Add to add OnePlan as an app within
Teams. Add OnePlan as a Channel Tab in
Teams

There are two methods to add OnePlan as a
channel tab in Teams.

4. Select your OnePlan group and click Save.

dcte. @ % 0 @

@ OnePlan
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Using the Add a tab button.

1. Inthe desired Team, click Add a tab. The Add a tab form will
open.

Welcome to the team!,
Here are some things to get going.

w e iB

There is new a OnePlan tab in your selected channel. The OnePlan tab gives access t«

2. Search for and select OnePlan.

€ > c a ww O 2

Ba PN e |

Howndodltouse OnelPan 4 vitin a Team.

3. Select your OnePlan group. Then click Save.

|anau&a GroupJeam mean
i ging

Search for and select the channel where you would I|ke to add

Selécmggn'ge@mgpat is the name of your OnePlan
Groupsdilicjoorptiael{opeiandtabkieasee all the

OnePlan content and modules.

i > General

SN o oo oo
[rom o]
I:—m
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Plan Level Teams

A separate Team may be created for each plan,
as needed. If a plan has its own Team already
connected, the name of the Team will be the name
of the Plan. On the Portfolios page, a Microsoft
Teams icon will show on the Plan row. Click on the
Team name in your Teams navigation or click the
Teams icon to open that Team.

It's possible that a separate Team is created for
every Plan created, or the Teams may need to be
created on demand, as needed. If unsure, verify
with your OnePlan administrator which is the case
for your organization.

Teams v Hooli > General -+

nversations  Files Wiki  OnePlan v +

D My Portfolio

~ ©~ | B [ | ZoomMonth v | PlanType:Plan +
9

# 1 Name

| ] 1 ¥ World-Class customer support

I
dl

[
R Q
=)

B B X
il

Q Qe IQ
. 8

Work in a Plan's Team

When viewing a Plan Team, the focus is only on
that one Plan. You may navigate to the available
modules, and manage your plan.

B PiperNet > General -~ e

+ 16 ®0 =

PiperNet

) 0O

Create a new Plan Team

You may connect your Plan to a new Team either
from the OnePlan website or from within Teams.
Open the Plan for which you will connect a new
Team. Expand the Plan menu. Select Microsoft
Teams.

z51 Hooli Servers

Shared With

Comments

Rate Table
General

If a Team doesn't yet exist for this Plan, you will see
"New Item - Create a new item in the destination
system." Click the Connect button.

Select Option

i. (®) New Item - Create a new item in destination system

Once the Team is created/connected, click Open
Item, or select the Team in the Teams navigation.

Microsoft Teams @

Teams v o

[ ES)

¢ VOIP Phones

B sovvor ustomersusing Mobie (910
[ e ——

B roene

Hool

[
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How do | store Project
schedules in Teams for my
OnePlan group?

This article explains how to set up your OnePlan
group to store Microsoft Project Desktop files in a
shared Teams Files document library.

This feature requires BOTH the Project
Professional and Microsoft Teams apps be installed
and configured for your OnePlan group.

Why should we use this feature?

This feature allows the schedule files to be in a
shared document library, in other words a central
hub for your OnePlan group's schedule files. The
latest version is saved and accessed from the
central library. So, there is no longer the need to
look for the latest version or need to use email

to share Project schedule files between users.
This new feature also prevents people publishing
over each other from local desktop copies of the
schedule, which could be out-of date.

Install Apps

If you haven't already installed the required
OnePlan apps, do so first.

How do | set up Project Desktop for OnePlan? [70]

How do | manage OnePlan in Microsoft Teams?
Configure the Microsoft Teams app and create a
group-level team for your OnePlan group.

Open Files in SharePoint

Navigate to Teams. Select your OnePlan group-
level team.

1. Open the Files library.
2. Click Open in SharePoint.

General @ fies [ cnerin +
A

+ New v T Upload v G Sync

@ Copylink L Download + Add cloud s

Create "Plans"” Document Library

1. In SharePoint, add an app.
2. Select Document Library as the type.
3. Name the Document Library "Plans".

Settings X

SharePoint

Sdd 3 page

Ite COTLENTS
Library settings
Restore this library
Site information
Site permissions
Site usage
Change the look
Site designs

Apps you can

pa
e

Gustomit Tasks
i sl Acding D
Pekarame
add Newest Name S )
¢ wa s uld u o
oD e

Upload Microsoft Project Templates

In SharePoint, add an app.

Select Document Library as the type.

Name the Document Library "PlanTemplates".
Upload your Microsoft Project .mpp templates

il .
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MS Project Online Integration

Project Online and Visual These two integrations synchronize Project Online
. . Projects to VSTS Areas.

Studio Team Services (VSTS):

Areas and Areas with ltems

» "Areas": Project Online projects sync as Areas
under a selected Team Project.

This article explains the main use case and out- « "Areas with ltems": Project Online projects
of-box capabilities for the OnePlan integration sync as Areas under a selected Team Project .
between Project Online and Visual Studio Team Additionally, Project tasks sync to two levels as
Services (VSTS): Areas, using the OneConnect work items, typically Features & User Stories.

integration platform. There is an integration for
"Areas" and an integration for "Areas with Iltems."
They are similar, but the "Areas with ltems" EEE—- Mo
integration has some additional data that sync over ‘

(VSTS Work ltems to Project Online Tasks). Refer
to the process steps to see the specific process for
how these two integrations work.

About

OneConnect for Visual Studio Online offers a
seamless approach to exchange critical information
between development teams and project teams
using Project Online and Visual Studio.

Agile projects
executed in & synced
to VSTS

This integration specifically synchronizes projects Resource Management
from Project Online to VSTS as Areas. VSTS work

items (typically tasks & bugs) synchronize back to
ProjectOnline as project Tasks.

Build better forecasts and gain greater insight into
capacity & demand, taking into account all types of
projects when optimizing your portfolio of projects.
See all work assigned (project online workload and

Agile Projects T — VSTS workload).
B_'G“ : Resources are mapped via same email address in
— f N both Project Online & VSTS, typically their Active
b = == - Directory (AD) account.

I

I

J.| ‘.L. J'.. JJM‘

L

Key Capabilities

Agile Project Visibility in Project
Online

Synchronize key data between Project Online and
Visual Studio to establish enterprise level portfolio
level visibility. Regardless of team execution
methodology (i.e. waterfall or agile), projects are
centrally visible for analysis & reporting.
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Timesheets / Actual Work

Completed hours entered into VSTS sync back to
Project Online Timesheets. Users don't need to do
double entry of time/actual work hours.

schedule is part of the configuration settings
(hourly, daily, etc.). If syncing on-demand, you
must go into Project Online & click Sync. This
will pull in the changes/updates from VSTS.
Back in Project Online, the project is updated
with the VSTS work items as Tasks in the
project schedule. Note: the tasks come in

flat rather than with a WBS (work breakdown
structure) hierarchy.

Areas with Items Process

This is the high level process flow for using the
integration. The "Epics with Items" process is

similar, with some additional notes as follows.

Areas Process 1.

This is the high level process flow for using the
integration.

1. As Areas reside beneath a parent VSTS Team 2.
Project & Area Path, the Team Project must
first exist in VSTS before creating the project in
Project Online.

2. Create a new project in Project Online. When
the integration is configured, a new field
get created in Project Online. The field is 3.
"TeamAreaProject," which is a lookup table
populated with the Team Projects from VSTS. 4.
Select the Team Project.

3. Teams may use their normal process for
project approval, portfolio analysis, etc.

4. When a project is active & ready to execute
using VSTS with an agile methodology, the PM
synchronizes the project to VSTS by clicking
on the synchronize button. A new Area is
created with the same project name under the
earlier selected Team Project. 5.

5. The PM builds out the project's agile plan
under the area path - the epics, features, user
stories, task & bugs.

6. The PM puts work items (tasks & bugs) into
an iteration. This is important, as only items
noted into an iteration will sync back to Project
Online.

7. Team members work using VSTS as usual. 6.
They update status on work items (tasks &
bugs), enter hours (remaining, etc).

8. Updates sync back to Project Online. The data 7.
that syncs back is based on the configuration
settings mapped fields. This can be done on
a scheduled timed-basis or on-demand. The

As Areas reside beneath a parent VSTS Team
Project & Area Path, the Team Project must
first exist in VSTS before creating the project in
Project Online.

Create a new project in Project Online. When
the integration is configured, a new field

get created in Project Online. The field is
"TeamAreaProject," which is a lookup table
populated with the Team Projects from VSTS.
Select the Team Project.

Teams may use their normal process for
project approval, portfolio analysis, etc.

Build out the project plan. The summary tasks
and child tasks will sync to VSTS as two levels,
based on how the integration is configured.
Typically, summary tasks would be synced to
Epics and the child tasks would be synced

to Features. To govern which tasks will sync,
there's a new field in the Tasks list called
"VSTS Task Item." In the plan, select the VSTS
task item for the tasks to synchronize.

When a project is active & ready to execute
using VSTS with an agile methodology, the PM
synchronizes the project to VSTS by clicking
on the synchronize button. A new Area is
created with the same project name under

the earlier selected Team Project. The project
tasks get created as Epics & Features (or the
configured levels, if different).

The PM builds out the project's agile plan
under the new Area with the Epics, Features,
User Stories, Tasks & Bugs.

The PM puts work items (tasks & bugs) into

an iteration. This is important, as only items
noted into an iteration will sync back to Project
Online.
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Team members work using VSTS as usual.
They update status on work items (tasks &
bugs), enter hours (remaining, etc).

Updates sync back to Project Online. The data
that syncs back is based on the configuration
settings mapped fields. This can be done on
a scheduled timed-basis or on-demand. The
schedule is part of the configuration settings
(hourly, daily, etc.). If syncing on-demand, you
must go into Project Online & click Sync. This
will pull in the changes/updates from VSTS.

10. Back in Project Online, the project is updated

with the VSTS work items as Tasks in the
project schedule. Note: the tasks come in

flat rather than with a WBS (work breakdown
structure) hierarchy. They come in at the
bottom of the plan. Note: the tasks do not sync
into the project plan under the "features" tasks.

Important Notes

If Areas are created first in VSTS, they are not
automatically synced to Project Online as a new
project.

The integration is also supported on Team
Foundation Services (On-Premise), but only for
the following versions: 2015, 2017, & 2018.

Must have full admin privileges/accounts in

both Project Online & VSTS to configure the
integration.

The default VSTS Work Item types are Tasks and
Bugs. These sync to the Project Online Tasks list.
Other types can be configured to also come over,
such as Features, User Stories, etc. but they will
still come in as project tasks, in a flat hierarchy.

Restrictions/Rules/Limitations

Basic mapping rule: Make sure to mapp fields
that are required by the other side of the
connector (in this case is VSTS), if the fields are
required by VSTS, then mapped the fields of that
item to get synchronized from Project Online to
VSTS.

Empty TeamAreaProject field in Project Online is
not allowed. (*Has to have a VSTS Team Project
for the project)

To support multi-level area path in Project
Online’s lookup table, user needs to adjust the
code mask section in the lookup table settings
based on the number of level the user need. (eq.
4 level = *.*.*.*.)

User can only enter a single work item type in the
VSTS Work Item Type column in the connector
GUI.

If user does not enter/leave empty the work item
type column, it will by default be “Area” work item
type.

Invalid input work item type will not let current
new item being synched gets created in VSTS.
Invalid input on work item type will not let current
item being synched gets updated on its item type
field in VSTS, if this work item has ever been
mapped before.

When user enter a single work item type in the
GUI, it must be very specific to the work item
type shown in VSTS (They are case-sensitive).
Take an example from the below picture, when
mapping “Epic” work item type, the value entered
on the GUI of the connector must follow the same
key word “Epic”, see the highlighted part below.
(Column name: VSTS Work Item Type)

When a user deletes an item in VSTS, the next
time the scheduler runs, it will still synchronize
(recreate) that item from Project Online to VSTS.
Unless the item is also deleted in Project Online,
then that item will never be synchronized back to
VSTS.

Changing area path to a different team project

is not allowed by VSTS. Only changing area
path level within the same team project that has
been initialized at the first time the work item is
synchronized is allowed.

Parent item name declared in Project Online
lookup table needs to be in this specific format:
“parent name - parent id”, where the parent id is
placed at the very end after “-“.

Attempting to change the parent item of the
already mapped item is not currently supported.
Parent item will be linked to the current item
being mapped only during the first creation of
this item to VSTS. The later the scheduler runs,
any updates related to parent item will not get
updated. *If user did not enter/wrong input the
parent item in the project field in PJO, delete the
item from VSTS, and assigned the correct parent
item to the field in PJO, and have it synchronized
back to VSTS/wait for the scheduler to run.
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+ Sample of the input for work item type to be
synched to VSTS and work item type that will be
synched to PJO as Task: (Same rule regarding
work item type case sensitivity when getting input
in the GUI, explained above)

Work item types need to be at an iteration to get
synched to Project Online. Only tasks and bugs
need to be in an iteration; other work item types
(Non-Bug and Non-Task) will just be brought over
to Project Online as Tasks.

VSTS Synchronize Button Functionality

Expectation:

» Create a newly created project in Project
Online to VSTS work item type.

+ If the item has already been created/synched
to VSTS before through the button, the next
time the button is clicked, it will only update
back to Project Online from VSTS. Any
updates in Project Online to VSTS will never
be made through the button (Therefore, the
“ProjectPublish” strategy is needed to synch
over updates from Project Online to VSTS).

Notes

* Mapping projects from Project Online to VSTS

Team Area (Projects -> Areas):

* Able to create a team area in VSTS from a
project in project online.

Mapping items from VSTS to Project Online tasks

(Tasks -> ltems):

* Able to select the work item type in VSTS
below the Area item and it will be mapped as
task schedule table in Project Online.

Mapping team area projects from

VSTS to Project Online lookup table

(Lookup_TeamAreaProject -> TeamAreaProjects)

» Able to synchronized team area project
level (Currently support up to 100 levels) to
a TeamAreaProject lookup table in Project
Online.

Project Online and Visual
Studio Team Services (VSTS):

Epics and Epics with ltems

This article explains the main use case and out-
of-box capabilities for the OnePlan integration
between Project Online and Visual Studio Team
Services (VSTS): Epics, using the OneConnect
integration platform. There is an integration for
Epics and an integration for Epics with ltems. They
are similar, but the Epics with Items integration has
some additional data that sync over (tasks to VSTS
work items). Refer to the process steps to see

the specific process for how these two integrations
work.

About

OneConnect for Visual Studio Online offers a
seamless approach to exchange critical information
between development teams and project teams
using Project Online and Visual Studio.

This integration specifically synchronizes projects
from Project Online to VSTS as Epics. VSTS work
items (typically tasks & bugs) synchronize back to
ProjectOnline as project Tasks.

Agile Projects : -

. : - L]
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e m
|

Key Capabilities

Agile Project Visibility in Project
Online

Synchronize key data between Project Online and
Visual Studio to establish enterprise level portfolio
level visibility. Regardless of team execution
methodology (i.e. waterfall or agile), projects are
centrally visible for analysis & reporting.

These two integrations synchronize Project Online
Projects to VSTS Epics.

» "Epics": Project Online projects sync as Epics
under a selected Team Project & Area Path.
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» "Epics with Items": Project Online projects sync
as Epics under a selected Team Project & Area
Path. Additionally, Project tasks sync to two
levels as work items, typically Features & User
Stories.
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Resource Management

Build better forecasts and gain greater insight into
capacity & demand, taking into account all types of
projects when optimizing your portfolio of projects.
See all work assigned (project online workload and
VSTS workload).

Resources are mapped via same email address in
both Project Online & VSTS, typically their Active
Directory (AD) account.

,‘l ‘m L t L4

Timesheets / Actual Work

Completed hours entered into VSTS sync back to
Project Online Timesheets. Users don't need to do
double entry of time/actual work hours.

- Project Name: Health Assessment Reporting Tool

Epics Process

This is the high level process flow for using the
integration.

1. As Epics reside beneath a parent VSTS Team
Project & Area Path, the Team Project & Area
Path(s) must first exist in VSTS before creating
the project in Project Online.

2. Create a new project in Project Online. When
the integration is configured, a new field
get created in Project Online. The field is
"TeamAreaProject," which is a lookup table
populated with the Team Projects & Area Paths
from VSTS. The lookup field is hierarchical.
Select an Area Path under the Team Project.

3. Teams may use their normal process for
project approval, portfolio analysis, etc.

4. When a project is active & ready to execute
using VSTS with an agile methodology, the PM
synchronizes the project to VSTS by clicking
on the synchronize button. A new Epic is
created with the same project name under the
earlier selected Team Project & Area Path.

5. The PM builds out the project's agile plan
under the epic - the features, user stories, task
& bugs.

6. The PM puts work items (tasks & bugs) into
an iteration. This is important, as only items
noted into an iteration will sync back to Project
Online.

7. Team members work using VSTS as usual.
They update status on work items (tasks &
bugs), enter hours (remaining, etc).

8. Updates sync back to Project Online. The data
that syncs back is based on the configuration
settings mapped fields. This can be done on
a scheduled timed-basis or on-demand. The
schedule is part of the configuration settings
(hourly, daily, etc.). If syncing on-demand, you
must go into Project Online & click Sync. This
will pull in the changes/updates from VSTS.
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Back in Project Online, the project is updated
with the VSTS work items as Tasks in the
project schedule. Note: the tasks come in
flat rather than with a WBS (work breakdown
structure) hierarchy.

Epics with Items Process

This is the high level process flow for using the
integration. The "Epics with ltems" process is
similar, with some additional notes as follows.

1.

As Epics reside beneath a parent VSTS Team
Project & Area Path, the Team Project & Area
Path(s) must first exist in VSTS before creating
the project in Project Online.

Create a new project in Project Online. When
the integration is configured, a new field

get created in Project Online. The field is
"TeamAreaProject,” which is a lookup table
populated with the Team Projects & Area Paths
from VSTS. The lookup field is hierarchical.
Select an Area Path under the Team Project.
Teams may use their normal process for
project approval, portfolio analysis, etc.

Build out the project plan. The summary tasks
and child tasks will sync to VSTS as two levels,
based on how the integration is configured.
Typically, summary tasks would be synced to
Features and the child tasks would be synced
to User Stories. To govern which tasks will
sync, there's a new field in the Tasks list called
"VSTS Task Item." In the plan, select the VSTS
task item for the tasks to synchronize.

When a project is active & ready to execute
using VSTS with an agile methodology, the PM
synchronizes the project to VSTS by clicking
on the synchronize button. A new Epic is
created with the same project name under the
earlier selected Team Project & Area Path. The
project tasks get created as Features & User
Stories (or the configured levels, if different).
The PM builds out the project's agile plan
under the new Epic, Features, & User Stories -
the tasks & bugs.

The PM puts work items (tasks & bugs) into

an iteration. This is important, as only items
noted into an iteration will sync back to Project
Online.

Team members work using VSTS as usual.
They update status on work items (tasks &
bugs), enter hours (remaining, etc).

9.

Updates sync back to Project Online. The data
that syncs back is based on the configuration
settings mapped fields. This can be done on

a scheduled timed-basis or on-demand. The
schedule is part of the configuration settings
(hourly, daily, etc.). If syncing on-demand, you
must go into Project Online & click Sync. This
will pull in the changes/updates from VSTS.

10. Back in Project Online, the project is updated

with the VSTS work items as Tasks in the
project schedule. Note: the tasks come in

flat rather than with a WBS (work breakdown
structure) hierarchy. They come in at the
bottom of the plan. Note: the tasks do not sync
into the project plan under the "features" tasks.

Important Notes

If epics are created first in VSTS, they are not
automatically synced to Project Online as a new
project.

The integration is also supported on Team

Foundation Services (On-Premise), but only for

the following versions: 2015, 2017, & 2018.

Must have full admin privileges/accounts in

both Project Online & VSTS to configure the

integration.

The default VSTS Work Item types are Tasks and

Bugs. These sync to the Project Online Tasks list.

Other types can be configured to also come over,

such as Features, User Stories, etc. but they will

still come in as project tasks, in a flat hierarchy.

Mapping projects from PJO to VSTS work item

(Projects -> Epics):

» Able to assign the mapped work item’s area
path in VSTS. (Support multi-level area path)

» User entered the field over in PJO’s projects
field and specify its area path. When the
scheduler runs, the projects synched over to
VSTS will get assign to the correct area path.

» User can update the area path of the work item
that has been mapped, when the scheduler is
run at future time. (Only area path within the
same level of team area project assigned to
the work item type at first synched to VSTS)

» Able to generalize mapping work item type to
VSTS. (Not specifically for Epics only)

User can enter their valid desired work item type

over in the connector GUI, and specify the work

item type (Epic, Bug, Feature, etc..)
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» User can update/change the work item’s type
that has been mapped, when the scheduler is
run at future time.

* Able to link the work item type to
its corresponding parent item type when
synchronizing the item from Project Online to
VSTS.

» User will specify in the PJO’s projects field its
parent item type, and when the scheduler runs,
the item type being synchronized will be linked
to its corresponding parent item type.

* Mapping items from VSTS to Project Online tasks

(Tasks -> ltems):

* Able to select the work item type in VSTS
below the parent item and it will be mapped
as task schedule table in Project Online.

» Mapping team area projects from

VSTS to Project Online lookup table

(Lookup_TeamAreaProject -> TeamAreaProjects)

» Able to synchronized team area project
level (Currently support up to 100 levels) to
a TeamAreaProject lookup table in Project
Online.

Restrictions/Rules/Limitations

» Basic mapping rule: Make sure to mapped
fields that are required by the other side of the
connector (in this case is VSTS), if the fields are
required by VSTS, then mapped the fields of that
item to get synchronized from Project Online to
VSTS.

+ Empty TeamAreaProject field in Project Online is
not allowed. (*Has to have an area path for the
project)

» To support multi-level area path in Project
Online’s lookup table, user need to adjust the
code mask section in the lookup table settings
based on the number of level the user need. (eq.
4 level =****.)

» User can only enter a single work item type in the
VSTS Work Item Type column in the connector
GUI.

* If user does not enter/leave empty the work item
type column, it will by default be “Epic” work item
type.

* Invalid input work item type will not let current
new item being synched gets created in VSTS.

* Invalid input on work item type will not let current
item being synched gets updated on its item type

field in VSTS, if this work item has ever been
mapped before.

When user enter a single work item type in the
GUI, it must be very specific to the work item
type shown in VSTS (They are case-sensitive).
Take an example from the below picture, when
mapping “Epic” work item type, the value entered
on the GUI of the connector must follow the same
key word “Epic”, see the highlighted part below.
(Column name: VSTS Work Item Type)

When user delete an item in VSTS, the next
time the scheduler runs, it will still synchronize
(recreate) that item from Project Online to VSTS.
Unless the item is also deleted in Project Online,
then that item will never be synchronized back to
VSTS.

Changing area path to a different team project

is not allowed by VSTS. Only changing area
path level within the same team project that has
been initialized at the first time the work item is
synchronized is allowed.

Parent item name declared in Project Online
lookup table need to be in this specific format:
“parent name parent id”, where the parent id is
placed at the very end after “-“.

Attempting to change the parent item of the
already mapped item is not currently supported.
Parent item will be linked to the current item
being mapped only during the first creation of
this item to VSTS. The later the scheduler runs,
any updates related to parent item will not get
updated. *If user did not enter/wrong input the
parent item in the project field in PJO, delete the
item from VSTS, and assigned the correct parent
item to the field in PJO, and have it synchronized
back to VSTS/wait for the scheduler to run.
Sample of the input for work item type to be
synched to VSTS and work item type that will be
synched to PJO as Task: (Same rule regarding
work item type case sensitivity when getting input
in the GUI, explained above)

@®OnePlan 43



Integrations

» Work item types in VSTS that will be synched to
Project Online as Task schedule needs to be at
the same project area path with its parent project
area path. For instance, from the picture below, a
user want to synched work items that are below
“VSTS Test Hans Epic” as Task in Project Online,
with this specified work items type only: Feature,
Task, and Bug. So these items need to have the
same area path as “VSTS Test Hans Epic” which
is shown in the second picture below.

* Work item types need to be at an iteration to get
synched to Project Online. Only tasks and bugs
need to be in an iteration; other work item types
(Non-Bug and Non-Task) will just be brought over
to Project Online as Tasks.

» VSTS Synchronize Button Functionality
Expectation:

» Create a newly created project in Project
Online to VSTS work item type.

+ If the item has already been created/synched
to VSTS before through the button, the next
time the button is clicked, it will only update
back to Project Online from VSTS. Any
updates in Project Online to VSTS will never
be made through the button (Therefore, the
“ProjectPublish” strategy is needed to synch
over updates from Project Online to VSTS).

Deploy OnePortfolio into

Project Online

Since the Project Online site already exists, the
OnePortfolio lists need to be added individually.
There are numerous list templates to be uploaded.
Maijority of the list templates are without content.
A few of the list templates have content, or need
to have content added. i.e. Years, Expense Types,
etc.

Templates

» Actual Costs

* Benefits

* Budgets

» Capacity

» Changes

» Cost Categories

» Expense Type (Add Content - Capital &
Operational)

» Forecast

* Initiatives (*Optional/If Using, SP Form in use)

* Issues

+ Portfolios (SP Forms in use)

* Requests (*Optional/lf Using, SP Forms in use)

* Resource Plan

* Resources

* Risks

* Roadmap

+ Status Reports

+ Strategic Themes

+ Style Library (Add Content - Portfolios.js)

» Workflow Tasks

* Years (Add Content - 2018, 2019, 2020, etc.)

SP Forms

Saved/exported SP forms to be imported to the
following lists

+ Portfolios (Separate New, Display, Edit)
* Requests (New, Display, Edit all the same)

Workflows
Add the following two workflows:

+ Portfolio Approval Workflow (Portfolios List)
» Create Status Report Workflow (Portfolios List)

Reports

» Update Queries to new site in the OnePortfolio
Main Report & publish to PowerBI

» Add Content - Report site page with Wicresoft
Report Viewer web part - point to published
OnePortfolio Main Report - set the page as the
home page

Features Purchased/Installed/
Activated

Necessary features:

* Power Bl
 SP Forms
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Project Online to OnePlan

This article explains how to set up the integration

between your OnePlan group/environment and
Microsoft Project Online.

This integration focuses on using Project Online
with OnePlan.

OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan.

1.

oW

Log in to your OnePlan group with your
Office365 account.

Open the Admin pages by clicking on the
Settings gear.

Select Integration in the admin navigation.
Click the + (plus) icon in the Authentication
Keys section.

Save the key name & generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.

General

OneConnect Setup

1.

K

NOTE

To complete the OneConnect
setup, you need have
Administrator or Editor privileges in
the OneConnect group you wish to
set the integration up in.

Go to https://my.oneconnect.ai.

2. Click Add Integration.
3. Locate the Project Online to OnePlan
integration.

|§ NOTE
There are two integrations

between Project Online and
OnePlan:

= Project Online o OnePl
m ( ] ) Comnectonerian

or

Project Online to OnePlan

- %0

4. Click Configure. The Integration configuration
form will open.
5. Complete the integration configuration form.
a. Complete the Project Online section.
» Site URL: Enter the
Project Online URL (e.g., https://
{OrganizationName}.sharepoint.com/
sites/{SiteName}).
+ Username: Enter the username.

@ NOTE
The username must

not have Multi-Factor
Authentication (MFA)
associated with it.
Because of this, we
encourage a service
account to be used to
access the SharePoint
site.

@®OnePlan 45


https://my.oneconnect.ai

Integrations

b.
c.

NOTE

It is standard best
practice to have a
single service account
be associated to a
single integration. If
a service account

is associated to
multiple integrations,
throttling can occur
from Microsoft, which
can lead to strategy
failures.

» Password: Enter the password for the
Username.

Site Url
Project Online Username

Password

* (Suggested) Client Id + Modern
Authentication Checkbox: If desired,
modern authentication is available.
For instructions to set up modern
authentication, see Set Up Project
Online Modern Authentication.

Client Id

his is checked)

* (Optional — Checkbox) Use timesheet
hours as actuals:

* (Optional - Checkbox) On-premises
Project Server: If using Project Server,
check this box.

* (Optional) Enterprise Project Type
(UID):

Click Next.

Complete the OnePlan section.

NOTE

Expand the Additional
Options area to see all
the necessary fields to be
filled in.

K

* Group Name: Enter the OnePlan Group

name you will be integrating into.
Authentication Key: Enter the OnePlan
Authentication Key generated from
OnePlan.

(Optional) Alternate OnePlan
Environment URL.: If using an
alternative environment than https://
my.oneplan.ai,please select the
appropriate URL here.

K

NOTE

Options currently are:
https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

(Optional) OnePlan Default Plan
Type: This is to be used in replace

of the Portfolio Plan Type field

mapping, should one not be provided
automatically within the integration. This
is to provide a default plan type for any
plan level work items that are brought
into OnePlan. A single value should be
entered.
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Group Name

Authentication Key

Authentication Key Name

when connecting to OneFlan OData

*  Additional Options
P Advanced Options

» Relay Options
B
d. Click Next.
Integration Information

Functionality

This integration has two main use cases for
functionality.

Project Online and OnePlan (Task assignments to
Resource Engagements)

+ Ability to create/update Plan in OnePlan

* Ability to create/update Project in Project Online

* Ability to create/update Resource engagements
in Project Online based on Task Assignments in
OnePlan

+ Ability to create/update resources in OnePlan
based on Project Online resource pool

Project Online and OnePlan (Resource Plans to
Resource Engagements, Tasks to Tasks)

+ Ability to create/update Plan in OnePlan

* Ability to create/update Project in Project Online

* Ability to create/update tasks in Project Online

* Ability to create/update Resource engagements
in Project Online based on Resource Plans in
OnePlan

* Ability to create/update resources in OnePlan
based on Project Online resource pool

he OnePlan configuration

Button Added

" This integration installs the OnePlan button on the

PWA site ribbon.
Synchronize

* When the selected project has never been
synchronized before, this button will perform
“ProjectPublish” action on that project. Action is
further explained in the section below.

* When the selected project has been
synchronized/connected to a plan in OnePlan,
this button will perform “OnePlanToPjo” action
on that project. Action is further explained in the
section below.

Open in OnePlan

» Open the associated OnePlan plan.

BROWSE PROJECTS

9 &

New Open  Add SharePoinf OnePlan | Azure  Project for the
- - Sites - PevOps » Web »
Synchronize
Open In OnePlan

Scheduled Jobs / Actions Available

1. Project Online and OnePlan (Resource
Engagements to Task Assignments)

* ProjectPublish
» Create/update Plan in OnePlan
* OnePlanToPjo
» Create/update project in Project Online
+ Create/update Resource engagements in
Project Online based on Task Assignments in
OnePlan
» SynchLookups
» Synchronize any lookup fields values into any
choice fields in OnePlan
» SynchResources
» Create/update resources in OnePlan based on
Project Online resource pool

2. Project Online and OnePlan (Resource
Engagements to Resource Plans, Tasks to Tasks)

* ProjectPublish
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» Create/update Plan in OnePlan
* OnePlanToPjo
« Create/update project in Project Online
» Create/update tasks in Project Online
» Create/update Resource engagements in
Project Online based on Resource plans in
OnePlan
» SynchLookups
* Synchronize any lookup fields values into any
choice fields in OnePlan
» SynchResources
» Create/update resources in OnePlan based on
Project Online resource pool

Default Field Mappings

1. Project Online and OnePlan (Resource
Engagements to Task Assignments)

Projects (Project Online) <--> Plans (OnePlan)

OnePlan Fields

Name Name

Project Online Fields

Owner Owner

Enterpriseresourceengagements (Project Online)
<--> Tasks (OnePlan)

Project Online Fields OnePlan Fields
Start Date StartDate

Finish Date EndDate

Work Hours Effort

Email AssignedTo
Name Name

Resources (Project Online) <--> Resources
(OnePlan)

Project Online Fields OnePlan Fields
Email Email

isGeneric Generic

Name DisplayName

2. Project Online and OnePlan (Resource Plans to
Resource Engagements, Tasks to Tasks)

Projects (Project Online) <--> Plans (OnePlan)

OnePlan Fields

Name Name

Project Online Fields

Owner Owner

Enterpriseresourceengagements (Project Online)
<--> Resource Plans (OnePlan)

Project Online Fields OnePlan Fields
Email Resource

State State

Date (timephased) Date

Work Hours * (see note below)

* In order for the Resource Engagement to work,
you will need to add an extra mapping that
indicate the Resource Plan Cost Type/Type to the
‘Work Hours’. This field mapping indicates which
Resource Plan Type to bring into Project Online.

Resources (Project Online) <--> Resources
(OnePlan)

Project Online Fields OnePlan Fields
Email Email

isGeneric Generic

Name DisplayName

Tasks (Project Online) <--> Tasks (OnePlan)

Project Online Fields OnePlan Fields
Name Name

Start Date StartDate

Finish Date EndDate
Assigned To AssignedTo

Set Up Project Online Modern

Authentication

Only the tenant admin can able to set up

the Modern Authentication for Project Online (or
OneAnalytics) integrations. If you wish to locate the
SharePoint or Tabular Data, please navigate to the
SharePoint Modern Authentication page.

Create the App Registration within
Azure.

1. While logged in as a tenant admin for the
client’s organization, log in to portal.azure.com.

2. Navigate to the Azure Active Directory (Azure
AD).

3. Within the left navigation bar, go into the App
Registration page.

4. On the top Left of the page, create a New
Registration.
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a. Name: Give the App Registration Name a
title.

b. Supported Account types: Single
Tenant.

c. Redirect URL (Optional): Dropdown: Web.

URL: https://my.oneplan.ai.
d. Click Register.

Set Authentication

While in the overview for the newly

created App Registration, navigate to the
Authentication page (left navigation panel,
beneath Manage).

Scroll down to Implicit grant and hybrid
flows. Ensure that both the Access Tokens
and ID tokens checkboxes are selected.
Scroll down to Allow public client flows. Enable
the following mobile and desktop flows (ensure
this is set to Yes).

Click Save.

5y OneAnalytics Connector | A

Set API Permissions

1.

o OneAnalytics Connector | AP permissions

Once finished with the Authentication settings
for the App Registration, navigate to the

API Permissions page (left navigation panel,
beneath Manage).

Select Add Permission.

Beneath the Microsoft APlIs tab, select
SharePoint.

What type of permissions does your application
require? Select Delegated Permissions.

In the dropdown selections, choose these
permission levels:

All Sites: Full Control

Enterprise Resource: Write

Project: Write

Project Web App: Full Control

Project Web App Reporting: Read

. User: Read Write All

Once the Permission levels have been set,
click Add Permissions.

In the API Permissions page, click Grant
Admin consent for {Tenant Name}.

Click on Yes for the consent confirmation
popup.

~0 Q0T

OneConnect Setup

1.

While logged into OneConnect, go to the
OneAnalytics (or Project Online) integration.

In the Project Online setup

page, type in the Project Online

URL (https://{TenantSite}.sharepoint.com/sites/
{ProjectSite}).

Type in the Username + Password of the
service account being used (Project Online will
require a Username + Password along with the
Client Id).

Expand the Additional Options section:

a. Enter the Client Id.
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b. Check the Modern Authentication
checkbox.
5. Click Test to confirm that the connection works
as intended.

Project Online and Office 365

Planner

This integration allows user to synchronize Projects
from Project Online to Office 365 Plans. When
doing so, you can choose to sync tasks from
Project Online to the Office 365 Planner or not. It
will also bring back tasks and task updates from
Office 365 planner to Project Online.

Required: Admin consent/permission to access
Capabilities

» Synchronizing Projects from Project Online to
Office 365 Plans (Projects -> Plans)

» Synchronizing Tasks from 0365 Planner to
Project Online (Tasks <-> Tasks)

All of these operations are run by clicking the Office
365 Planner button in Project Online.

Project Online to Jira

Integrtation

This article explains how to set up an integration
between Project Online and Jira.

Integration Setup
For this integration, you will need to gather the
following information:

From Project Online

» Site URL
» Username and Password
* (Optional) Client ID

From Jira

+ Jira URL

» Username

* API Token. If using Jira Cloud, follow Generate
a Jira Cloud API Token [50] to generate an API
token.

Generate a Jira Cloud API Token

To generate an API Token using Jira Cloud, log into
the Jira environment to be used.

1. Navigate to id.atlassian.com/manage-profile/
security/api-tokens.
2. Click Create API token. A new window will

appear.
3. Give the API Token a Label.

4. Click Create.

5. The API Token will appear on the next page.
OneConnect

1. Go to my.oneconnect.ai.

2. Locate the Project Online to Jira integration.
Click the Configure button.

3. Complete the configuration form.
a. Complete the Project Online section.
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b.
c.

NOTE

Expand the Additional
Options area to see all
necessary fields to be
filled in.

K

+ Site URL: Enter the
Project Online URL (e.g.,
https://<organization>.sharepoint.com/
sites/<site>).

* Project Online Username: This will be
the email address that will need to have
access to the SharePoint site.

» Password: Enter the password for the
Username.

& Project Online

Site Url
Project Online Username

Password

* (Optional, Suggested) Client Id +
Modern Authentication Checkbox:
If desired, modern authentication is
available. See Set Up Project Online
Modern Authentication [48] for more
information.

Client Id

Click Next.

Complete the Jira section.

» Jira URL: Enter the
organizations Jira URL (e.qg., https.//
<organization>.atlassian.net).

* Username: Enter the Jira username
that will be used for the integration.

d. ClI

(Optional) Check this box to sync all
issues in the backlog

(Optional) Check this box to roll up
sub tasks, resources to its parent
(Optional) Check this box if you are
using Jira Server

ick Next.

Integration Information

Project Online Changes

The following Lookup Tables for Custom Fields
will be installed within your Project Online upon

installation of the integration.
Lookup Table Name Level Value
JiraProjectType 1 Business
1 Service Desk
1 Software

The following Enterprise Custom Fields will be
installed within your Project Online upon installation

of the integration.
Name Entity Type Lookup Table
Epic Task Text
Jira Original Task Text
Estimate
Jira Issue Type Task Text
Feature Task Text
Story Task Text
Iteration Task Text
JiraProjectType Project Text JiraProjectType
Jira Labels Task Text
Jira Fix Versions Task Text
Jira Components Task Text
Jira Reporter Task Text
Jira Priority Task Text
Jira Status Task Text

Default Field Mappings

Projects - Projects

. . Project Online Jira Direction Notes
. API To!(en. Enter the Jira T(?ken. If. Fields Fields
gsmg Jira Clouq, follow the instructions Name Project Both Required
in Generate a Jira Cloud API Token [50]. Name
* Issue Types: List the Jira issue types to JiraProjectType Project Both Required
be brought over into Project Online. Type
Owner Owner Both Required
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Tasks - Issues

Project Jira Fields Direction Notes

Online Fields

Iteration Sprint Both

Epic Epic Link Both

Jira Issue Issue Type Both

Type

Jira Original Original Both

Estimate Estimate

Assigned To Assignee Both

Remaining Remaining Both

Work Estimate

Start Date Start Date Both
(Sprint)

Finish Date Finish Date Both
(Sprint)

Name Summary Both

Actual Work Time Spent Both

Jira Labels Labels Both

Jira Fix Fix Versions Both

Versions

Jira Components Both

Components

Jira Reporter Reporter Both

Jira Priority Priority Both

Jira Status Status Both

Lookup Jira Project Type - Project Types

Project Online Jira Fields Both Notes
Fields
Lookup Value Type Name Both

Default Scheduled Strategies

SynchTypes: Synchronizes Jira Project Type Key
to Project Online lookup table.

ProjectPublish: Synchronizes Projects and Tasks
between Project Online and Jira.

JiraReleaseToMilestone: Synchronizes Projects
and Tasks between Project Online and Jira.
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MS Project for the Web Integration

Project for the Web integration

overview

This article explains the OnePlan and Project for
the Web integration. To set up the integration, see
Set up the Project for the Web integration [53].

Introduction

With the OnePlan and Project for the Web
integration, users are able to build out their project
plans in Project for the Web, and bring that project
plan into OnePlan to leverage advanced tools like
resource plans, status reports, and much more.

https://player.vimeo.com/video/557839899

Use cases
This integration has two main use cases for
functionality:

» Create or Update plans from OnePlan as a
Project in Project for the Web.

+ Create or Update tasks from Project for the Web
into OnePlan schedule.

For this integration, the project plan must be
created in OnePlan FIRST. Then, from OnePlan,
create a synced/mapped project in Project for the
Web. The projects should not be created manually
in Project for the Web.

Set up the Project for the Web

integration

This article explains how to set up the OnePlan and
Project for the Web integration. For an overview on
the integration, see Project for the Web integration
overview.

https://player.vimeo.com/video/556928192

Get an integration key from OnePlan

Ig NOTE
You must have administration

access to get an integration key
from OnePlan.

Log into OnePlan.

Click the Settings icon K3 to access the Admin
pages.

Go to Integrations.

In Authentication Keys, click Add Key. The
Add Key form will open.

Enter a name for the new key in the Key Name
field (e.g. "Project for the Web"). Click Add to
generate a new key.

Save the key name and generated key in

a secure location (e.g. copy/paste into a
protected OneNote notebook) for use in the
OneConnect configuration.

Authentication Keys
App Name Key

Reporting

Project for the Web | cixxnP3D2uRsuwxKCdORZ W zuI7726 |

S NOTE
Once you navigate away from

the OnePlan admin page, the
new key is encrypted.
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Set up the integration in OneConnect

1. InIntegrations, click New External
Integration. You will be redirected to
my.oneconnect.ai.

2. Under Integrations for OnePlan, select
OnePlan and Project for the Web
'Accelerator'. Click Configure. The integration
configuration settings will open.

Integrators s

Oneplan Oneplan onePlan  oneplan

nnnnnnnnnnnnnnnnnnnnn

<<<<<

3. Configure the OnePlan and Project for the Web

integration.
a. Complete the OnePlan configuration
section.

* OnePlan Group Name: Enter the name
of the OnePlan group that you are
connecting to.

* OnePlan Authentication Key:Enter the
OnePlan authentication key that has
been generated from the OnePlan
integration admin page.

+ Integration Key Name: Only use this
when connecting to OnePlan OData,
otherwise please leave it blank.

Ig NOTE
If you are using the

US tenant (my.oneplan.ai)
can skip Additional
Options, Advanced
Options, and Relay
Options. These settings
are not required to set up
the integration.

If you are using the EU,
CA, or AU tenant, you
need to enter your tenant
information into Additional
Options.

QnePlan

OnePlan Group Name (Enter the name of the OnePlan group that you are connecting to
here) *

OnePlan Authentication Key (Enter the OnePlan authentication key that has been
generated from the OnePlan integration admin page here)

Integration Key Name (Only use this when connecting to OnePlan OData, otherwise
please leave it blank)

» Additional Options
» Advanced Options

» Relay Options

b. Click Next.

Ig NOTE
The Project for the Web

section will open. You
will skip the Integrators
section. There is no
set up required in the
Integrators section.

c. Complete the Project for the Web section.
* Project for the Web URL.: Enter in the
CDS (Common Data Service)/Dynamics
URL.
e.g. https://
orgfdcac62c.crm.dynamics.com/
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d.

* Username and Password: Enter in
username and password that will be
used (Preferably a service account).

K

NOTE

The user needs to
have admin access
to the PowerApps
environment you are
connecting to, and
Project for the Web
licensing.

» Client Id (Azure App Id):
If you are a tenant admin: Click
Click here to approve consent to use
the default app registration for this
tenant (Admin Required).
Otherwise: Follow CDS (Common Data
Service) / Dynamics Setup [59]. Then
enter/paste the Application (Client) ID
from CDS/Dynamics that you saved
from the CDS/Dynamics Setup steps.

K

NOTE

The Client ID is not
needed if the default

app registration has been
approved.

4. Set up filters and field mappings. A filter

must be added to the OneConnect filters, to
distinguish which projects in Project for the
Web are to synchronize with OnePlan. Add a
filter for only Projects that don't have a blank
ID, in other words, don't include projects that
don't have a mapped OnePlan plan. The ID
fields referenced in the filter must also be
mapped in the field mappings section.

Logs +

Project for the Web integration

settings
This article describes the integration settings for the
OnePlan and Project for the Web integration.

See Project for the Web integration overview [53]
for an overview of the integration and its uses. See
Set up the Project for the Web integration [53] for
instructions to set up the integration.

Go to my.oneconnect.ai. On the home screen lists

q Project for the Web

Project for the Web URL

Username

Password

Client Id (Azure App Id) - Leave this blank if you have consented to use the default app

registration

¥ Advanced Options

¥ Relay Options

Test

Click Next.

all of your active integrations. Go to the desired

~ integration. Click Edit " to edit the integration

settings. Click View Scheduled Jobs = to view

and edit scheduled jobs. Click Delete ' to delete
the integration.

Edit the integration settings

23 Integration Properties

Update the integration configuration properties that
were set in Set up the Project for the Web
integration [53].
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o Your ntegration will expie in 25 day(s).

Integration Mappings +

OnePlan

Mappings

Update mappings for the integration in the
Mappings tab. In the Project for the Web
integration, there are five mapping types:

* Filters

NOTE

These Filters only relate to
Events, not Schedules.

* Fields

NOTE

The Tables mappings are not
editable.

Table Mappings

nnnnnnn

Field Mappings

» To edit a mapping:

Advanced +

« To add a filter rule:

1.

2.

Select the desired field type mapping. The
field mappings will open.

Click the direction arrow to change the
direction of the mapping.

Click Delete to remove a mapping.

Plans = Projects

Plans

m Projects

1. Select the desired mapping. -
2. Click Add Rule. B
3. Enter or create a filter expression.
4. Repeat steps 2-3 to add multiple filters to _
a mapping. » To add a mapping:
5. Click Save. 1. Select the desired fields from both sides of
o+ e o the integration (e.g. both a OnePlan Plan
5 field and a Project for the Web Project
field).
5 | o 2. Click Add Field Mapping. The new
mapping will appear at the bottom of the
* Tables mappings list.
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Plans = Projects

Value Mappings

& Projects Add Field Mapping
Stage - Effort (Hours) - [
* ltems
» To add value mappings:
— 1. Click on the desired field type. The value
mappings will open.
S 2. Click Add Value Mapping. The Add form
will open.
» To add item mappings:
1. Select the desired field type mapping. The
item mappings will open.
2. Click Add. The Add form will open.
E—— - 3. Complete the Add form:
* Field: Select a field from the drop down
»»»»» R menu.

» Source Value(s): Enter the source
values, separated by a comma.

* Destination Value: Enter the
destination value.

» Click Add Value Set to add additional
source and destination value fields.

3. Select a an item from both the Source and
Destination drop downs.
4. Click Save.

Add Add

Source Destination Field

Value Sets Acld Value Set

“ Close Source Valuets) © Destination Value ®

» To delete item mappings:

1. Select the desired field type mapping. The “ Close
item mappings will open.
2. Select an item mapping. 4. Click Save.

3. Click Delete.

Default field mappings
| Plans (OnePlan) <--> Projects (Project for the Web)

Table 1. Plans <--> Projects default field

»»»»» ﬁvmm .
o mappings
OnePlan field Project for the Web field Direction
Values Name Name Both
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OneP
Effort

lan field Project for the Web field Direction
Effort Both

Tasks (OnePlan) <--> Tasks (Project for the Web)

Table 2. Tasks <--> Tasks default field mappings

OnePlan field Project for the Web field Direction

Name Project Task Name Both

Effort Effort Both

Assigned To Assigned To Both
Schedules

To manually execute a scheduled job, click
Execute.

To delete a scheduled job, click Delete.

Add a new scheduled job

1. Cl
Wi

ick Add Schedule. The Add schedule form
Il open.

2. Complete the Add schedule form.

Strategy:

Enabled: When the Enabled switch is to
the right (on), the job will run on the set
schedule.

Schedule Type: Select the type of schedule.

Options include Daily, Monthly, and Hourly.
Day(s) of Week: Select the day(s) of the
week for the job to run.

Time(s) of Day: Select the time(s) of day for
the job to run.

TimeZone: Select the timezone for the
schedule to be based on.

Delta Type: Options include Incremental or
Full.

Delta Range: Options include Last Run,
Day, Week, Month, Custom, Hours, Days,
Weeks, Months.

Automatic Retry: Currently only available
for schedules that are set to run Daily

or Monthly with only one Time(s) of Day
specified. This setting is ignored if the
strategy uses the Schedule operation. E.g.
queues up multiple items to sync. If a
schedule fails 5 consecutive times during a
24 hour period, this setting is reset to false.
As there may be a problem that requires
investigation to resolve. Once the issue has

been resolved, this setting can be manually
set back to true.
3. Click Save.

.........

AAAAAA

v 0000000 2
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Add

Strategy

@ oo

Properties

Schedule Type

Days of Week Times) of Day

12am

Edit a scheduled job

1. Click Edit Schedule next to the desired job.
The schedule settings form will open.

2. Update the schedule settings form. See the
Add schedule form for settings details.

3. Click Save.

Configure job filters

1. Click Configure Filter next to the desired job.
The filter settings form will open.

2. Edit the filter settings as desired.

3. Click Save.

Default scheduled jobs

The following scheduled jobs are installed by
default:

* SynchLookups
Synchronize any mapped lookup/options set
fields’ choices from Dynamics into OnePlan.

* OnePlanUpdate
Synchronize projects and tasks from Project for
the Web to OnePlan.
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* OnePlanPublish

Synchronize OnePlan plans into Project for the

Web as projects

Logs

View the activity logs for the integration.

+ Statistics: A log of integration data collected
over the past five days.
» Events: A log of all transactions not tied to a

CDS (Common Data Service) /

K

schedule. E.g. transactions that were triggered

via action button.
» Schedules: A log of all transactions tied to a
schedule.

Logs -

Advanced

K

Dynamics Setup

NOTE

In order to do the CDS (Common
Data Service)/Dynamics setup,
you need to have an admin
account.

NOTE

The service account used

for integration must have the
‘System administrator’ or ‘System
Customizer’ role in Dynamics 365.

Make sure that an Admin account can grant the
admin consent for the API permission. Once it is
granted, the API permissions should each have the
status Granted for [organization name].

Move, install, or uninstall the current integration into 1

or between OnePlan groups.

Go to hitps://portal.azure.com. An Admin
account is required to approve API access.

« Migrate: Migrate the integration into another 2. On the top left comner, expand the portal menu
OnePlan group. navigation and select Azure Active Directory
+ Reinstall: Reinstall the integration into your 3. On the Ief’f navigation, select App
current OnePlan group. Rgglstratlons _ _ _
+ Uninstall: Uninstall the integration from your 4. CI'Ck_ Ne‘_” Registration. The Register an
current OnePlan group. application form will open.
5. Enter a name for the application in the Name
field.
Advanced ~
|§ NOTE
Migrate This is the user-facing display
name for this application, and
Reinstall can be changed at any time.
A 6. Click Register. Once registered, you will
Uninstall be directed to the recently created App
configuration home page.
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n | App registrations ¢

Register an application

- Projac forthe Web Integration - Test | A% permissions

14. Configure the Dynamics CRM API permissions
settings.
S— » What type of permissions does your
= application require?: Select Delegated
7. Save the Application (client) ID (e.g. copy/ permissions.
paste into a notepad doc) for use in the + Select permissions: check the checkbox for
OneConnect configuration. user_impersonation.
15. Click Add permissions.
: e ® Request API permissions X
8. On the left navigation, go to Manage > o
Authentication.
9. Update the Authentication settings.
» Supported account types: select © v
Accounts in this organizational directory
only.
+ Advanced Settings: set Allow Public
Client Flows to Yes.
10. Click Save to save the changes.
= Prosctfo the Web Itegration - Test | Authenticaion
[Esne] X oseas | 2 Gottessmacr
A %
11. On the left navigation, go to Manage > API
Permissions.
12. Click Add a permission. The Request API
permissions form will open.
13. Select Dynamics CRM.
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Project for the Web Accelerator Integration

6. Select Restore.

Project for the Web Accelerator

i - Set Up Timesheet Period
Integration - Pre-Integration et Up Timesheet Ferlods

Setup 1. In the OnePlan Config, navigate to Time Plan.
This article explains how to set up an integration 2. Click on the + ne_xt to Periods.
between OnePlan and Project for the Web (P4W) 3. Select Bulk Periods.
using the Accelerator. The Accelerator applies 4. Choose a Start date for your periods to begin
useful customizations to the Project for the Web on.
Power App. 5. Pick how many days are assigned in a
period.

The integration focuses on streamlining data 6. Pick the number of periods to be made in
between OnePlan and Project for the Web. bulk.

7. Click Add.

Files

OnePlan Backup: OnePlan(!Power Apps

: Power Apps Pre-Integration Setup
Accelerator Project Template)2022_09_15.backup

Project for the Web Accelerator

OnePlan Accelerator:

OnePlanProjectAccelerator_21_0_0_15.zip 1. Log into make.powerapps.com.

2. On the Top right of the page, click on the
environment that has Project for the Web.

3. Expand the Navigation Menu on the left (three

horizontal lines), click on Solutions.

You should see a few Display Names with the

name of Project and variations of the name

with msdyn_ProjectServiceCore.

At the top of the page, click on Import

Solution.

6. Click Browse to locate
Project_for_the_Web_Accelerator_1_7_0_5.

Licenses
Accelerator + Project for the Web: Project Plan 1

Accelerator + Project for the Web + Power BI: 4.
M365 / Project Plan 1 & Power BI

OnePlan Pre-Integration Setup 5.
Create a Blank OnePlan Group

1. Log into my.oneplan.ai’/home/newgroup.
2. Give the group a Name.

. o zip.
3. Click I(.‘.lt'elatzlGrlt()l(J)p. 'II'Dr:ls will create a new 7. Click Next.
completely blank OneFlan group. 8. Click Next.

4. Once the group has been made, contact
OnePlan to enable Advanced settings in the
OnePlan configuration.

9. Expand the Select a connection dropdown
and click on + New Connection. This will bring
the Microsoft Dataverse window appear asking
for consent of use.

10. Click Create.

Import Backup into OnePlan

1. In the OnePlan Configuration, navigate to 11. Login using Mod Administrator credentials.
Backup / Restore. 12. Return to the Import a Solution page and click

2. Click Import Backup. on Refresh. The connection information will be

3. Check the Include Content box. filled in.

4. Select Browse to locate the backup. 13. Click Import. This will take a few minutes to

5. Select the OnePlan(!Power import.

Apps Accelerator Project
Template)2022_09_15.backup file.

OnePlan Project Accelerator

@ OnePlan
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Click Import Solution.

Click Browse to locate the
OnePlanProjectAccelerator_21_0_0_15.zip.
Click Next.

Click Import. Wait until solution successfully
imports.

Once both Accelerators are imported into

the new environment, click on Publish All
Customizations.

Modify OnePlan Project Accelerator
Remote the Extra Financials Tab

1.
2.

In make.powerapps.com, click on Solutions.
Click on OnePlan Project Accelerator. A new
page will load.

Make sure that in the far-left panel, the
Objects section is highlighted.

In the Objects panel, expand Tables, expand
Project, click on Forms.

Click on Information. The Forms Template
page will load.

Click on the ellipses and select Switch to
Classic. A new tab will load with the classic
editor.

Click Ok.

In the top left corner of the page, there is the
Quick Launch that shows all the sections of the
OnePlan Accelerator.

11.
12.
13.

14.

o IMPORTANT

Notice there are two
Financials tabs:

» The top Financials tab,
when clicked, will have the
words Solution: OnePlan
Project Accelerator, and
Form: Project. Beneath the
words are two boxes:
Financials > Section >
oneplan_FinancialPlanner
. This is the Financials tab
to keep.

* The second Financials tab
will only have the OnePlan
Project Accelerator, and
Form: Project words (no
boxes underneath). This is
the Financials tab that must
be deleted.

Click on the second Financials tab.

Click Remove. An alert will appear confirming
the deletion.

Click Ok.

Click Save.

Click Publish. A yellow box will appear with
the word Publishing Customizations in the
middle.

Return to the previous browser tab that shows
the Forms Template, in the top right of the
page, click Publish.

Update code for Timesheets
Change the URL in the Code Snippet

<html><head>

<script src="https://ajax.googleapis.com/ajax/
<script src="ClientGlobalContext. js.aspx" type
<meta><meta><meta><meta><meta><meta><meta><met

<body style="word-wrap: break-word;"onfocusout

<iframe id=""iframe" allowfullscreen="true"

</iframe>
<script language=""javascript'>
debugger;
var Integrationld;
var EventManagerUrl = "https://service
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var Configld ; 4. Copy the Shareable
var currentUrl = parent.window.XKRPageay cofteitygetphieaitUri (O ;
Configld=2ca864fc-XXXX-XXXX-

var settings = { XXXX-1ec2281bXXXX&amp;Appld=64a1b4de5-
""async':true, XXXX-XXXX-XXXX-71b7e7dcXXXX)
""crossDomain':true, 5. Replace the bolded code with the Shareable

"url”: EventManagerUrl + "/GelHIntegrationsForSite?siteid=" + currentUrl + '
"headers':{

"cache-control:""no-cBRepéace Code Snippet for Timesheets

"postman-token' :""971b5492-1473-90fb-be27-f60a623F4425"

} 1. Copy the modified code snippet above.
3} 2. Go to make.powerapps.com.
debugger; 3. Click Solutions.
$.ajax(settings) .done(functioA(rédissrasednéPlan Project Accelerator.
debugger; 5. Ensure the Objects tab is selected in the far-
if(response.length > 0) { left column.
// B> Expantawdb Resdaegs. back to 0 $$$$$$$$SSS$S$SH
Integrationld=responsgitR ddiegrationld;
GetConfig(); 8. Locate OnePlan Timesheet, click on the 3
debugger; vertical dots.
3 9. Expand the Edit options, select Edit in
else { o Classic. A new tab will load with the classic
alert("This site has not agep configured for integrations.™);
} 10. Locate and click the Text Editor button. A new
H: window will appear.
. , 11. Click on the Source tab.
Iunctlon GetConfig() 12. Delete the code in this tab.
var settings = { 13. Replace code with the modified snippet from
"Yfasync'': true, above.
“crossDomain®: true, 14 Click Ok.
“url™: EventManagerUri5. Llick@aMuttonUrl?Integrationld=" + Integrationl
“method": "GET", 16. Click Publish. A yellow window will appear.
"headers":{ 17. Return to previous tab and click Done.
""*cache-control™: "no-cache"
} Project for the Web Accelerator
é.ajax(settings).done(funmtﬁqggltzﬁ)q - Integratlon Setup
var reg = new RegExp{hisprigesxpirinsibeytesptyp antiptegyation
var queryString = regbei@epdaealfE.and roject for the Web (P4W)
Configld = queryString§ing the Accelerator. The Accelerator applies
document . getE lementBy¥sRiUl Fysiperzatiops te theyProjsel foriheoWah an. ai 2Confi gl ¢
H; Power App.
</icript> The integration focuses onl streamlining data
</body></html> between OnePlan and Project for the Web.

1. Log into OnePlan.

2. Click on the user icon on the top right of the
page.

3. Click Share With.
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OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan. If the Advanced Settings
are enabled for your group, continue to the next
steps. If the Advanced Settings are NOT enabled,
contact OnePlan for assistance.

1. Log in to your OnePlan group with your
Office365 account.

2. Open the Admin pages by clicking on the

Settings gear.

Select Integration in the admin navigation.

Click the + (plus) icon in the Authentication

Keys section.

5. Save the key name and generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.

o

App Name. Ke,
Calendars
Reporting
Fields
Reporting S—
z nan

this

3 gration to this tenant, p inwith
Events
st "
Add Key
ion

WorkPlan  Befi

After the key is created, be sure to copy and store in safe location. You will
not be able to recover the key

OneConnect Setup

To complete the OneConnect setup, you need to be
an Administrator or Editor in the OneConnect group
you wish to set the integration up in.

1. Go to hitps://my.oneconnect.ai.

2. Navigate to OnePlan and Project for the Web
‘Accelerator’. Click the Configure button. The
configuration form will open.

nePLan and Project for the Web ‘Accelerator

(P ==

3. Complete the configuration form.
a. Complete the OnePlan section.
* App Name: Enter the OnePlan Group
name you will be integrating into.
» Key: Enter the OnePlan Authentication
Key generated from OnePlan.

(Optional) OnePlan URL: For clients
that have their oneplan.ai hosted
outside of the United States, please
enter the OnePlan URL used.

S NOTE
Options currently are:

https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai

Onean

Onefian Group Name (Enter the name of the Oneflan group that you are connecting
te hare) "

Oneflan Authentication Key [Enter the OnePlan authentication key that has been
generated from the OnePlan integration admin page here)

Integration Key Name (Only use this when cennecting te OnePlan ODat. otherwise

please leave it blani)

Click Next.
Complete the Project for the Web section.

Project for the Web URL: Enter

the Project for the web URL (https./
<Organization>.crm.dynamics.com/).
Username: Enter the email address that
will be used for this integration.
Password: Enter the password
associated with the username above.
Click Here to approve consent to use
the default app registration for this
tenant. Sign in using admin privileges to
grant access.

Click Next.
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Project for the Web Accelerator S R PSR Notes
Integ ratlon - DefaUIt Fleld Improve Improve Project to
. Employee Employee OnePlan
Mappings and Scheduled Retenon  Retention
. (ID)
Strateg 1es Priority Priority Project to
This article describes the default field mappings (ID) OnePlan
and scheduled strategies that are set up when Issue Issue Project to
the Project for the Web Accelerator integration is Health Health (ID)  OnePlan
installed. Lower Lower Project to
Cost Cost (ID) OnePlan
A = Overall Overall Project to
Default Field Mappings Health Health (D)  OnePlan
Plans - PrOJects Project Project Project to
Type Type (ID) OnePlan
OnePlan Project Direction Notes Risk Risk (ID) Project to
Fields Fields OnePlan
Name Name Both Required Stage Stage (ID) Project to
Timesheet Effort Project to OnePlan
Hours Completed OnePlan State State (ID) Project to
(Hours) OnePlan
Start Start Date Project to Timesheet Timesheet Project to (Recommended,
(Summary OnePlan Charge Charge OnePlan Temporary)
Task) (ID) Remove this
Due Finish Project to field mapping
(Summary Date OnePlan Timesheet Timesheet Project to (Recommended,
Task) Type Type (ID) OnePlan Temporary)
% % Project to Remove this
Complete Complete OnePlan field mapping
Owner Owner Project to Schedule Schedule Project to
OnePlan Health Health OnePlan
Manager Project Project to
Manager OnePlan Tasks - Tasks
Forecast Forecast OnePlan
9P OnePlan Project Direction Notes
Actual Actual OnePlan Fields Fields
Cost Cost to Project Name Name Both Required
et s OnePIlan Assigned To Assigned To Project to
to Project OnePlan
Benefits Benefits OnePlan Effort Effort Proiect to
to Project OnonPIan
Strategic Strategic Project to .
Alignment Alignment OnePlan Sl Sl g:?ée;;;:]o
(ID)
. Timesheet Effort OnePlan
Neer Neer Project to Hours (Actual Completed to Project
Staffing Staffing OnePlan Hours) (Hours)
Business Business Project to - .
Unit Unit (ID) OnePlan Due Finish CP):]OSDCI;?
Effort Effort Project to o o .
Health Health (D)  OnePlan % Complete % Complete gfg;‘l:;:’
Financial Financial Project to .
Task Task Project to
Health el {(12) SLEHCT] Dependencies Dependencies OnePlan
Funding Funding Project to (PFTW)
Source (Slgt;rce OnePlan Task Order Display Project to
(OnePlan Sequence OnePlan
System)
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Lookup Tables - Lookup Tables

OnePlan Project Direction Notes
Fields Fields

Improve Improve Project to

Employee Employee OnePlan

Retention Retention

(Plan) (Project)

Lower Lower Project to

Cost Cost OnePlan

(Plan) (Project)

Business Business Project to

Unit Unit OnePlan

(Plan) (Project

Task)

Priority Priority Project to

(Plan) (Project) OnePlan

Financial Financial Project to

Health Health OnePlan

(Plan) (Project)

Effort Effort Project to

Health Health OnePlan

(Plan) (Project)

Schedule Schedule Project to

Health Health OnePlan

(Plan) (Project)

Issue Issue Project to

Health Health OnePlan

(Plan) (Project)

Funding Funding Project to

Source Source OnePlan

(Plan) (Project)

Project Project Project to

Type Type OnePlan

(Plan) (Project)

Timesheet Timesheet Project to (Recommended,

Charge Charge OnePlan Temporary)

(Plan) (Project) Remove this
field mapping

Timesheet Timesheet Project to (Recommended,

Type Type OnePlan Temporary)

(Plan) (Project) Remove this
field mapping

Stage Stage Project to

(Plan) (Plan) OnePlan

Overall Overall Project to

Health Health OnePlan

(Plan) (Project)

Risk Risk Project to

(Plan) (Project) OnePlan

Default Scheduled Jobs

SynchLookups: This strategy will synchronize the
choice value options in Project for the Web into
the corresponding Choice field options mapped in
OnePlan.

OnePlanUpdate: Publishes data from Project for
the Web into OnePlan.

OnePlanPublish: Publishes data from OnePlan
into Project for the Web.

Project for the Web Accelerator
Integration - Add Power Bl to

the Accelerator
A Power Bl template can be deployed alongside the

Accelerator. Deploy the Power Bl template after the
OnePlan Accelerator.

Prerequisites

* An environment with Project for the web and the
Project Accelerator in it.

* Admin rights to the environment.

» The appropriate privileges to deploy the Power Bl
content pack to powerbi.com.

Deploy the Power Bl Template

1. Download the Power Bl template for the
Accelerator.

2. Deploy it using Power Bl Desktop or in
the PowerBl.com service.

3. When prompted for the environment
URL, use the base URL of
your environment. For example: https:/
myenvironment.crm.dynamics.com.

IMPORTANT

When you deploy the report,
ensure that your team will have
access to it. Learn more about
sharing in Power BI.

Modify the Project Accelerator
Prerequisites

1. Power Bl report has been deployed to
PowerBl.com.

2. A customized solution has been created to
include the changes. To create a solution
please review Create a solution.
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The Report menu currently points at a web
resource file containing HTML with instructions

on how to get the Power Bl Template with
theAccelerator. Since the Accelerator is managed,
the web resource cannot be edited. There are two

8.
options to have the report bring up the Power BI 9.
report:
Updating the report menu via Power
Bl embedded report
1. Sign into powerapps.com.
2. Select the environment containing the
Accelerator.
3. Select solutions > the customized solution >
Edit.
4. Select the Objects option.
5. New > Dashboard > Power Bl embedded.
IE an F
6. Give the report a name and choose the
workspace/report and save.
10.
o4 MNew Power Bl embedded da... = 11.
Display name * 12'
Type® @
.é\- B
l:_:‘ Power Bl dashboard
| ]US? environment variable -_
Power Bl workspace * ;
Power Bl report *
Power Bl Template for the Accelerator o
7. If not already added, add the site map to the

custom solution.

a. Add existing > more > Site Map.

b. Choose Project —
msdyn_ProjectServiceCore.

c. Click Add.

Select the site map and click Edit.
Select the Reports option under Reporting.

a. Select Type = Dashboard.

b. Default Dashboard = choose the report
from the drop down.

c. Click Save and close.

Sice And Cloie

Companents Properties

SUB AREA

Dastboard

Defaunt Dashboard

Agcelrater Flvpant

Farameter Passing

Click Publish.

Go back to the Project app and click Report.
The report will now show up along other
reports in the environment.

@ Requests Dashboard
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Updating the Report Menu via Web

Resource (full frame)

The Accelerator already contains a placeholder for
the Power Bl template. Once you've deployed the
Accelerator and the Power Bl template, follow these

</head>
<body onfocusout="parent.setEmailRange();"
<iframe width="100%" height=""100%" src:
</body>
</html>

steps to have the Power Bl report appear in the . clji:jis Ok to save the changes and close the
Accelerator. 9 ,
12. If not already added, add the site map to the
1. Once you have deployed the Power Bl custom solution.
template, open the report in PowerBl.com. a. Add existing > more > Site Map.
2. Select the file > Embed Report > Website or b. Choose Project —
portal. msdyn_ProjectServiceCore
c. Click Add.
¥ Share K ChatinTeams Q Get 13. Select the site map and click Edit.
. 14. Select the Reports option under Reporting.
ki a. Select Type = Web Resource.
& e p rog ram H b. URL = Accelerator Power Bl report.
NCIALS c. Click Save and close.
LTH » | B SharePoint enling - -
HEQA, e
NCIALS e
ELINE
STON, _m' -
3. Copy the link in the top box ("Here's a link you :
can use to embed content") and keep it handy. —
Secure embed code Tige
[ o A A T TR
4. Sign into Power Apps.
5. Select the environment containing the
Accelerator.
6. Select Solutions > the customized solution >
e ustomized solt 15. Click Publish.
7 Sele.ct the Objects option 16. Go back to the Project app and click Report.
8. New > more > Web resource. 17. 'Ie':t?r;e::g:igrl]ll now show up taking up the
9. Set the fields as follows: |
+ Display Name: Accelerator Power Bl report
* Name: Accelerator_report
+ Type: Webpage HTML
10. Create a new html file to upload with the follow
text. Update the “REPLACE THIS” with the
embedded string copied in step 3.
<html>
<head>
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How do | set up Project Desktop

for OnePlan?

This article explains how to configure your OnePlan
group for Microsoft Project Professional/Desktop.
When users publish their MS Project schedules to
OnePlan, data is mapped between the two tools
according the the Field Mappings. This requires the
Project Professional app be installed.

Go to the Admin pages, select Project Professional
in the navigation.

Admin Settings

When the Project Professional app is installed in
OnePlan, some fields may already be mapped. You
may add more mappings or delete mappings as
needed.

Fields

Field Mapping

Microsoft Project Field OnePlan Field Direction

Start Start Both
Finish Due Both
Cost Estimated Cost MS Project to OnePlan
% Complete % Done Bath

Actual Start Actual Start Both
Actual Finish Actual Finish Both

Remaining Cost Remaining Cost MS Project to OnePlan

Remaining Work Remaining Effort MS Project to OnePlan

Actual Cost Actual Cost MS Project to OnePlan

Add Mapping

Click the [+] icon to add another field mapping.
Complete the mapping form. When project
schedules are published to OnePlan, they are
mostly read-only. Yet, team members can update
the status of their work via the My Work page, and
then the Project Manager can pull the updates back
into their MS Project schedule.

* Microsoft Project Field: Select a field.

* OnePlan Field: Select a task-level field. If
needed, you may add more task-level fields on
the Fields settings (Create and edit fields).

 Direction: Select which direction the data maps
- either MS Project to OnePlan, OnePlan to MS
Project, or Both.

MS Project Desktop Integration

Add Mapping *
Microsoft Project | o6 N
Field:

OnePlan Field Status N
Direction: Both M

I
Il
"

User Setup

Each project manager who will build and/or manage
their project schedule in MS Project needs to install
the OnePlan to Project Connector on their local
machine.

Here are the instructions: Install the Project
Connector [70]

Install the OnePlan for Project

Connector

This article explains how to install the OnePlan for
Project Connector between OnePlan and Microsoft
Project. The OnePlan for Project Connector tools
allows project managers to build and manage their
project schedules in the MS Project Desktop, and
then sync the project schedule to OnePlan.

You must have Microsoft Project Desktop installed
locally on your machine to use the OnePlan for
Project Connector. Have Microsoft Project installed
prior to installing the OnePlan connector.

Install OnePlan for Project Connector

Tool

Navigate to the OnePlan Integration page
for Microsoft Project: hitps://oneplan.ai/integrations/
microsoftproject/.

Click the blue button to install the connector.
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Microsoft Project

Deliver all types of projects successfully by keepin ojects, resources and teams o

you can easily plan and collaborate on projects from
a project throu

all project ple

of the project. The flexible scheduling

Categories

locate resources by name, ski

Essentials | Featured

Productivty

Save the Download File

ﬁ One Plan For Project

Select Installation Folder LA

The installer will install One Plan For Project to the following folder.

To install in this folder. click "Next". To install to a different folder. enter it below or click "Browse"

Folder:
CiProgram Files\OnePlan\OnePlanForProject,

Browse,

Disk Cost.

If prompted, click Save. Do not click Run. Instead,

go to your Downloads folder (or wherever you may

have saved it).

Unblock Download File

You may prompted that the download file is
blocked. Open the properties for the download

Cancel < Back
% One Plan For Project - X
Confirm Installation (

The installer s ready to install One Flan For Project on your computer.

Click "Mext" to start the installation

file. On the general tab, select the check box for

Unblock.

- PR —

* Quickacees

@ onsoie
- Repsit ot
4 Doaumens Uit eDesian
= Ficures Troublasnoo compatiiy "
10545,

& windows (©)
- RecoveRY )

@ Nevwerk ®
 Descror B10sCH

——
[E——
Renae

o = |
)

Run Installer Setup Wizard

- X

&y

ﬁ%‘ One Plan For Project

Welcome to the One Plan For Project Setup Wizard

The installer will guids you through the steps required to install One Plan For Project an your
computer

WARNING: This computer program is protected by copyrightlaw and intemational treaties
Unauthorized duplication or distibution of this program, or any portion of it may resultin severe civil
or criminal penalties, and will be prosecuted to the maximum extent possisle under the law:

Cancel < Back

Gonce ook
ﬁ One Plan For Project - X
Installation Complete |

One Flan For Project has been successhully installed.

Click "Close" to exit

Please use Windows Updats o check for any critical updates ta the NET Framework.

<Back

Close

Cancel

@ OnePlan
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Open Microsoft Project

After the installation is complete, open Microsoft
Project. The first time you open MS Project, you will
be prompted to confirm installation of the connector
add-in. You may start with a blank schedule & build
it out, or begin with an existing schedule/template.
Click Install.

Microsoft Office Customization Installer

Publisher has been verified & \ﬁlf

Are you sure you want to install this customization?

Name: Project_and_OnePlan_Synch - Project_and_OnePlan_Synch
file:///C:/Program
Files/OnePlan/OnePlanForProject/Project_and_OnePlan_Synch.vsto
Publisher: 1Plan LLC

From:

‘While Office customizations can be useful, they can potentially harm your
computer. If you do not trust the source, do not install this software. Mare

Information...
Install Don't Install

OnePlan Menu in Microsoft Project

Once installed, the OnePlan Connector will show
the OnePlan menu.

Task Resource Report Project View Help

ﬁ E‘ \’:I_ll Qﬁ[onnect

[£%] Map Resources Hel
Open Publish Update = Vap Q P

Plan E% Settings

Synchronization Confiquration Help

OnePlan Connector Settings

Hide Resource Mapping on Publish: Select the
check box to skip the resource mapping on publish.
Users would instead click the Map Resources
button on the ribbon prior to publishing.

Check for Updates: Select the check box to auto-
check for updates each time you open MS Project.
You may also manually check for updates if you
leave that option unchecked.

Synch Choice Fields: Click this button to synch
the choice options for fields mapped between
OnePlan and MS Project.

R

[@) setiings - x

e | pubtsn
o o Olvie
158.75 days Tht check
ssdays  Thu
3days  Tha

budget
Hold kick-off ahrs Tud
me

18.25days  Tue oK Cancel
n  13.25days
ential 10 days Tue 10/8/19 Tue 10/22/19 Support]

OnePlan Help
The OnePlan Help menu directs the user to the
OnePlan online guide.

OnePlan User Guide

OnePlan to Microsoft Project Connector
Install the OnePlan for Project Connector
Use the OnePlan for Project Connector

View all chapters

Follow to the article How to Use the OnePlan for
Project Connector for how to connect your plan
and project schedule. Use the OnePlan for Project
Connector

Updates

If you have the Check for Updates box checked,
when a new version is available, you will be
prompted to download the latest version.

[@] pownload Update X

Latest CnePlan app version (V1.1.31) is available.

Would you like to download the new version?

Yes No

Use the OnePlan for Project

Connector

This article explains how to use the OnePlan for
Project Connector between OnePlan and Microsoft
Project. The OnePlan for Project Connector tools
allows project managers to build and manage their
project schedules in the MS Project Desktop, and
then, sync the project schedule to their Plan in
OnePlan.

72 @ OnePlan



Integrations

From within OnePlan, users can see resource
load across all projects, dive into project schedule
details, view the Gantt, timeline, critical path, etc.
Also, users can do additional collaboration (even
task-level). Users can also view & work with the
tasks in a KanBan board.

You must have both Microsoft Project Desktop and
the OnePlan for Project Connector installed locally
on your machine to use the OnePlan for Project
Connector. The Project Professional app must also
be installed in OnePlan by your admin.

New Plan without a Schedule of Tasks

Typically, you will already have a plan with details,
but not yet a schedule. Navigate to the Schedule
Grid page for your plan. If you don't yet have a plan
in OnePlan, create it. Later, when publishing from
Microsoft Project, you'll be prompted to select your
plan.

) e vigration

Open Microsoft Project

Build your task schedule. When ready to publish,
open the OnePlan menu.

s @ Help

K Name ~|D - Start sh v Predecessors
Azure Migration 84 Wed 10/9/1 Mon 2/3/20
< Initiating 7.5days?  Wed 10/9/19 Fri10/18/19

“Develop Project  3.5days?  Wed 10/9/19 Mon
Charter 10/14/19

Identify Goals 1 day? Wed 10/9/19 Wed 10/9/19 Project Director
and Objectives
Develop 1day? Thu 10/10/19 Thu 10/10/19 3 Project Director

- Research 1day? Fi10/11/19 Fri10/11/19 4 Project Manager

Experience
- Develop Project 0.5days? ~ Mon Mon s Project Manager,
Charter 10/14/19  10/14/19 Acceptor
+Develop adays? Mon Fri10/18/19 2
Preliminary Project 10/14/19
Scope Statement

GANTT CHART

Connect to OnePlan Group and Plan

Click Connect. Authenticate to your Office365
account.

22 Microsoft

Pick an account

ovillamshokudemocom

~+  Use another account

Select OnePlan Instance and Group

You may have access to multiple OnePlan
instances and/or groups. If so, first select your
OnePlan instance.

R —

Please select a OnePlan instance for connection

my.oneplan.ai N

Select

Then select your OnePlan group,

[@] onePlan Groups X

Please select a OnePlan group

@ OnePlan
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Connection Successful

OK

Save Plan

Save your project schedule as the same name of its
corresponding plan in OnePlan.

@

< v 4 <« Documents > OnePlan > Ms Project Schedules v O | Search Ms Project Schedules 0

Organize ~  New folder

=] Pictures Name Status

= This PC B ©
B 3D Objects
B Desktop

[ videos

& Windows(© 5

I File name: | Azure Migrationmpp | o

Save as type: | Project (mpp) v

A Hide Folders Tools ~ Save Cancel

Publish Project Schedule to OnePlan

Now that your Project file is connected to OnePlan,
it's time to publish this schedule to OnePlan.

Click Publish.

Task  Resource Report Project View Help  OnePlan

ﬁ L_’_\ [ = connect

N [F] Map Resources | @ Help
open [publish Ppdate

Plan [ Settings

Synchronization Help

Select Plan

The connector looks for the existing plans in your
OnePlan group. Select your plan.

OnePlan Plans X
Please select a OnePlan plan

Azure Migration

Desert Skies

Employee Portal Launch
Fabrikam

Hooli

Office365 Launch

Rose Desktop App

Software Development

Support Customers using Mobile
VOIP Phones

Map Resources / Build Team

You may map resources before publishing, by
selecting Map Resources in the OnePlan menu. Or,
you may wait to be prompted to map resources
during the publish process.

Custom Filters for Mapping Resources

If you have a large Resource Center in OnePlan,
you may add filters to limit which resources show
for mapping. Select a resource-level field, such

as department, role, etc. Select the operator, and
enter the desired filter value. If adding additional
rows, select And/Or for how the filters should work
together. Once the filters are set, you may minimize
the filter section again to map the resources.

Menu options: Refresh/Apply Filter, Save Filter, Add
Filter Row, Remove Filter Row

[@) Build Team - X
Filter OnePlan Resources
Saved fiters: [All Resources v

] Custom Filters

=N

Save Filter

If you expect to use the same or similar filters, click
the Save Filter icon. Enter the filter name. It will
now show under the saved filters drop down.
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Filter OnePlan Resources
Saved fiters: [All Resources <

# Custom Filters

Field Neme.

Operator Value AndiOr
| Business Unit | Equal v [ or |v
» o Business Unit | Equal v Product Development ~

Build Team

OnePlan Resources Microsoft Project Resources

Daniel Williams
Project Manager
Business Analyst

Save Filter

Adam Noshimuri

Amy Comelll 1T & Dev Resources|

Grace Williams save || Concel ||
Erwin Zischka [ Erwin Zischka
Patrick Sands. e Support

Map Resources

Select the name of a OnePlan resource on the left

Build Team

Filter OnePlan Resources

| Custom Filters
Build Team

‘OnePlan Resources ~
Daniel Williams

Project Manager

Business Analyst

Developer

Support Add >
Kono Kalakaua

Replace >

Steve McGarrett
Adam Noshimuri

9/ Remove
Amy Comelll

.
Erwin Zischka
Lisa Andrews
Lori Weston

» lMM—

Microsoft Project Resources
Daniel Williams

Project Manager

Acceptor

Application Architect
Technical Architect

Quality Assurance Manager

omaas Manager

(106 ot show on pubiish again

Publish Cancel

You may select the check box to not show
on publish (you'll still be able to manually map

side. Select the name of a resource from your MS

Project schedule on the right side. Click Replace.
This will replace any references to that MS Project

button.

schedule resource with the name of the OnePlan

resource.

Build Team - X
Fi
Saved f

% Custom Filters
Build Team

ces o lig roject Resources
ol of
A A4 TOTeCTNERgeT
Support Add > Technical Architect

Kono Kalakaua Quality Assurance Manager

Contracts Manager

©

Replace >
Steve McGarrett

‘Adam Noshimuri Remove
Amy Comelll

Grace Williams

Erwin Zischka

Lisa Andrews

Lori Weston

Datrick Sani v

ok Cancel

Select the name of a OnePlan resource on the left
side. Click Add. This will add the name to the MS

Project schedule list of resources.

Build Team - x
Filter OnePlan Resources
Saved fiters: [All Resources >

# Custom Filters

Build Team
OnePlan Resources A Microsoft Project Resources
Daniel Williams >
Project Manager Project Manager

Business Analyst

| Replace >
Steve McGarrett

Acceptor

Application Architect
Technical Architect

Quality Assurance Manager
Contracts Manager

Adam Noshimuri Remove

Amy Cornelll

Grace Williams

Erwin Zischka

Lisa Andrews

Lori Weston

Datrick Sand hd

[J0 not show on publish again publsh Cancel

If a name is mapped that you want to change,
select the row on the right side, then click the
Remove button.

resources via the ribbon button).

Once all mappings are done, click the Publish

| @ uild Team
; Filter OnePlan Resources

i Saved filters: ~

# Custom Filters

! Build Team
OnePlan Resources ~ Microsoft Project Resources
D C
Project Manager Wo Fat
| Business Analyst Acceptor
1 Developer Kono Kalakaua
Support Addl> Steve McGarrett
| Kono Kalakaua T Grace Williams
Steve McGarrett Erwin Zischka
1 Adam Noshimuri SENEE Support
| Amy Comelll
1 Grace Williams
Enwin Zischka
'J Lisa Andrews
Lori Weston

1 [0 ot show on publish again |

|

Task Import Progress

Importing tasks to OnePlan...

Publish Successful

Task Import Progress

Publish Successful

Close

@ OnePlan
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Open Plan in OnePlan

Open the Schedule Grid page of your plan. If you
were already there, refresh your browser. The tasks
will show for your plan now.

View Which Plans are Connected to

MS Project

Navigate to the Portfolios page. Any plans
connected to MS Project will show the Project icon
on the row.

My Portfolio

R R R C

Proposed (1) On Track. (1) On Track:

Proposed (1) On Track. (1) On Track.

o Jooms oo |
|

R R R

Updated Team

Any tasks assigned to resources in the MS Project
schedule when mapped and published will be
added to your plan team (Shared With).

Shared With: Hooli x

Current Team

Steve McGarrett smegarrett@hokudemo.com

Updates in Project Schedule

Through the life of the project, come back to your
MS Project schedule. Click the Update button to
review the updates to tasks made by the team
members. If there are no updates, you'll be notified.
Otherwise, you may review to accept or reject the
updates.

“ Task Resource Report Project View Help OnePlan

3 a5z 2 Connec
@ iy B [ S

%] Map Resources Hel
Open Publis} Update aMap 0 P
Plan F};Seﬁings

Synchronization Cenfiquration Help

There are no tasks to be updated back into this project.

Map Custom Fields in the

OnePlan to Project Connector

This article explains how to map OnePlan fields
and Project fields using the OnePlan to Project
Connector.

This procedure requires the Project Professional
app to be installed in your OnePlan config. See
How do | Add Apps to OnePlan? for more
information.

This procedure also requires the OnePlan for
Project Connector to be installed and configured.
See Install the OnePlan for Project Connector
and Use the OnePlan for Project Connectorfor
instructions.

Map Custom Fields in the OnePlan
and Project Connector

1. Go to the OnePlan admin pages > Project
Professional.

2. Click New Mapping. The New Mapping form
will open.

3. Configure the new custom field mapping using
the New Mapping form.
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» Microsoft Project Field: Select the MS
Project field you would like mapped to the
selected OnePlan field.

* OnePlan Field: Select the OnePlan field
you would like mapped to the selected MS
Project field.

» Direction: Select the direction you would like
data to flow in the field mapping. Options
include MS Project to OnePlan, OnePlan
to MS Project, and Both.

Add Mapping x

2t -

Click Add to create the new field mapping.
Open Microsoft Project Desktop.

Open the OnePlan menu > Settings.

Click Synch Fields to sync the field mappings
you configured in OnePlan.

No ok

BERR®O0

Import Microsoft Project
Schedule into OnePlan

This article explains how to import your Microsoft
Project schedules into OnePlan.

You would want to use these steps when you are
migrating from Microsoft Project to OnePlan as your
main project management tool.

1. Follow Install the OnePlan for Project
Connector to install Project Connect in
Microsoft Project.

2. Follow Use the OnePlan for Project

Connector [72] to publish your Microsoft
Project schedule into OnePlan.

3. Disconnect Microsoft Project from the schedule

in the OnePlan Work Plan.

a. Click the Connected Systems icon in
the Work Plan header. The Connected
Systems popup will open.

b. Click Disconnect to disconnect Microsoft
Project from the schedule.

Support Customer using Mobile

4. Select the grid options menu = > Check
Schedule. The schedule check will run. Once
it is complete, click Ok in the Check popup
that appears. Save your work plan to save any
adjustments made during the check.

@ |support Customer using Mobile
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How do | store Project
schedules in Teams for my
OnePlan group?

This article explains how to set up your OnePlan
group to store Microsoft Project Desktop files in a
shared Teams Files document library.

This feature requires BOTH the Project
Professional and Microsoft Teams apps be installed
and configured for your OnePlan group.
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Why should we use this feature?
This feature allows the schedule files to be in a
shared document library, in other words a central
hub for your OnePlan group's schedule files. The
latest version is saved and accessed from the
central library. So, there is no longer the need to
look for the latest version or need to use email

to share Project schedule files between users.
This new feature also prevents people publishing
over each other from local desktop copies of the
schedule, which could be out-of date.

Install Apps

If you haven't already installed the required
OnePlan apps, do so first.

How do | set up Project Desktop for OnePlan? [70]

How do | manage OnePlan in Microsoft Teams?
Configure the Microsoft Teams app and create a
group-level team for your OnePlan group.

Open Files in SharePoint

Navigate to Teams. Select your OnePlan group-
level team.

1. Open the Files library.
2. Click Open in SharePoint.

n Generalar Files JWiki OnePlan +
| —
+ New 3 Syne

T Upload v G Sync

@ Copylink & Download + Add cloud s,

Create "Plans"” Document Library

1. In SharePoint, add an app.
2. Select Document Library as the type.
3. Name the Document Library "Plans".

Settings X

SharePoint

Sdd 3 page

Ite COTLENTS
Library settings
Restore this library
Site information
Site permissions
Site usage
Change the look
Site designs

Upload Microsoft Project Templates

oM~

In SharePoint, add an app.

Select Document Library as the type.

Name the Document Library "PlanTemplates".
Upload your Microsoft Project .mpp templates

Project Desktop to OnePlan

migration best practices

This article describes the process to migrate a
Microsoft Project Desktop schedule to OnePlan
Workplan.

Phase one

You must have both Microsoft Project Desktop and
the OnePlan for Project Connector installed locally
on your machine to use the OnePlan for Project
Connector.
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Update the Capital-Expense field p——— s o e
1. Make sure Microsoft Project is closed. . . =
2. In Teams, go to OnePlan > MPP Files. = UU“IHE‘ T [NE

_ * Tables = ¥ |[Nc

Teams =
Data
ﬂ OnePlan
General
Core Team © 9. Migrate over to the Capital-Expense column
MPP Files & (Make sure you are on the Gantt Chart View).
8 10. Right click and insert column (Text10). If
OoCcM column Text10 contains values then insert
UAT © column Text11, and if Text11 contains no

values then Copy and Paste the values from
Text10 into Text11 column. If Text11 contains
values then try inserting Text12, and so on,
until you find a text column which has no

3. 3. In MPP Files, click Files at the top, then
click the ellipsis (...) and Open in SharePoint.

[ I values.
B weprites o s A O G Meet
New T T _r.':'ﬂ M
Text10 » Capital-Expense -
. . G
4. Click on the project name c
[ T Eeeeees— ] L c J
[ t c
= . C

11. Highlight the entire Capital-Expense column,
then right click and Copy the values from
the column. Paste the values into the Text10

5. Make sure Profile references your connection
column.

to MS Project Server.
6. Click Work Offline. , —

« Toaxid - i i | Pk -
c
G
Logn | e

] EC
(o7 Loael fearreriay Brscsart ¢ Asugrere=ia -

C
E
E

7. Click View on top Ribbon. -
8. Click Outline > All Subtask. 12. Right click on column heading for Text 10.

Click Custom Fields. The Custom Fields
form will open.

mmEAmOoOOO 000
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I
2 i | i ||
Taxtl _H’ ~u
E #
E oy £
E — £
E Ea i
E ! 1 3 | 1 L
E ]
E .c'l.' AWt _ d
= & a
E rt ol &
E - | e i i ]
E 1
E I ]| 1
F =
E A Text Styl .
E 2 Setting a
E £
E | Custom Fields #
E I A Thu 3M1C
13. In the Custom Fields form, click Rename.

Custom Fields X

Field

(®) Task (O Resource Project Type: Text ~

Text10
Text11
Text12
Text13
Text14
Text15
Text16
Text17

v

Rename... Delete Add Field to Enterprise... Import Field...

14. Type in the name as “Capital or Expense” in
the New name for 'Text10’ field and click OK.

Rename Field X

New name for ‘Text10"

Capital or Expense

oK Cancel

NOTE: The field will map to Capital-Expense
in the work type Schedule.

15. Click OK to finish renaming.

16. Click OK to finish renaming.

17. Update column C&E Complete in SharePoint
to value YES to indicate file has been updated.

18. Start over at step 4 (click on project name) to
update the next project.

Phase two

Phase two cannot be started until the project
names have been added to OnePlan.

Connect your migrated schedule to
OnePlan using templates

To continue to use the connected MPP schedules
without navigating to the team site folder library, a
project must be connected as a template.

All migrated schedules have been added to the
template library.

Your Project should now open in Project
Professional Desktop.

1. Go to my.oneplan.ai and find your project in the
Portfolios list.

2.  Open your project.
3. On the ellipse (...) after the project name select
Shared With.

| 1909052 - NS Centralized Asset Man...

View Planning «

@ 19090 i

4. Start typing your last name in the Add User
field.

5. Select your name once it appears. The system
automatically adds you.

6. Click in the Access column next to your name.
7. Change your access to Owner.

Shared With: 1909052 - NS Centralized Asset Management - Phase 2 (Implementation)

-urrent Team

-~ Thornton, Denise

®  Shuits Melody

8. Close the screen by selecting the X in upper
right corner.
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9. Go to Work Plan > List.

Details Resource Plan Work Plan - R¢

du

10. In the toolbar, click the Microsoft Project icon.

|1205316 - OPTCS Project
e - o Paning v 7 v E

© 1205316 - OPTCS Project Not Started <

11. Select Project Professional and click Next.

Select Connection Type

Project Professiona

12. Find the matching and appropriate schedule
from the Select Template drop down.

Select Option

13. Click CREATE PLAN.

Select Option

sct Template 1205316 - OPTCS Project v

14. Click Yes to the Microsoft Office File Warning
Screen.
NOTE: The pop up may not appear directly
on your screen. It may end up behind another
application. If this happens you may need to
minimize or close your applications until the
pop up appears.

Some files contain viruses that can be harmful to your
' 4, computer. Itis important to be certain that this file is from a
trustworthy source.

Do you want to open this file?

Program: Microsoft Project

Address:
https://nsconline.sharepoint.com/sites/MigrationTesting/Plan

5/2109541 - Parking Assignment Optimization - PAQ
Implementation for OR.mpp

Yes | No |

15. Select Computer when the Login screen pops
up.

Login

Load Summary Resource Assignments

Work Offline

Cancel

Publish Project Schedule to OnePlan
using MS Project Professional

1. Open the Oneplan Tab on the MS Project
Professional ribbon menu.

2. Click Publish.

- % B 7 2109471 SAP CAP Jira (1) - Project Professional
File Task Resource Report Project View Help
@ 5) Connect @ Help
] _ -
o P
Publish | Update Open #g2 Map Resources (i) About
Plan
[8 Settings 2] Publish Info

Synchronization Configuration Information
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3. Ifthe OnePlan URL screen appears, leave the
default to United States.
4. Click Select.

[ OnePlan URL - b4

Please select a OnePlan instance for connection

I United States w I

Select

-

5. The OnePlan Authentication screen will open.
Log in using you NS (Norfolk Southern) Corp
account.

& Microsoft

Pick an account

Melody. Shults@nscorp.com

E Shults, Melody
Signed in

6. The OnePlan Group select screen may appear.

Select Migration Testing and click OK.

@ OnePlan Groups

Please select a OnePlan group

Search group...

NS OnePlan
NS Resource Import

7. The following resource mapping screen will
appear.

Map your resource to the resources in

OnePlan.

a. Click to select the resource in the
OnePlan Resources column.

b. Click to select the matching resource
in the Microsoft Project Resources
column.

c. Select Replace. A check mark will appear
on the Microsoft Project Resources.

d. Repeat for all remaining active resources.
Inactive resources will not appear in
OnePlan Resources list and should be
skipped.

NOTE:The owner of the Plan will show already

mapped. You must remap the owner because

it is connected to the wrong account. They will
show as duplicate entry in the Microsoft Project

Resources section.

For example:

Creech Terry
[] Creech; Terry

To correct this, you will need to remove

the Owner, for example Creech Terry, from
Microsoft Project resources by highlighting and
clicking Remove. Then map Creech; Terry to
the Oneplan resource on the left. Always map
the owner's name with the semicolon (;) in it.
NOTE: If you do not see the check boxes

in the Microsoft Project Resource section try
adjusting you monitor display to 1920 X 1080.
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9. Select Publish in the lower right of the
resource mapping screen.

10. The following pop up will appear. If the pop up
does not appear, go back up to the OnePlan
Tab and select publish again.

OnePlan Publish X

All the tasks have been queued for publish. Please allow some time for
the publish process to complete.

Go to 'Publish Info’ in the toolbar to view the progress.

11. Select OK.

12. On the OnePlan tab, select Publish Info.

13. Log in using your nscorp account.

14. Publish screen will appear with process status.
Validate the process has completed.

15. Close project and select Yesto save.

16. Click Close on the Connected System
screen.

Q Status: Connected

Open a Published schedule in
OnePlan

1. Go to my.oneplan.ai.

2. On the left navigation select Portfolio icon.

3. Alist of Projects that you are the owner of will
appear.

4. Click on the Project Name you just published to
in the previous steps.

5. Go to the Work Plan tab.

Select List from the drop down.

7. Select work type Schedule.

o

8. Review the schedule and confirm data has
published from Project Desktop, especially
Capital and Expense.

9. Review the tasks in the Oneplan schedule and
confirm the PM (Project Manager) and other
resource have been mapped to tasks.

10. Click the the Project Professional icon and
confirm you can open the schedule directly
from the work plan type Schedule.

Archive section

1. If the OnePlan URL screen appears. Leave the
default to United States.
2. Click Select.

[ OnePlan URL - A
Please select 3 OnePlan instance for connection

United States v
Select

3. OnePlan Authentication screen will open. Log
in using you NS (Norfolk Southern) Corp
account.

& Microsoft
Pick an account

IE Shults, Melody

Melody Shults@nscorp.com

Signed in
4. OnePlan Group select screen appears.
5. Select Migration Testing and click OK.
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@ OnePlan Groups

Please select a OnePlan group

Search group...

Migration Testing
NS OnePlan
NS Resource Import

6. A selection screen will appear where you can
select the associated Project in OnePlan to
connect to.

7. Search to find the matching plan in OnePlan.
Click the plan to select it and click OK.

NOTE: If you do not see your project listed,
STOP and follow the steps beginning with step
5 to make yourself an owner of the project.
Once you are an owner on a project you can
then import a schedule.

How to clear cache in MS

Project Professional?

In order to clear the cache in Microsoft Project
Professional we will start with the product opened
with a blank project schedule as shown below.

Important, DO NOT have any project schedules
opened at this time in Microsoft Project.

Continue with the following steps:

1. Click the File tab then select Options in the
Quick Launch.

Open
Project Web App

L] PWA - INTEGENT

@ OneDrive - INTEGENT LLC

INTEGENT LLC

OneDrive - Personal

2. Once in the Project Options dialog, select the
Save(1) page, then click the Clean Up Cache
(2) button.

3. Inthe Clean Up Cache dialog perform the
following:

+ + Select all the projects in the Remove
projects from cache section. Use Shift-
click to simplify selection.

+ Click the Remove From Cache button.

Note: The screenshot on the left is before we
cleared projects from the cache. The screenshot

shows the cleared cache.

1. While still in the Clean Up Cache dialog,
change the Project Filter to Projects checked
out to you via the drop down list box.

Remove projects from cache

roject Filter | Projects not checked outtoyou [ |
= "| Projects not checked out to you N =
File N; Modified
B Projects checked out to you (Kp)| Modified

2. If there are any projects showing up in

the cache now, perform the same procedure

and clear them from the cache (Important,

ensure you do not currently have any projects
opened!)

» Select all the projects in the Remove
projects from cache(1)section. Use Shift-
click to simplify selection.

» Click the Remove From Cache(2) button.
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Click the Close button when finished.
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MS 365 Planner Integration

Set up the Microsoft 365 |§

Planner integration

This article explains how to set up the integration
between your OnePlan environment and Microsoft
365 Planner.

NOTE

Once you navigate away from
the OnePlan admin page, the
new key is encrypted.

https://player.vimeo.com/video/556935360 Set up the integration in OneConnect

Get an integration key from OnePlan 1. In Integrations, click New External

NOTE

You must have administration
access to get an integration key
from OnePlan.

K

Log into OnePlan.

Integration. You will be redirected to
my.oneconnect.ai.

susagy

Under Integrations for OnePlan, select

2. Click the Settings icon KA to access the Admin OnePlan and M365 Planner. Click Configure.
pages. The integration configuration settings will open.
3. Go to Integrations.
4. In Authentication Keys, click Add Key. The Integrations
Add Key form will open. T
5. Enter a name for the new key in the Key Name S .
field (e.g. "Project for the Web"). Click Add to
generate a new key.
Configure the OnePlan and Microsoft 365
Planner integration.
a. Complete the OnePlan configuration
section.

* OnePlan Group Name: Enter the name
of the OnePlan group that you are
connecting to.

6. Save the key name and generated key in + Authentication Key: Enter/paste the

a secure location (e.g. copy/paste into a
protected OneNote notebook) for use in the
OneConnect configuration.

Authentication Keys
App Name Key

Reporting

Project for the Web | cixnP3D2URIuWKCAORZAW1zuI7T a6 |

OnePlan Key that you saved from the
earlier OnePlan Setup steps.

* (Optional) OnePlan URL.: For clients
that have their oneplan.ai hosted
outside of the United States, please
enter the OnePlan URL used

86

@ OnePlan


https://player.vimeo.com/video/556935360
https://support.microsoft.com/en-us/office/protect-notes-with-a-password-in-microsoft-onenote-280af2bf-0959-4889-9191-e326b2bbedee
http://my.oneconnect.ai

Integrations

@ NOTE
Options currently are:

https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

OnePlan

OnePlan Group Name (Enter the name of the OnePlan group that you are connecting to

| MikeTestProd
|

OnePlan Authentication Key (Enter the OnePlan authentication key that has been
enerated from the OnePlan integration admin page here)

Integration Key Name (Only use this when connecting to OnePlan OData, otherwise
please leave it blank)

» Additional Options
¥ Advanced Options

» Relay Options

b. Click Next.

@ NOTE
The M365 Planner

section will open. You
will skip the Integrators
section. There is no
set up required in the
Integrators section.

c. Complete the M365 Planner configuration
section.
* Click Authorize
» Check the select this checkbox to allow
updates to Office 365 planner tasks

d. Click Next.
Integration Information

Functionality

This integration has two main use cases for
functionality.

1. Create or Update plans from OnePlan as a
Plan in Microsoft 365 Planner.

2. Create or Update tasks from Microsoft 365
Planner into OnePlan schedule.

Scheduled Jobs

*Microsoft 365 Planner currently does not support
scheduled jobs.

1. OnePlanUpdate
+ Synchronize plans and tasks from Microsoft
365 Planner to OnePlan
2. OnePlanPublish
+ Synchronize OnePlan plans and tasks into
Microsoft 365 Planner as plans and tasks

Default Field Mapping
Plans (OnePlan) <--> Plans (Microsoft 365 Planner)

OnePlan Fields Microsoft 365 Planner Direction
Fields

Name Project Name Both

Owner Owner Both

Tasks (OnePlan) <--> Tasks (Microsoft 365
Planner)
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OnePlan Fields Microsoft 365 Planner Direction
Fields
Name Task Name Both
StartDate Start Date Both
EndDate Due Date Both
% Done % Complete Both
Assigned to Assigned to Both
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Azure DevOps Integration

Azure DevOps Epics Integration

- Integration Overview

This article explains the main use case and out-
of-box capabilities for the integration between
OnePlan and Azure DevOps: Epics, using the
OneConnect integration platform.

https://player.vimeo.com/video/559670924

About

OneConnect for Azure DevOps offers a seamless
approach to exchange critical information between
development teams and project teams using
OnePlan and Azure DevOps.

This integration specifically synchronizes plans
from OnePlan as Epic work items (typically stories,
tasks, and bugs) and synchronizes work items back
to OnePlan as backlog items.

Agile Project Visibility in Oneplan
Synchronize key data between OnePlan and Azure
DevOps to establish enterprise level portfolio

level visibility. Regardless of team execution
methodology (i.e. waterfall or agile), projects are
centrally visible for analysis and reporting.

» "Epics": OnePlan plans sync as Epics under a

selected Team Project & Area Path.

Epics Process

This is the high level process flow for using the
integration.

1.

As Epics reside beneath a parent Azure
DevOps Team Project & Area Path, the Team
Project & Area Path(s) must first exist in Azure
DevOps before creating the plan in OnePlan.
Create a new plan in OnePlan. When

the integration is configured, a new field

will be created in OnePlan. The field is
"TeamProjectsArea," which is a lookup table
populated with the Team Projects & Area Paths
from Azure DevOps. Select an Area Path
under the Team Project.

Teams may use their normal process for
project approval, portfolio analysis, etc.

When a project is active and ready to

execute using Azure DevOps with an

agile methodology, the PM synchronizes the
project to Azure DevOps by clicking on the
synchronize button. A new Epic is created with
the same plan name under the earlier selected
Team Project & Area Path.

The PM builds out the project's agile plan
under the epic - the features, user stories, task
& bugs.

The PM puts work items (stories, tasks, and
bugs) into an iteration. This is important, as
only items noted into an iteration will sync back
to OnePlan.

Team members work using Azure DevOps

as usual. They update status on work items
(stories, tasks, and bugs).

Updates sync back to OnePlan. The data

that syncs back is based on the configuration
settings mapped fields. This can be done on

a scheduled timed-basis or on-demand. The
schedule is part of the configuration settings
(hourly, daily, etc.). If syncing on-demand, you
must go into OnePlan and click Sync. This

will pull in the changes/updates from Azure
DevOps.

Back in OnePlan, the plan is updated with the
Azure DevOps work items as Backlog Items in
the plan.

Important Notes

The backlog item sync is bi-directional even after
the initial sync. You can create or edit data in
OnePlan or Azure DevOps and then sync to the
other system. The only fields that are not editable
in OnePlan are the ones you choose to only sync
from DevOps to OnePlan.

Sprints are synced into OnePlan.

The integration is also supported on Team
Foundation Services (On-Premise), but only for
the following versions: 2015, 2017, and 2018.
Must have full admin privileges/accounts in both
OnePlan & Azure DevOps to configure the
integration.

The default Azure DevOps Work ltem types are
Tasks and Bugs. These sync to the OnePlan
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work plan list as type: Backlog. Other types

can be configured to also come over, such as
Features, User Stories, etc. but they will still
come in as plan backlog items, in a flat hierarchy.

* Mapping projects from OnePlan to Azure DevOps

work item (Projects -> Epics):

Able to assign the mapped work item’s area
path in Azure DevOps. (Support multi-level
area path)

User entered the field over in OnePlan’s
projects field and specify its area path. When
the scheduler runs, the projects synched over
to Azure DevOps will get assign to the correct
area path.

User can update the area path of the work item
that has been mapped, when the scheduler is
run at future time. (Only area path within the
same level of team area project assigned to
the work item type at first synched to Azure
DevOps)

Able to generalize mapping work item type to
Azure DevOps. (Not specifically for Epics only)

» User can enter their valid desired work item type
over in the connector GUI, and specify the work
item type (Epic, Bug, Feature, etc..)

User can update/change the work item’s type
that has been mapped, when the scheduler is
run at future time.

Able to link the work item type to

its corresponding parent item type when
synchronizing the item from OnePlan to Azure
DevOps.

User will specify in the OnePlan’s projects field
its parent item type, and when the scheduler
runs, the item type being synchronized will be
linked to its corresponding parent item type.

* Mapping items from Azure DevOps to OnePlan
tasks (Tasks -> ltems):

Able to select the work item type in Azure
DevOps below the parent item and it will be
mapped as task schedule table in OnePlan.

* Mapping team area projects from Azure DevOps
to OnePlan lookup table (Lookup_Team Projects
Area -> Team Projects Areas)

Able to synchronized team area project level
(Currently support up to 100 levels) to a Team
Projects Area lookup table in OnePlan.

Restrictions/Rules/Limitations

Basic mapping rule: Make sure to map fields
that are required by the other side of the
connector (in this case is Azure DevOps), if the
fields are required by Azure DevOps, then map
the fields of that item to get synchronized from
OnePlan to Azure DevOps.

Empty Team Projects Area field in OnePlan is
not allowed. (*Has to have an area path for the
project)

To support multi-level area path in OnePlan’s
lookup table, user need to adjust the code mask
section in the lookup table settings based on the
number of level the user need. (eq. 4 level =
*EEED)

User can only enter a single work item type in
the Azure DevOps Work Item Type column in the
connector GUI.

If user does not enter/leave empty the work item
type column, it will by default be “Epic” work item
type.

Invalid input work item type will not let current
new item being synched gets created in Azure
DevOps.

Invalid input on work item type will not let current
item being synched gets updated on its item type
field in Azure DevOps, if this work item has ever
been mapped before.

When user enter a single work item type in

the GUI, it must be very specific to the work

item type shown in Azure DevOps (They are
case-sensitive). Take an example from the below
picture, when mapping “Epic” work item type,
the value entered on the GUI of the connector
must follow the same key word “Epic”, see the
highlighted part below. (Column name: Azure
DevOps Work Item Type)

When a user deletes an item in Azure DevOps,
the next time the scheduler runs, it will still
synchronize (recreate) that item from OnePlan
to Azure DevOps. Unless the item is also
deleted in OnePlan, then that item will never be
synchronized back to Azure DevOps.

Changing area path to a different team project
is not allowed by Azure DevOps. Only changing
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area path level within the same team project that
has been initialized at the first time the work item
is synchronized is allowed.

Parent item name declared in OnePlan lookup
table need to be in this specific format: “parent
name parent id”, where the parent id is placed at
the very end after “-“.

Attempting to change the parent item of the
already mapped item is not currently supported.
Parent item will be linked to the current item
being mapped only during the first creation of this
item to Azure DevOps. The later the scheduler
runs, any updates related to parent item will not
get updated. *If user did not enter/wrong input the
parent item in the project field in OnePlan, delete
the item from Azure DevOps, and assigned the
correct parent item to the field in OnePlan, and
have it synchronized back to Azure DevOps/wait
for the scheduler to run.

Sample of the input for work item type to be
synched to Azure DevOps and work item type
that will be synched to OnePlan as Task: (Same
rule regarding work item type case sensitivity
when getting input in the GUI, explained above)

Work item types in Azure DevOps that will be
synched to OnePlan as Task schedule needs to
be at the same project area path with its parent
project area path. For instance, from the picture
below, a user want to synched work items that
are below “Azure DevOps Test Hans Epic” as
Task in OnePlan, with this specified work items
type only: Feature, Task, and Bug. So these
items need to have the same area path as “Azure
DevOps Test Hans Epic” which is shown in the
second picture below.

» Work item types need to be at an iteration to get
synched to OnePlan. Only tasks and bugs need
to be in an iteration; other work item types (Non-
Bug and Non-Task) will just be brought over to
OnePlan as Tasks.

* Azure DevOps Synchronize Button Functionality
Expectation:

» Create a newly created project in OnePlan to
Azure DevOps work item type.

« If the item has already been created/synched
to Azure DevOps before through the button,
the next time the button is clicked, it will only
update back to OnePlan from Azure DevOps.
Any updates in OnePlan to Azure DevOps will
never be made through the button (Therefore,
the “ProjectPublish” strategy is needed to
synch over updates from OnePlan to Azure
DevOps).

Azure DevOps Epics Integration

- Integration Setup

This article explains how to set up the Azure
DevOps Epics to OnePlan Plans integration.

To set up this integration, you need:

 to have OnePlan and OneConnect approved by
an Office365 tenant admin

» to be a OnePlan admin, meaning you are a user
with Owner permissions in OnePlan

+ to be a OneConnect Administrator or Editor in the
OneConnect group where you want to set up the
integration

+ to be an Azure DevOps admin

OnePlan Setup

The following video walks through the steps to
set up OnePlan for the Azure DevOps Epics to
OnePlan Plans integration.

https://player.vimeo.com/video/730060278

For the integration configuration, you will need to
collect the following information from OnePlan:

+ the group name
* an authentication key
the authentication key name

1. Log in to your OnePlan group with your
Office365 account.
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2. Generate a new authentication key

a. Open the Admin pages by clicking on @ NOTE

the Settings gear. It is best practice to

b. Select Integration in the admin SRR £ SETEs BRI

navigation. to use for the integrations.
c. Click the + (plus) icon in the Authentication We strongly recommend setting up
Keys section. an Azure DevOps service account
d. Enter a name for the new authentication with admin permissions to use in
key. Then click ADD to create the key. this configuration.

@ NOTE
It is best practice 1

to create a new
authentication key for
each integration, and to

name each authentication
key so you know which a. Go to Azure DevOps.

integration it belongs b. On the top right-hand corner, click on User

to. For this integration, Settings and select Personal Access

Tokens. Once you are redirected to the

user settings page, click New Token and

fill out the information.

* Make sure to provide a token name and
only allow the token access within the
organization you are going to connect in

Copy and save the root of the URL (i.e. https://
dev.azure.com/Organization).

2. Generate an Azure DevOps Personal Access
Token.

we recommend a name
like "Azure DevOps
Integration”.

e. Save the key name and generated key
somewhere secure. Once you navigate

. OneConnect.
away, the key is hidden. o .
» Set the Expiration to be the maximum
(Azure DevOps only allows 1 year as
atenicaion e 7] the maximum token validity) by selecting

~ Custom Defined and select the dates.
: » Set the Scopes for the token to Full

Access.
@ NOTE
o0 ][ cnen If your Organization
does not allow Full
Access for any reason,
Azure DevOps Setup we understand. The
The following video walks through the steps to set integration requires the
up Azure DevOps for the Azure DevOps Epics and following permissions
OnePlan Plans integration. at minimum:
https://player.vimeo.com/video/730099480 Scope Permission
Name Level
For the integration configuration, you will need Identity Read and
to collect the following information from Azure Manage
DevOpS' Work Read,
’ Items Write, and
Manage

» the Azure DevOps URL
» an Personal Access Token
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Create a new personal access token X

Name

== ]

1 I QAVSTSEPIC I

°' ion (UTC
N~ Custom defined I 11/20/2020 i)

| Scopes

Authorize the scope of access associated with this token
gl Scopesf® Full access

Custom defined

o B
o

c. Click Create. After you click Create, you
will be provided with the token. Make
sure to save the token name, key and
expiration date somewhere (notepad, doc,
etc.), as once you close the tab, the
key will remain hidden. Also, note the
expiration date to extend the token once
it expires.

OneConnect Setup

1. Go to https://my.oneconnect.ai.

2. Navigate to OnePlan Plans and Azure
DevOps Epics. Click the Configure button.
The integration configuration form will open.

~
—
~—

3. Complete the integration configuration form.
a. Complete the OnePlan Section.

S NOTE
Expand the Additional

Options heading to see
all the necessary fields to
be filled in.

* Group Name: Enter the OnePlan Group
name you will be integrating into.

» Authentication Key: Enter the OnePlan
Authentication Key generated from
OnePlan.

* (Optional) Alternate OnePlan
Environment URL: If using an
alternative environment than https://
my.oneplan.ai, please enter the
appropriate URL here.

@ NOTE
Options currently are:

https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

* (Optional) Button Name: If connecting
multiple Azure DevOps organizations to
a single OnePlan Group, use this field
to create a custom name for the Azure
DevOps button connecting to the listed
Azure DevOps organization.

* (Optional) OnePlan Default Plan
Type: This is to be used in replace
of the Portfolio Plan Type field
mapping, should one not be provided
automatically within the integration. This
is to provide a default plan type for any
plan level work items that are brought
into OnePlan. A single value should be
entered.

l:*]_:‘) OnePlan

Group Name

Authentication Key

s generated in the integration tab within the OnePlan configuration

Authentication Key Name

when connecting to OnePlan OData
»  Additional Options
» Advanced Options

» Relay Options

BRI TN
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Click Next.
Complete the Azure DevOps Section.

S NOTE
Expand the Additional

Options tab to see all
the necessary fields to be
filled in.

* Azure DevOps URL: Enter the Azure

DevOps organization URL (e.g., https://
dev.azure.com/{OrganizationName}).
Azure DevOps Personal Access
Token: Enter the Personal Access
Token of the organization that will be
integrating into OnePlan.

Arure DevOps URL

Personal Access Token

Azure DevOps Plan Level Type: Enter
a single Azure DevOps work item type
that will be the Plan level item in
OnePlan. If there are more than one
work item types listed, no plans will be
brought in.

Azure DevOps Work Item Type:

Enter any work item type desired to

be imported from Azure DevOps into
OnePlan as a Backlog/Task level item.

Azure DevDps Plan Level Type

Azure DevOps Work ltem Type (Comma Separated)

Feature, User Story, Task, Bug

(Optional) Bring In Tasks and Bugs
that are not in an iteration/sprint:
(Default) When unchecked, only the
tasks and bugs that are in a sprint will
be brought in. When the box is checked,
all items will be brought in (even if no
sprint is selected).

(Optional) Allow creation and editing
of work items in OnePlan to be
brought into Azure DevOps: (Default)

When unchecked, users in OnePlan will
be unable to:
* Create new tasks
» Export changes made on tasks in
OnePlan back into Azure DevOps
d. Click Next.

OnePlan Changes When Integration
Setup is Complete

Once the integration is complete, three things will
occur in the OnePlan integration page:

* An integration line item is made.

* An integration event is created.

* Azure DevOps is now available in the Connected
Systems icon.

Integration Line item

Each item within the Integration section shows the
OneConnect integrations connected to the OnePlan
Work Plan.

Integration Event

Integration events are automated responses that
will bring data over from OnePlan into Azure
DevOps.

What this event does is trigger the OnePlanPublish
strategy for any item that is connected to Azure
DevOps. This will bring any values that are mapped
to go from OnePlan to Azure DevOps to be
updated.

What triggers this event is after a connected item
has been saved in OnePlan. At the plan details
page, this occurs after an item has been modified
and then is automatically saved. At the backlog
level, this is done after editing a field, and then
clicking Save.

Connected Systems

Any item that is connected to Azure DevOps
will show the Azure DevOps icon at both the
My Portfolio page, and for any item in the Work
Plan Backlog page for plans and tasks that are
connected to Azure DevOps.
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To connect an item from OnePlan into Azure
DevOps, navigate to the Work Plan - Backlog
page, click on the plug icon (Connected Systems
Icon) and select the options of connecting to an
existing item within Azure DevOps, or creating

a new item. Once the plan is connected, the
Connected Systems window can also be used to
Import, Export, or Open the Azure DevOps Plan
level item.

Azure DevOps Epics Integration
- Default Field Mappings and
Scheduled Jobs

This article explains the Azure DevOps Epics
to OnePlan Plans default field mappings and
scheduled jobs for your integration.

Default Field Mappings

IMPORTANT

After the integration is installed,

it is best practice to check the
default field mappings for errors or
missing mappings.

The following video walks through the default
field mappings for the Azure DevOps (ADO) and
OnePlan Epics integration.

https://player.vimeo.com/video/730357797

Plans - Epics

OnePlan Azure Direction Notes
Fields DevOps
Fields
Name Title Both Required
Plan Id Parent Both Recommended
(Structure) Item ID
Assigned Assigned Both
To To
Iteration Iteration Both Recommended
(OnePlan) Path
Iltem Type Work ltem Both Recommended
Type
Start Iteration ADO to
Start Date OnePlan
Due Iteration ADO to
End Date OnePlan
Effort Original ADO to
Estimate OnePlan
Points Story ADO to
Points OnePlan
Remaining Remaining OnePlan
Effort Work to ADO
Lookup Tables - Team Area Projects
OnePlan Azure Direction Notes
Fields DevOps
Fields
Team Project/ ADO to Recommended
Project Area OnePlan
Areas Name
(Plan)

OnePlan Azure Direction Notes
Fields DevOps
Fields
Name Title Both Required
Team Area ID Both Required
Project
Areas
Owner Assigned Both Required
To
Portfolio Work ADO to Recommended
Plan Plan OnePlan
Type Type

Backlog - Items

Lookup Tables - Pick List Lookup

IMPORTANT

This table is intentionally left
empty. Only choice fields should
be mapped in this table to run the
SyncLookupToADO strategy.

OnePlan Azure Direction Notes
Fields DevOps
Fields

Default Scheduled Jobs

The following scheduled jobs are installed by
default:
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OnePlan Update: Publish data from Azure
DevOps to OnePlan.

This strategy has a filter within the Azure
DevOps - OnePlan > Epics — Plans section.
This filter will only sync items that are already
mapped to OnePlan. Please talk to your OnePlan
Contact about filtering the information being
brought in from Azure DevOps. If this filter is
removed (and not replaced with an alternative
filter), all items will be brought into OnePlan.
OnePlan Publish: Publish data from OnePlan to
Azure DevOps.

This strategy has a filter within the OnePlan -
Azure DevOps > Plans — Epics section. This
filter will only sync items that are already mapped
to OnePlan. Please talk to your OnePlan Contact
about filtering the information being brought into
Azure DevOps. If this filter is removed (and not
replaced with an alternative filter), all items will be
brought into Azure DevOps.

Optional Strategies

These strategies are available to be scheduled
but are not installed by default. Click on the Add
Schedule button to see the list of strategies.

OnePlanPlanltemsCleanUp: Deletes OnePlan
task/backlog items that have been deleted from
Azure DevOps. This does not delete plans from
OnePlan.

SyncLookupToADO: Synchronize a list of items
from Oneplan to ADO lookup field.

Azure DevOps Epics Integration
- Recommendations and Best
Practices

This article describes OnePlan's recommendations
and best practices for the Azure DevOps Epics
integration.

Make Work Item Type a Plan Type

In OnePlan, the default Plan Types are: Portfolio,
Program, Project, Epic, Objective, Idea, and Key
Result. If the Work Item Type is of any other value
than the above list, then the plan will be imported,
but it will not be imported correctly and might be
considered “missing” from the My Portfolio page.

Set Up the Plan Type

While in OnePlan, navigate to Config > General >
Plan Types > Add Type. Add the Work Item Type
to the desired hierarchy level. Once complete, feel
free to run the OnePlanUpdate strategy against a
single plan to verify it worked.

@ NOTE
This field is case sensitive, if the

values do not match exactly, the
plan type field will remain blank.

My Plan is Missing from My Portfolio
To check if your plan was brought in, go to Home >
Plans > All Plans. Type in the name of the plan, if
the plan is there, look at the Plan Type column. If it
is blank, then you need to manually change this to
a valid plan type via the Reorganize button on the
left side of the plan name.

Make Integration Bi-Direction
OneConnect

1. Check the box Allow creation and editing of
work items in OnePlan to be brought into
Azure DevOps.
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2. The field mappings desired to go in both
directions are set correctly (Please do not
modify any of the fields marked as Required in
the Field Mappings section). To alter this, click
on the arrows between the options saved.

3. Add Value Mapping to any values that do not
match between Azure DevOps and OnePlan.
This is mainly used with Multi-/Choice fields.

OnePlan

+ (Task/Backlog) Ensure that any backlog item
going back into Azure DevOps has the
appropriate Item Type selected.

Multi-Organization Use

The ADO and OnePlan integration also supports
multiple Azure DevOps Epics integrations to the
same OnePlan group!

Each integration will be connected to a single Azure
DevOps Organization.

Authentication Keys

We highly recommend that each integration is given
its own OnePlan Authentication Key.

Button Name

For synching purposes, we recommend that each
integration be given a unique name, this name will
be used to differentiate between the Azure DevOps
Organizations when exporting data from OnePlan.

1. Within OneConnect, expand Additional
Options.

2. Fill out the Button Name field that will indicate
which Organization you are syncing to.

Azure DevOps Plan Hierarchy

Integration - Integration Setup

This article explains how to set up the integration
between OnePlan and Azure DevOps and
incorporate a hierarchy structure.

This integration focuses on synchronizing data
between OnePlan and Azure DevOps. Multiple
nested Work Item Types in Azure DevOps will

be imported into OnePlan as hierarchical plans.
Any other Work Item Types will be brought into
OnePlans’ Work Plan — Backlog section as tasks.

OnePlan Setup

For this integration, you will need to collect the
following information from OnePlan:

+ the group name
* an authentication key
+ the authentication key name

K

NOTE

To complete the OnePlan setup,
you need to be an admin

(user with Owner permissions) in
OnePlan.

—_

Log in to your OnePlan group with your
Office365 account.

2. Open the Admin pages by clicking on the
Settings gear.

3. Select Integration in the admin navigation.

4. Click the + (plus) icon in the Authentication

Keys section.

5. Save the key name and generated key
somewhere, as once you navigate away from
this browser page, the key cannot be seen.
This Authentication key is to be used at a later
step in the OneConnect configuration.

i OnePlan

Events

" Add Key

After the key is created, be sure to copy and store in safe location. You will
ot be able to recover the key

Azure DevOps Setup

For this integration, you will need to collect the
following information from AzureDevOps:

» the Azure DevOps URL
» a Personal Access Token

1. Copy and save the root of the URL (i.e. https://
dev.azure.com/Organization).
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2.

Generate an Azure DevOps Personal Access

Token.

a. Go to Azure DevOps.

b. On the top right-hand corner, click on User
Settings and select Personal Access
Tokens. Once you are redirected to the
user settings page, click New Token and
fill out the information.

» Make sure to provide a token name and
only allow the token access within the
organization you are going to connect in
OneConnect.

» Set the Expiration to be the maximum
(Azure DevOps only allows 1 year as
the maximum token validity) by selecting
Custom Defined and select the dates.

» Set the Scopes for the token to Full
Access.

K

NOTE

If your Organization
does not allow Full
Access for any reason,
we understand. The
integration requires the
following permissions

at minimum:

Scope Permission

Name Level

Identity Read and
Manage

Work Read,

Items Write, and
Manage

K

Create a new personal access token

Name

Q

()

fl QAVSTSEPIC I

ol o (UTO)
. Custom defined

| Scopes

Authorize the scope of access associated with this token
o L

Custom defined

I 11/20/2020

o B

c. Click Create. After you click Create, you

will be provided with the token. Make
sure to save the token name, key and
expiration date somewhere (notepad, doc,
etc.), as once you close the tab, the

key will remain hidden. Also, note the
expiration date to extend the token once
it expires.

OneConnect Setup

NOTE

To complete the OneConnect
setup, you need have
Administrator or Editor privileges in
the OneConnect group you wish to
set the integration up in.

Go to https://my.oneconnect.ai.

2. Navigate to OnePlan Plans and Azure
DevOps - Plans Hierarchy. Click the
Configure button. The configuration form will
open.
3. Complete the configuration form.
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a. Complete the OnePlan section:
(T'f: OnePlan

@ N OTE Group Name
Expand the Additional

Options area to see all (e Piar g et thak e InkEgration I Sonrectiag 1o
the necessary fields to be
filled in.

Authentication Key

v Ky is generated in the integration tab within the OnePlan configuration

* Group Name: Enter the OnePlan Group
name you will be integrating into.

Authentication Key Name

» Authentication Key: Enter the OnePlan s viees corneiciing 16 CEFlan OBt
Authentication Key generated from
OnePIan. P Additional Options

* (Optional) Alternate OnePlan » Advanced Options
Environment URL.: If using an ¥ Relay Options

alternative environment than https://
my.oneplan.ai, please enter the
appropriate URL here.

BRI TN

b. Click Next.
NOTE c. Complete the Azure DevOps section:
@ Options currently
include: lhttps.://htt y S NOTE
au.oneplan.ai, S: "
ca oneslan ai htth))S'// Expand the Additional
eu-one Ian.ai’ ’ Options area to see all
-onepian.al. the necessary fields to be
filled in.
* (Optional) Button Name: If connecting
multiple Azure DevOps organizations to
a single OnePlan group, use this field * Azure DevOps URL: Enter the Azure

to create a custom name for the Azure
DevOps button connecting to the listed
Azure DevOps organization.

DevOps organization URL (e.g., https://
dev.azure.com/{OrganizationName}).
Azure DevOps Personal Access
Token: Enter the Personal Access
Token of the organization that will be
integrating into OnePlan.

Azure DevOps URL

Personal Access Token

Azure DevOps Plan Level Type: Enter
multiple Azure DevOps work item types
that will be brought into OnePlan as
Plan level items. Please note that the
listed work item types must be nested
(i.e., Epics is the parent, Feature is the
child to the Epic).

@ OnePlan
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NOTE

Please ensure that

the hierarchy format
matches what is shown
in Azure DevOps, if the
order is not the same,
then the work items will
not be brought in.

K

* Azure DevOps Work Item Type:
Enter any work item type desired to
be imported from Azure DevOps into
OnePlan as a Backlog/Task level item.

Azure DevOps Plan Level Type

Azure DevOps Work Item Type (Comma Separated)

Feature, User Story, Task, Bug

* (Optional) Sync ADO team project
name to come into OnePlan as parent
plan type: (Default) When unchecked,
the Team Project Name is ignored and
not brought into OnePlan. If checked, it
will be brought into OnePlan as a parent
plan type of the plans being imported.

* (Optional) Bring in Tasks and Bugs
that are not in an iteration/sprint:
(Default) When unchecked, only the
tasks and bugs that are in a sprint will
be brought in. When box is checked, all
items will be brought in (even if no sprint
is selected).

d. Click Next.

OnePlan Changes After the Integration

is Complete

Once the integration is complete, three things will
occur in the OnePlan integration page:

* An integration line item is made.

» An integration event is created.

» Azure DevOps is now available in the Connected
Systems icon.

Integration Line Item
Each item within the Integration section shows the

OneConnect integrations connected to the OnePlan
Work Plan.

Integration Event

Integration events are automated responses that
will bring data over from OnePlan into Azure
DevOps. What this event does is trigger the
OnePlanPublish strategy for any item that is
connected to Azure DevOps. This will bring any
values that are mapped to go from OnePlan to
Azure DevOps to be updated.

What triggers this event is after a connected item
has been saved in OnePlan. At the plan details
page, this occurs after an item has been modified
and then is automatically saved. At the backlog
level, this is done after editing a field, and then
clicking Save.

Connected Systems

Any item that is connected to Azure DevOps
will show the Azure DevOps icon at both the
My Portfolio page, and for any item in the Work
Plan Backlog page for plans and tasks that are
connected to Azure DevOps.

To connect an item from OnePlan into Azure
DevOps, navigate to the Work Plan - Backlog
page, click on the plug icon (Connected Systems
Icon) and select the options of connecting to an
existing item within Azure DevOps, or creating

a new item. Once the plan is connected, the
Connected Systems window can also be used to
Import, Export, or Open the Azure DevOps Plan
level item.

Azure DevOps Plan Hierarchy
Integration - Recommendations
and Best Practices

This article describes OnePlan's recommendations
and best practices for the Azure DevOps Epics
integration.
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Make Work Item Types a Plan Type

In OnePlan, the default Plan Types are: Portfolio,
Program, Project, Epic, Objective, Idea, and Key
Result. If the Work Item Type is of any other value
than the above list, then the plan will be imported,
but it will not be imported correctly and might be
considered “missing”.

Set Up the Plan Type

While in OnePlan, navigate to Config > General >
Plan Types > Add Type. Add the Work Iltem Type
to the desired hierarchy level. Once complete, feel
free to run the OnePlanUpdate strategy against a

single plan to verify it worked.

K

NOTE

This field is case sensitive, if the
values do not match exactly, the
plan type field will remain blank.

My Plan is Missing from My Portfolio
To check if your plan was brought in, go to Home >
Plans > All Plans. Type in the name of the plan, if
the plan is there, look at the Plan Type column. If it
is blank, then you need to manually change this to
a valid plan type via the Reorganize button on the
left side of the plan name.

Make the Integration Bi-Directional

OneConnect

1. The field mappings desired to go in both
directions are set correctly (Please do not
modify any of the fields marked as Required in
the Field Mappings section). To alter this, click
on the arrows between the options saved.

2. Add Value Mapping to any values that do not
match between Azure DevOps and OnePlan.
This is mainly used with Multi-/Choice fields.

OnePlan

(Task/Backlog) Ensure that any backlog item going
back into Azure DevOps has the appropriate Item
Type selected.

Multi-Organization Use

We also support multiple Azure DevOps Plans
Hierarchy integrations to the same OnePlan group.

Each integration will be connected to a single Azure
DevOps Organization.

Authentication Keys

We highly recommend that each integration is given
its own OnePlan Authentication Key.

Button Name

For synching purposes, we recommend that each
integration be given a unique name. This name will
be used to differentiate between the Azure DevOps
Organizations when exporting data from OnePlan.

1. Within OneConnect, expand Additional
Options.

2. Fill out the Button Name field that will indicate
which Organization you are syncing to.

Azure DevOps Plan Hierarchy
Integration - Default Field
Mappings and Scheduled Jobs

This article describes the default field mappings
and scheduled jobs for the Azure DevOps Plan
Hierarchy integration.

Default Field Mappings

Plans - Plans
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OnePlan Azure Direction Notes
Field DevOps
Field
Name Title Both Required
Team Area ID Both Required
Projects
Areas
Owner Assigned To Both Required
Portfolio Work ltem Both Required
Plan Type Type
Portfolio Parent ltem Both Required
Parent Id ID
Backlogs - Items
OnePlan Azure Direction Notes
Field DevOps
Field

Name Title Both Required
Start Start ADO to

Date OnePlan
Item Type Work ADO to Required

Item OnePlan

Type
Due Finish ADO to

Date OnePlan
Assigned Assigned ADO to
To To OnePlan
Parent Id Parent ADO to Recommended
(Structure) Item ID OnePlan

Lookup Tables - Pickup List Lookup

OnePlan Azure Direction Notes
Field DevOps
Field
Team Project/ ADO to Required
Projects Area Name OnePlan
Areas
(Plan)

Default Scheduled Jobs

The following scheduled jobs are installed by
default:

* OnePlanUpdate: Publish data from Azure
DevOps to OnePlan.

* OnePlanPublish: Publish data from OnePlan to
Azure DevOps.

This strategy has a filter within the OnePlan -
Azure DevOps > Plans — Plans section. This
filter will only sync items that are already mapped
to OnePlan. Please talk to your OnePlan Contact
about filtering the information being brought into
Azure DevOps. If this filter is removed (and not
replaced with an alternative filter), all items will be
brought into Azure DevOps.

Optional Strategies

These strategies are available to be scheduled but
are not installed by default. Please click on the Add
Schedule button to see the list of strategies.

* OnePlanPlanltemsCleanUp: Deletes OnePlan
task/backlog items that have been deleted from
Azure DevOps. This does not delete plans from
OnePlan.

* SyncLookupToADO: Synchronize a list of items
from Oneplan to ADO lookup field.

Azure DevOps Team Projects

Integration - Integration Setup

This article explains how to set up the integration
between OnePlan and Azure DevOps based on the
Team Project.

This integration focuses on synchronizing data
between OnePlan and Azure DevOps. Each Team
Project within Azure DevOps can be imported into
OnePlan as its own plan. Any Work Item Types
listed can be brought into OnePlans’ Work Plan —
Backlog section as tasks.

To set up this integration, you need:

» to have OnePlan and OneConnect approved by
an Office365 tenant admin

+ to be a OnePlan admin, meaning you are a user
with Owner permissions in OnePlan

+ to be a OneConnect Administrator or Editor in the
OneConnect group where you want to set up the
integration

* to be an Azure DevOps admin

OnePlan Setup

For this integration, you need to collect the
following information from OnePlan:

» the group name
* an authentication key
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+ the authentication key name

S NOTE
To complete the OnePlan setup,

you need to be an admin
(user with Owner permissions) in
OnePlan.

—_

Log in to your OnePlan group with your
Office365 account.

2. Open the Admin pages by clicking on the
Settings gear.

Select Integration in the admin navigation.
Click the + (plus) icon in the Authentication
Keys section.

5. Save the key name and generated key
somewhere, as once you navigate away from
this browser page, the key cannot be seen.
This Authentication key is to be used at a later
step in the OneConnect configuration.

B ow

=

this tenant, logged in with a

= Add Key

an gef
After the key is created, be sure to copy and store in safe location. You will
9t be able to recover the key

Azure DevOps Setup

For this integration, you will need to collect the
following information from Azure DevOps:

» the Azure DevOps URL
» a Personal Access Token

@ NOTE
It is best practice to create

a service account to use for

the integrations. We strongly
recommend setting up an Azure
DevOps service account with
admin permissions to use in this
configuration.

Copy and save the root of the URL (i.e. https://

dev.azure.com/Organization).

Generate an Azure DevOps Personal Access

Token.

a. Go to Azure DevOps.

b. On the top right-hand corner, click on User
Settings and select Personal Access
Tokens. Once you are redirected to the
user settings page, click New Token and
fill out the information.

* Make sure to provide a token name and
only allow the token access within the
organization you are going to connect in
OneConnect.

» Set the Expiration to be the maximum
(Azure DevOps only allows 1 year as
the maximum token validity) by selecting
Custom Defined and select the dates.

» Set the Scopes for the token to Full
Access.
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OneConnect Setup

@ NOTE
If your Organization

does not allow Full

we understand. The

Access for any reason, @ NOTE

integration requires the
following permissions

at minimum:
Scope Permission
Name Level
Identity Read and
Manage
Project Read, 1.
and Write, and 2.
Team Manage
Security Manage
Work Read,
Items Write, and
Manage
3.
A\
Create a new personal access token X

Name

[ ]

Quaanization

| I QAVSTSEPIC I

°I g on (UTC)
- Custom defined I 11/20/2020 &=

| Scopes

Authorize the scope of access associated with this token
@I Scopes§® Full access

Custom defined

o B3 -

Click Create. After you click Create, you
will be provided with the token. Make

sure to save the token name, key and
expiration date somewhere (notepad, doc,
etc.), as once you close the tab, the

key will remain hidden. Also, note the
expiration date to extend the token once
it expires.

To complete the OneConnect
setup, you need to be an
Administrator or Editor in the
OneConnect group you wish to set
the integration up in.

Go to https://my.oneconnect.ai.

Configure the following integration: OnePlan
Plans and Azure DevOps Plans Hierarchy.
Click the Configure button.

OnePlan Pl

d Azure DevOps TeamProjects

Complete the integration configuration form.
a. Complete the OnePlan section.

* Group Name: Enter/paste the OnePlan
Group name from the earlier OnePlan
Setup steps.

» Authentication Key: Enter/paste the
OnePlan Authentication Key that you
saved from the earlier OnePlan Setup
steps.

* (Optional) Alternate OnePlan
Environment URL.: If using an
alternative environment than https://
my.oneplan.ai, please enter the
appropriate URL here.

@ NOTE
Options currently are:

https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

* (Optional) Button Name: If connecting
multiple Azure DevOps organizations to
a single OnePlan group, use this field
to create a custom name for the Azure
DevOps button connecting to the listed
Azure DevOps organization.

+ (Optional) OnePlan Default Plan
Type: This is to be used in replace
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of the Portfolio Plan Type field

mapping, should one not be provided
automatically within the integration. This
is to provide a default plan type for any
plan level work items that are brought
into OnePlan. A single value should be
entered.

C]q\fn OnePlan

Group Name

Authentication Key

1 Ky i generated in the integration tab within the OnePlan configuration

Authentication Key Name

when conmecting to OnePlan OData

» Additional Options
» Advanced Options

» Relay Options
[

Click the Next button.
Complete the Azure DevOps section.

K

NOTE

Expand the Additional
Options tab to see all
necessary fields for the
integration.

* Azure DevOps URL: Enter in the Azure
DevOps Organization URL (e.g. https://
dev.azure.com/{OrganizationName}/).

* Azure DevOps Personal Access
Token: Enter the Personal Access
Token the organization that will be
integrating with OnePlan.

Arure DevOps URL

Personal Access Token

* Azure DevOps Work Item Type
(Comma Separated): Enter any work
item type desired to be imported from
Azure DevOps into OnePlan as a
Backlog/Task level item.

Azure DevOps Work Item Type (Comma Separated)

Epic, Feature, User Story, Task, Bug

or Plans Hierarchy integrations.

* (Optional) Bring in Tasks and Bugs
that are not in an iteration/sprint:
(Default) When unchecked, only the
tasks and bugs that are in a sprint will
be brought in. When box is checked, all
items will be brought in (even if no sprint
is selected).

d. Click Next.

OnePlan Changes After the Integration

is Complete

Once the integration is complete, three things will
occur in the OnePlan integration page:

* An integration line item is made.

» An integration event is created.

» Azure DevOps is now available in the Connected
Systems icon.

Integration Line Item

Each item within the Integration section shows the
OneConnect integrations connected to the OnePlan
Work Plan.

Integrations

Integration Event

Integration events are automated responses that
will bring data over from OnePlan into Azure
DevOps. What this event does is trigger the
OnePlanPublish strategy for any item that is
connected to Azure DevOps. This will bring any
values that are mapped to go from OnePlan to
Azure DevOps to be updated.
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What triggers this event is after a connected item
has been saved in OnePlan. At the plan details
page, this occurs after an item has been modified
and then is automatically saved. At the backlog
level, this is done after editing a field, and then
clicking Save.

Connected Systems

Any item that is connected to Azure DevOps will
show the Azure DevOps icon at the My Portfolio
page.

To connect an item from OnePlan into Azure
DevOps, navigate to the Work Plan - Backlog page,
click on the plug icon (Connected Systems Icon)
and select New ltem to create that Project within
Azure DevOps. Once the plan is connected, the
Connected Systems window can also be used to
Import, Export, or Open the Azure DevOps Plan
level item.

Azure DevOps Team Projects
Integration - Default Field
Mappings and Scheduled Jobs

This article describes the default field mappings
and scheduled jobs when you install the

Azure DevOps Team Projects to OnePlan Plans
integration.

Default Field Mappings

Plans - Team Projects

OnePlan Azure Direction Notes
Fields DevOps
Fields
Name Project Both Required
Name
Owner Owner Both Required
Backlog - Items
OnePlan Azure Direction Notes
Fields DevOps
Fields
Name Title Both Required
Parent Id Parent Both Recommended
(Structure) ID
Assigned Assigned Both Required
To To
ltem Type Work Both Required
Item
Type

OnePlan Azure Direction Notes
Fields DevOps
Fields
Start Start ADO to
Date OnePlan
Due Finish ADO to
Date OnePlan
Points Story ADO to
Points OnePlan
Lookup Tables — Pick List Lookup
OnePlan Azure Direction Notes
Fields DevOps
Fields

This table is intentionally left empty. Only choice
fields should be mapped in this table to run the
SyncLookupToADO strategy.

Default Scheduled Jobs

The following scheduled jobs are installed by
default:

* OnePlanUpdate: Publish data from Azure
DevOps to OnePlan.

* OnePlanPublish: Publish data from OnePlan to
Azure DevOps.

Optional Strategies

These strategies are available to be scheduled but
are not installed by default. Please click on the Add
Schedule button to see the list of strategies.

* OnePlanPlanlitemsCleanUp Deletes: OnePlan
task/backlog items that have been deleted from
Azure DevOps. This does not delete plans from
OnePlan.

* SyncLookupToADO: Synchronize a list of items
from Oneplan to ADO lookup field.

Azure DevOps Team Projects
Integration - Recommendations

and Best Practices
This article describes OnePlan's recommendations

and best practices for the Azure DevOps Team
Projects integration.

Choose a Plan Type for Team Projects
Please note that at this time, Team Projects will be
brought into OnePlan without a plan type due to the
varied expectations of all our clients.
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It is highly encouraged that a Default OnePlan
Plan Type be entered within the OnePlan
Connector for those items to be found within the
My Portfolio page.

To change the plan type for the Team Project, go
to the Home Icon > and underneath the Plans
section, click on All Plans. From here, locate the
hamburger icon on the left side of the plan in
question (it should have a blank Plan Type), and
select Reorganize. A new window will appear, and
the plan type can be selected from there.

Multi-Organization Use

We also support multiple Azure DevOps Team
Projects integrations to the same OnePlan group.

Each integration will be connected to a single Azure
DevOps Organization.

Authentication Keys

We highly recommend that each integration is given
its own OnePlan Authentication Key.

Button Name

For synching purposes, we recommend that each
integration be given a unique name. This name will
be used to differentiate between the Azure DevOps
Organizations when exporting data from OnePlan.

1. Within OneConnect, expand Additional
Options.

2. Fill out the Button Name field that will indicate
which Organization you are syncing to.

@ OnePlan

107



Integrations

Azure Active Directory Integration

Azure Active Directory to
OnePlan Resource Center

Integration - Integration Setup

This article explains how to set up the Azure Active
Directory to OnePlan Resource Center integration.

OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan. If the Advanced Settings
are enabled for your group, continue to the next
steps. If the Advanced Settings are NOT enabled,
contact OnePlan for assistance.

1. Log in to your OnePlan group with your
Office365 account.

2. Open the Admin pages by clicking on the

Settings gear.

Select Integration in the admin navigation.

4. Click the + (plus) icon in the Authentication
Keys section.

5. Save the key name and generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.

w

i OnePlan

Enable OnePlan App Permissions
These steps will require action from the client's
Tenant Administrator to enable app permissions
and consent.

1. Log into your OnePlan group using your
Office365 account.

2. Open the Admin pages by clicking on the
Settings (gear) icon.

Select Users on the Admin Navigation panel.
Expand the AD Synchronization section.

At the bottom of the section, locate: To
Synchronize users, you must enable app
permissions: here. Click on the blue here
button to allow the tenant administrator to grant
permissions.

K

o R~

NOTE

The Tenant Administrator will
have to provide their Tenant
Credentials to approve the
app permissions.

6. After enabling the app permissions,
navigate to https://my.oneplan.ai/account/
Consentlntegration to provide admin consent
for the specific OnePlan Group.

K

NOTE

The Tenant Administrator will
have to provide their Tenant
Credentials to approve the
app permissions.

OneConnect Setup

To complete the OneConnect setup, you need to be
an Administrator or Editor in the OneConnect group
you wish to set the integration up in.

1. Go to https://my.oneconnect.ai.

2. Navigate to Azure AD Users to OnePlan.
Click the Configure button. The integration
configuration form will open.

Aaure AD Users to OnePlan
IA ‘ 1 ' Syne data from Azure AD Users to OnePlan Respurces

3. Complete the Azure AD Users to OnePlan
integration configuration form.
a. Complete the Azure AD section.

108 ®OnePlan


https://my.oneplan.ai/account/ConsentIntegration
https://my.oneplan.ai/account/ConsentIntegration
https://my.oneconnect.ai

Integrations

NOTE

Expand the Additional
Options heading to see
all the necessary fields to
be filled in.

K

Tenant Domain: This is the URL for
the tenant organization, this can be
found in Azure Active Directory >
Overview > Primary Domain URL (i.e.,
TenantName.onmicrosoft.com).
Authorize (Button): This can be

used as an alternative to creating a
Client Id and Client Secret. A Tenant
Administrator will have to enter their
credentials on behalf of the Organization
for the permissions to work.

(Optional) Client Id: This is the Azure
App Id that will be generated by the
Tenant Administrator within the client’s
organization. This can be used in place
of the Authorize button.

(Optional) Client Secret: This is the
Azure App Secret that will be generated
by the Tenant Administrator within the
client’s organization. This can be used in
place of the Authorize button.
(Optional) Azure AD Group: Enter the
group name(s) that will be synced over
into OnePlan from Azure AD.

NOTE

This field is case
sensitive.

Azure AD
Authorization

Click here to approve consent to use the default Azure AD app registration for this tenant (Admin Reguired).

Tenant Domain *

This is the Primary Domain for example 'M365x30114350.onmicrosoft.com’

Client Id (Azure App Id)

Orly use this if you're planning on using your own App registration.

Client Secret (Azure App Secret)

Orly use this if you're planning on using your own App registration.

¥ Additional Options

Azure AD Groups

A comma separated list of the Azure AD Groups te pull users from.

¥ Advanced Options

¥ Relay Options

Click Next.

Complete the OnePlan section.

* Group Name: Enter the OnePlan Group
name you will be integrating into.

* Authentication Key: Enter the OnePlan
Authentication Key generated from
OnePlan.

* (Optional) Alternate OnePlan
Environment URL: If using an
alternative environment to https://
my.oneplan.ai, please enter the
appropriate URL here.

K

NOTE

Options currently
include https://
au.oneplan.ai, https://
ca.oneplan.ai, and
https://eu.oneplan.ai.

@ OnePlan
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(D OnePlan

Group Name

OnePlan group name that the integration is connecting to.

Authentication Key

Authentication Key is generated In the Integration tab within the OnePlan configuration.

Authentication Key Name

» Additional Options
¥ Advanced Options

» Relay Options

d. Click Next.

Azure Active Directory to
OnePlan Resource Center
Integration - Default Field
Mappings and Scheduled

Strategies

This article explains the AzureActive Directory to
OnePlan Resource Center default field mappings
and scheduled jobs for your integration.

Default Field Mappings

Users - Resources Section

Azure OnePlan Direction Notes
AD Fields
Fields
Display Display Azure AD to Suggested
Name Name OnePlan
Mail Email Azure AD to Required
OnePlan

Default Scheduled Strategies

SyncAzureResources: This strategy synchronizes
Resources from Azure AD to OnePlan Resources.

Additional Azure AD Fields Available
to Synchronize into OnePlan

The fields in Azure Active Directory that are readily
available to be brought into OnePlan are:

Display Mail Company Employee
Name Name Name

Given Surname Department Job Title
Name
Employee Employee Account Is
Id Hire Date Enabled Resource
(Date) (YesNo) Account
City State City Street
Address
Postal Country Mobile Hire Date
Code Phone (Date)
User Type User Inactive Office
(Dropdown) Principal (YesNo) Location
Name
Mail Preferred Sign in Employee
Nickname Language Sessions Leave
Valid From Date Time
Date Time (Date)
(Date)
Created Fax Age Group
Date Time Number (Dropdown)
(Date)

An additional step to create a corresponding field
within the OnePlan Resource Center is necessary
to map to the available fields in Azure AD. This can
be done within the OnePlan Configuration page >
Fields > Resources.

Mapping to OnePlan’s Inactive Field

When mapping to OnePlan’s Inactive field, please
map this to the Azure AD’s Inactive field.

Azure Active Directory to
OnePlan Resource Center
Integration - Setting Permission

Levels for New Resources

When bringing in a new resource into the OnePlan
Resource Center, that resource (if they are not
generic) will have to have a permission level set.

By default, the permission level for all new
resources coming into OnePlan will be assigned the
permission level of Contributor.

If you would like to change the default permission
level for all new resources coming into OnePlan,
within OnePlan, navigate to Admin/configuration
pages > General > Resources. Choose a
permission level from the Default Level drop-down.
The Default Level chosen from this drop-down will
apply to all resources coming into OnePlan from
that point forward until the value has been altered.
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S CTER 4. On the top Left of the page, create a New
Registration.
+ Name: Give the App Registration Name a
| I title.
— » Supported Account types: Single Tenant.
* Redirect URI (Optional): Dropdown: Web.
s URL: https://my.oneplan.ai.
[
. =
@ NOTE '. =
Changing the Default Level value p
will not alter any resources -
currently existing within OnePlan. =
5. Click Register.
6. Once the registration has been completed, the
App Registration page will load. Within the
Essentials section, the Application (client) ID
A WARNING can be found.
Changing the Default Level
value can impact Team Member
Licenses. Please check in with 3
your OnePlan representative to
ensure that licenses are not 7. On the navigation panel on the left, click on
mistakenly allocated. Certificates & Secrets.
8. Towards the middle-left of the page, click on +
New Client Secret. The Add a Client Secret
panel will expand on the right side of the
. . browser.
Azure Active Directory Modern
Authentlcathn @ NOTE
Only the tenant administrator may be able to set L ..
. This is where a Description
up the Modern Authentication for the Azure AD ..
integration. If you wish to locate the SharePoint/ LIS Explratlop L)
. . can be set according to the
Tabular Data documentation, or even the Project , .
Online documentation, please navigate to the GelmpEryy’s Rl
SharePoint Modern Authentication page, or to
Project Online Modern Authentication page_ 9. CI|Ck Add. The panel will Close, and the C“ent
Secret will be in the middle of the page
Create the App Registration within underneath the column labelled as Value.
Azure
1. While logged in as a tenant admin for the
client’s organization, log in to portal.azure.com.
2. Navigate to the Azure Active Directory (Azure
AD).
3. Within the left navigation bar, go into the App
Registrations page.
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NOTE

Please note that this value
will only appear once, it is
encouraged to save this value
in a secure location should
you need it a second time.
Otherwise, it is best practice
to create a whole new client
secret for each time it is
needed.

Set API Permissions

1. Once finished with the setting up the Client
Secret, navigate to the API Permissions page
(left navigation panel, beneath Manage).

2. Select Add A Permission.

3. Beneath the Microsoft APIs tab, select
Microsoft Graph.

4. What type of permissions does your application

require? Select Application Permissions.
5. In the dropdown selections, choose these
permission levels:
* User.Read.All
* Group.Read.All
* GroupMember.Read.All
6. Once the Permission levels have been
selected, click Add Permissions.
7. In the API Permissions page, click Grant
Admin consent for {Tenant Name}.
8. Click on Yes for the consent confirmation
popup.

o OneAnalytics Connector | APf permissions

OneConnect Setup

1. While logged into OneConnect, go to the
Azure AD Users to OnePlan integration.

2. Inthe Azure AD setup page, type in
the Primary Domain URL. This can be
found in Azure AD Overview Page (i.e.,
{TenantName}.onmicrosoft.com).

3. Type in the Client Id and Client Secret.

4. Click test to confirm that the connection
works as intended. If there is a Connected
Successfully notification at the top right of the
browser page, proceed to click on Save.
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SharePoint Integration

SharePoint Lists to OnePlan S

Plans [ YO PRt —
This article explains how to set up an integration for

SharePOint I|St itemS tO become planS in OnePlan. 3 Comp|ete the integration Configuration form_
OnePlan Setup SR — Yo

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan. If the Advanced Settings
are enabled for your group, continue to the next
steps. If the Advanced Settings are NOT enabled,
contact OnePlan for assistance.

1. Log in to your OnePlan group with your
Office365 account. Lpsitin

2. Ope.n the Admin pages by clicking on the Sy ——
Settings gear. :

3. Select Integration in the admin navigation.

4. Click the + (plus) icon in the Authentication
Keys section.

5. Save the key name and generated key
somewhere (such as in a notepad doc), as

once you navigate away, the key cannot be S NOTE

seen. To be used _at a Ie_\ter step in the Expand the Additional
OneConnect configuration. Options section to see all
necessary fields for this
3 e integration.
| Authentction ks 7]

o |

a. Complete the SharePoint section

b
. . | Afierthe key 3 and store Youwil |
Subscription ot be able to recover the key

OneConnect Setup

1. Go to https://my.oneconnect.ai

2. Click on the SharePoint to OnePlan integration
tile. Click on the Configure button to the right
of the SharePoint Lists to OnePlan Plans.
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Chist |l (M sy Feqanered i St

Chest Secret (If wning registencd spp suth)
Plase pecify sl SharePoint livth name 1o be wynchronize (Comma ueparsted]
Email Copy Ta

SharePoint Online URL: This will

be the SharePoint Site where

the List is located (eg. https://
or123.sharepoint.com/sites/sitename).

@ NOTE
Currently, we do not

support SharePoint
Server.

Username + Password: If your
company wishes to use basic
authentication, please input the
credentials of the user who has access
to this SharePoint site.

Check this box if using registered
app authentication: If basic
authentication is not secure enough

for your organization, see Set Up
SharePoint Modern Authentication [118]
to set up a Client ID + Secret. This

box must be checked, and Client ID +
Secret (located in Additional Options)
must be made in SharePoint for these
credentials to work.

Client ID + Secret: To be used with the
checkbox above.

* Please Specify all SharePoint list

names to be synchronize (Comma
separated): This is where the names
of any and all lists are entered that will
be brought into OnePlan. The names
need to match the front-end name of
the list that will be brought over. To find
the front-end name of the list, go to the
SharePoint Site > Settings icon > click
Site Contents. The list name on this
page is what is typed in this box. Not
the individual item name in each list.
Check this box if only single list
specified: If only one list is going to be
brought into OnePlan, check this box.
Email Copy To: To include someone
else that is not already being notified of
this integration status, enter the email
here.

Click Next.
Complete the OnePlan section.

TP Forap B TR M1E Peai o T TS T R Tl i b T
-

we T ey Dl Lo plons Bpmy § rolipm Foen L0l o Vi Do g et by PO b, it

mby e Sy bamn Cer tmn i e e b e e T L [T g ey

OnePlan Group Name: Enter/paste the
OnePlan app name from the earlier
OnePlan Setup steps.

OnePlan Authentication Key: Enter/
paste the OnePlan Key that was saved
from the earlier OnePlan Setup steps.
(Optional) OnePlan URL: For clients
that have their oneplan.ai hosted
outside of the United States, please
enter the OnePlan URL used.
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Previously Imported SharePoint Lists

@ NOTE Not Showing in My Portfolio
Options currently are: If the SharePoint list items have already been
https://au.oneplan.ai, imported into OnePlan and are not visible in My
https://ca.oneplan.ai, Portfolio, these steps can have the SharePoint list
https://eu.oneplan.ai. item show in My Portfolio:

1.  Going to Home Page. In the bottom left panel
labelled Plans, click on the All Plans tab to see
all plans that are created.

d. Click Next.

Integration Information
™~ VORI C Vw271

|0 e —

Scheduled Jobs
The following scheduled jobs are installed by # G
default.
=
» SharePointToOnePlan e
 This strategy syncs Projects from SharePoint =

to OnePlan
» SynchLookups

« Sync list from SharePoint to OnePlan 2. Click on the Hamburger icon on the left of

the plan name and select Reorganize. A new
window will appear.

Field Mappings

Table 1. Default Mappings

SharePoint OnePlan Direction Notes
Fields Fields
Title Name Both Required
SP List ID SP List Both
Name

Table 2. Recommended Field Mappings

SharePoint OnePlan Direction Notes
Field Field
Custom Portfolio SharePoint Highly
Column Plan to Recommneded | 3. Select the Plan Type desired. Then click
Name Type OnePlan Reorganize

We highly recommend that a column be made
within SharePoint list (Text or Choice) and in that
column, have the name of the plan type desired
be listed. The out of the box options are Portfolio,
Program, Project, and Epic.

If the SharePoint list is brought into OnePlan

without this field mapping, the list items will not

appear in My Portfolio, however, the list items will 4. The Plan item will now appear in My Portfolio.
be located at Home > Plans section > click All
Plans.
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a i i [ |
B 3. Complete the integration configuration form.
e L — a -
SharePoint Lists to OnePlan
Tasks a
This article explains how to set up an integration
for SharePoint list items to become tasks within —
OnePlan plans.
OnePlan Setup
In order to do the OnePlan setup, you need to be :
an admin, meaning you are a user with Owner == =]
permissions in OnePlan. If the Advanced Settings
are enabled for your group, continue to the next a. Complete the SharePoint section
steps. If the Advanced Settings are NOT enabled,
contact OnePlan for assistance.
NOTE

1. Log in to your OnePlan group with your Expand the Additional

Office365 account. Options section to see all
2. Open the Admin pages by clicking on the necessary fields for this

Settings gear. integration.
3. Select Integration in the admin navigation.
4. Click the + (plus) icon in the Authentication

Keys section. i i
5. Save the key name and generated key

somewhere (such as in a notepad doc), as SharsPolnt Guling Ul

once you navigate away, the key cannot be

seen. To be used at a later step in the ro—

OneConnect configuration.

‘”l ) Au(he?t‘i(a‘ti‘on KeyD
Chem Secred (W wning registered spp authl
Fease wpecify all SharePoint livk nams to be wynchioaine |Comma weparsted])

OneConnect Setup st oy To
1. Go to https://my.oneconnect.ai
2. Click on the SharePoint to OnePlan integration « SharePoint Online URL: This will

tile. Click on the Configure button to the right be the SharePoint Site where

of the SharePoint Lists to OnePlan Tasks.
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the List is located (eg. https://
or123.sharepoint.com/sites/sitename).

N

NOTE
Currently, we do not
support SharePoint
Server.

» Username + Password: If your
company wishes to use basic
authentication, please input the
credentials of the user who has access
to this SharePoint site.

» Check this box if using registered
app authentication: If basic
authentication is not secure enough
for your organization, see Set Up
SharePoint Modern Authentication [118]
to set up a Client ID + Secret. This
box must be checked, and Client ID +
Secret (located in Additional Options)
must be made in SharePoint for these
credentials to work.

» Client ID + Secret: To be used with the
checkbox above.

* Please Specify all SharePoint list
names to be synchronize (Comma
separated): This is where the names
of any and all lists are entered that will
be brought into OnePlan. The names
need to match the front-end name of
the list that will be brought over. To find
the front-end name of the list, go to the
SharePoint Site > Settings icon > click
Site Contents. The list name on this
page is what is typed in this box. Not
the individual item name in each list.

» Check this box if only single list
specified: If only one list is going to be
brought into OnePlan, check this box.

+ Email Copy To: To include someone
else that is not already being notified of
this integration status, enter the email
here.

b. Click Next.
c. Complete the OnePlan section.

* OnePlan Group Name: Enter/paste the
OnePlan app name from the earlier
OnePlan Setup steps.

* OnePlan Authentication Key: Enter/
paste the OnePlan Key that was saved
from the earlier OnePlan Setup steps.

* (Optional) OnePlan URL.: For clients
that have their oneplan.ai hosted
outside of the United States, please
enter the OnePlan URL used.

K

NOTE

Options currently are:
https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai

d. Click Next.
Integration Information

Scheduled Jobs

The following scheduled jobs are installed by
default.

» SharePointToOnePlanTasks

» This strategy syncs Projects from SharePoint
to OnePlan

» SynchLookups
» Sync list from SharePoint to OnePlan

Field Mappings
SPList(s) to Tasks
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Table 3. Default Mappings

SharePoint OnePlan Direction Notes
Fields Fields
Title Name Both Required
SPList(s) to Tasks
Table 4. Required Field Mapping
SharePoint OnePlan Direction Notes
Field Field
Custom Plan Id Both Required
Column Name

OneConnect does not have the ability to know
where to assign the SharePoint list items
automatically. Because of this, a custom text
column needs to be made in SharePoint, and within
that column, the OnePlan Plan Id. Having this field
mapping will allow the SharePoint list items to come
over into OnePlan as a Schedule item within the
Work Plan.

To find the OnePlan Plan Id, open the Plan Details
section of the plan in question, go into the Console
Log of your browser, type Planld, and press Enter.
The unique plan id will appear.

mzm

Copy and paste the Plan Id into the SharePoint
Plan Id Column that was created.

n SieOre
E=3 a

(TR -

Set Up SharePoint Modern
Authentication

This article describes how to set up Modern
Authentication for SharePoint to use with
integration configurations, like Tabular Data.

IMPORTANT

The user setting up Modern
Authentication must be a Global
Admin (Tenant Admin) as well as
the Site Collection Admin.

1. Go to your SharePoint Site URL. You will
need this Url for integration configurations,
such as the Tabular Data integration. This
URL will usually follow the format of https://
[tenantName].sharepoint.com/sites/[siteName]

NOTE

This URL will be used in the
OneConnect Integration.

2. Register a SharePoint add-in (app) using
the AppRegNew form and grant the API
permissions.
a. Register the Add-in using the AppRegNew
Form. Go to [TenantSharePointSite]/
_layouts/15/AppRegNew.aspx

B Registeran App « B
€ > C & @S sharepoint.com/sites/ S/ |ayouts/15/appregnew.aspx

The page will look like this:

« Client ID: Click on the Generate button
to be given a custom GUID.
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C.

+ Client Secret: Click on the Generate
button to be given a unique secret.

+ Title: The name of your add-in that will
be displayed to the end user.

* App domain: The domain where the
add-in is hosted. In this example, | used
my.oneconnect.ai (NO SLASHES / OR
https:)

@ NOTE
If you use
www.oneconnect.ai an
error when testing the
integration connection
will pop up saying
“Microsoft.ldentifyMode

|.SecurtyTokenService.
Requ.... Token request
failed.”

* Redirect URL: For token generation.
In this example, | used https://
my.oneconnect.ai

Click Create. A new page will show giving
the user the Client ID, Client Secret, Title,
App Domain, and Redirect URL. Save the
Title, Client ID and Client Secret for future
use. These will be needed for the next

step, and for the OneConnect Integration.

Ig NOTE
The client id and

client secret are linked
to individual OneDrive
URLs.

To grant API Permissions.
Go to [TenantSharePointSite])/_layouts/15/
Applnv.aspx

* App Id: Enter the client Id.

+ Title: Enter the title used in the
AppRegNew form

* App domain: The domain where the
add-in is hosted. In this example, | used
my.oneconnect.ai (NO SLASHES / OR
https:)

* Redirect URL: For token generation. |
used https://my.oneconnect.ai

* Permission Request XML: Enter the
following code to grant full control:

<AppPermissionRequests
AllowAppOnlyPolicy=""true">
<AppPermissionRequest
Scope=""http://sharepoint/content/sitecol I
Right=""FullControl"'/>
<AppPermissionRequest
Scope="http://sharepoint/content/sitecol
Right=""FullControl"'/>
</AppPermissionRequests>

After you click Create you will be
prompted to trust the add-in. Click Trust
It.

To check if the permissions have been
applied, go to [TenantSharePointSite]/
_layouts/15/appprincipals.aspx

@ OnePlan
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f.  The XML code grants you 2 full control

permissions on a site collection and full E
control on a web. See Available scopes

and permissions, and restrictions on Office | @ Home
Store apps permissions from Microsoft for
a detailed description of other options. (Q U
3. Ifintegration is made, however when looking at ol
the field mappings page shows an error of 401
Unauthorized, that means that the Tenant is on ' Teams & groups
the newer side. To fix this:
a. At SharePoint site, click on the top right Pﬂ Roles
waffle icon, and click on Admin. This will
bring up the Microsoft 365 Admin Center. B Resources
e B Billing
£ Support
Apps
o3 Settings
E Chutlook ‘ Oinelirive
i Setup
Word Excel
ﬂ ﬂ v~ Reports
FowerPaoint Onelote
P 3, ©  Health
& SharePoint ﬁ Teams
Admin centers
I‘ Yammer P Power Autom

Security

Compliance
All apps

The Microsoft 365 Admin URL will be

similar to this: Azure Active Directo...

& adminmi com/Zauth_up in40 e 1< ource =applauncher#/homepage

Lo
@
o Endpoint Manager
&
@

Exchange
b. In the Microsoft 365 Admin Center, click

on the hamburger icon on the top left of 3> SharePoint
the page to expand the Navigation bar,
and click on the three dots labeled Show # Teams

All. This will bring additional navigational

items into the view. Click on SharePoint -
option. This will open the SharePoint i
Admin Center page.

All admin centers

Show pinned
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The SharePoint Admin URL will be similar
to this:

a “-admin.sharepoin(.com/,layou!sﬂ 5/online/AdminHome.aspx#/home

On the desktop of the computer. Open
Windows PowerShell with Administrator
Privileges. In the Windows PowerShell
paste these commands and press Enter
after each command:

Get-Module -Name
Microsoft.Online.SharePoint.PowerSh
ell -ListAvailable | Select
Name,Version

Install-Module-Name

Microsoft.Online.SharePoint.PowerSh

ell

A. If this is your first time using
Windows PowerShell, you will get
two Notifications, the first: “NuGet
Provider is required to continue”.
Read the notification. Type “Y”
and press Enter.

B. The second notification will say
“Untrusted repository”. Read the
notification. Type “Y” and press
Enter.

Install-Module -Name

Microsoft.Online.SharePoint.PowerSh

ell -Scope CurrentUser

vi. Set-SPOTenant

-DisableCustomAppAuthentication

$true
vii. Set-SPOTenant

-DisableCustomAppAuthentication

$false

d. Once all the commands have been
entered successfully, close windows
PowerShell, and wait 15 minutes, then
check in OneConnect if the field

mappings show up when refreshed. For

the official Microsoft documentation on
the Windows PowerShell instructions:
https://docs.microsoft.com/en us/

powershell/sharepoint/sharepoint-online/

connect-sharepoint-online

Install and configure the

Microsoft SharePoint App

This article explains how to install and configure
the Microsoft SharePoint App in OnePlan, which

allows the creation of individual SharePoint sites/

workspaces for plans.

Install Microsoft SharePoint App

Install the app Microsoft SharePoint. See How do |

add apps? to install an app in OnePlan.

After the app is installed, a new settings

iv.  Update-Module -Name section called Microsoft SharePoint in the admin
Microsoft.Online.SharePoint.PowerSh  nayigation.
ell
v. Connect-SPOService -Url [SharePoint
Admin Site] -Credential [Admin haae
Credentials] Microsoft
A. Replace the [SharePoint Admin e
Site] with the SharePoint Admin *
URL (from step 3b) that will
match this format: [TenantSite-
admin.sharepoint.com]
B. Replace [Admin Credentials] with
the Global Administrator/Tenant
Administrator username.
C. A notification will appear asking
“Do you want to run software
from this untrusted publisher?”.
Read the notification. Type“A”
and press Enter.
@ OnePlan 121


https://docs.microsoft.com/en-us/powershell/sharepoint/sharepoint-online/connect-sharepoint-online
https://docs.microsoft.com/en-us/powershell/sharepoint/sharepoint-online/connect-sharepoint-online
https://docs.microsoft.com/en-us/powershell/sharepoint/sharepoint-online/connect-sharepoint-online

Integrations

App Information x

Microsoft SharePoint

Pravides Microsoft SharePoint Sites

INSTALL APP

Cancel See To allow custom script on other SharePoint
sites for more information.
Permissions SharePoint Integration Settings

Navigate to the Microsoft SharePoint admin
page. Expand the SharePoint Integration heading
section.

See Allow or prevent custom script - SharePoint
in Microsoft 365 | Microsoft Docs to allow users
permission to connect a new item in SharePoint

with OnePlan. Click the link to enable the SharePoint integration.
NOTE: Users may run into an "Access is Denied" The page will refresh, and you will need to navigate
error when connecting a new item in SharePoint back to this page.

with OnePlan.

Enable SharePoint m!egvam’mE

Auto Create: Check this box to automatically create a site everytime a plan is created

After enabled, a green check mark is shown.

To resolve the error: Auto Create: Select the check box to automatically
create a site/workspace every time a new plan is

1. Open Windows ISE in Admin privilege. created. If left unselected/unchecked, users will be
2. Install the SharePoint modules. able to create a site for a plan as needed.
3. Connect to the SP Online admin center.
4. Execute the following cmdlet to disable the
restriction: ———
Set-SPOSite https://crm958441._sharepoin ¥ "evesterontiegeionislie stomizePages 0

Auto Create: (0 Check this box to automatically create a site everytime a plan is created

Site Information
Expand the Site Information heading section.
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Enter your SharePoint Site Collection URL. Each
site for this OnePlan group will be created as a
subsite in that site collection.

Enter the username and password of the Service
Account in the SharePoint site.

You need to refresh your browser to kick off the
authentication. This is needed the first time entering
username & password, as well as if you update the
password in the future. Then, proceed to the next
section for the Templates.

Templates

Expand the Templates heading section. Each plan
type in your OnePlan Group will be listed. You may
have a different template selected per plan type.

The content, lists, libraries, and settings in the
workspace templates will determine what will be in
the plan workspaces upon creation. You may create
new and/or modify the existing templates in your
SharePoint site collection, which will show them
available for selection. Such as add lists, configure
the web parts, add content, etc.

Enterprise Project

simple Project

Portfolio slobal tlemplate

Program Team site (no Office 365 group)
Team site (classic experience)
Blank Site

Document Workspace

Blank Meeting Workspace
Decision Meeting Workspace
Social Meeting Workspace

Multinana Mastina Winrkenare

Use SharePoint workspaces

This article explains how to use SharePoint
workspaces with OnePlan. This functionality
requires the app Microsoft SharePoint be installed
and configured by your admin.Based on settings, a
SharePoint workspace may be auto-created upon
creation of your plan. Or, a SharePoint workspace
may be created manually as needed per plan.

Open Plan

Navigate to your plan from the Portfolios page.

i} E Desert Skies

©

(1) Create (2) Select

| General
Name

&£ Parent Portfolio
Portfolio

Manager

Cloud and mobile first
Daniel Wiliams
Eﬂ Executive Sponsor Wo Fat
Priority High

Select SharePoint

Open the plan contextual menu. Select
SharePoint.

1 m Desert Skies

Q (1) Create (2) Select

B General

Create New Plan Site/Workspace

Click the Connect button to create a workspace
for this plan. Based on the plan type, the template
configured by the admin determines how the
workspace looks with that template's lists, libraries,
and content.

The new workspace is created following the Site
Collection URL and then the plan name will be the
workspace URL.
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im]| E Desert Skies

Q (1) Create (2) Select

| General
Name: Desert Skies
Q% Parent Portfolio
Portfolio Cloud and mobile first

Mariager Daniel Williams

Executive Sponsor. Wo Fat
Priority- High

i} E Desert Skies

Q (1) Create (2) select

| General
Name Desert Skies
RRJ Parent Portiolio
Portfolio Cloud and mobile first

Manager Daniel Williams

Executive Sponsor. Wo Fat
Priority- High

Open Existing Plan Site/Workspace
Whether a workspace was created automatically

or manually, the steps to open the workspace are
the same. Open the plan contextual menu. Select
SharePoint. Click the button to open the connected
workspace.

The plan name is also the site name in SharePoint.

SharePoint Online (SPO)

0 Sezrch this site

Terminologies
Term Description
Site A site in SharePoint
List A list in SharePoint.
List Name The name of a list in SharePoint.

Based on Customer requirements.

Field A column for a list in SharePoint.
Field A specific list of Fields for a specific list in
Names SharePoint.

Also known as Mappings, or Field
Mappings.

Requirements

Workspace Permissions/Access
The OnePlan plan's team permissions transfers to
the workspace permissions.

» Plan Owner: Workspace Owner permissions
» Plan Member: Workspace Edit permisions
» Plan Visitor: Workspace Read-Only permissions

Portfolios View - Plans with

Workspaces

When viewing the Portfolios page, any plan with a
connected SharePoint workspace created will show
the SharePoint icon.

Requirement Description

Office 365 Used as a 'Service' account to perform
account the Operations listed below.
* Must have Site Collection Admin
permission for each Site.
Site(s) The Site in which Operations will be
performed.
List(s) The List Name(s) in which an Operation
will execute.
» Each List requires a list of Field
Names.
Operations
Operation Requirements Description
Get List Items List Name Will pull all items
from specified list.
Field Names
Only Create List Name Will only push
List ltems New items into the
Field Names specified list.
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Operation

Only Update
List Items

Create Or
Update List
ltems

Requirements

List Name

Field Names

List Name

Field Names

Description

Will only Update
existing items into
the specified list.

Will either push New
items, or Update
existing items into
the specified list.

@ OnePlan
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Tabular Data Integration

OnePlan and Tabular Data for

Bulk Resource Import

This article explains how to set up the integration
between OnePlan and Tabular Data for bulk
resource import.

How to Use OnePlan with Tabular Data

This integration focuses on importing Users (usually
in bulk) into OnePlan via a .CSV file format.

OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan.

1. Log in to your OnePlan group with your
Office365 account.

2. Open the Admin pages by clicking on the

Settings gear.

Select Integration in the admin navigation.

4. Click the + (plus) icon in the Authentication
Keys section.

5. Save the key name and generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.

w

i OnePlan

General

Calendars

App Name ey
Reporting -
Fields
Reporting -
Calculations || To allow integration to thistenant, in it nd cick
Format Rules

Events +
I Integration

st e Y
Add Key

WorkPlan  Befi t
. | Aferthe key is created, be sure to copy and store In safe ocation. You will |
Subscription ot be able to recover the key

Backup/Restore

Key Neme:

Enable App Permissions

For the OneConnect integration to work, a Microsoft
Tenant Administrator will need to enable app
permissions.

1. While on the OnePlan Admin page, navigate to
the Users tab.

Expand the AD Synchronization section.

At the very bottom of the page, locate the
sentence “To synchronize users you must
enable app permissions: here”, and click on
the word: here. This will load a Microsoft Login
screen where the Tenant Admin will have to log
in to enable permissions.

Once logged in, the Permissions Requested
window will appear. Click Accept to enable
permissions. Page will redirect the user to the
OnePlan Admin page.

Permissions requested

Review for your organization
G) OnePlan
App info

This application is not published by Microsoft or
your organization.

This app would like to:
. Read all groups

Allows the app to list groups, and to read their properties
and all group memberships on behalf of the signed-in user.
Also allows the app to read calendar, conversations, files, and
other group content for all groups the signed-in user can
access.

This is a permission requested to access your data in
Contoso.

. View users' basic profile

Allows the app to see your users' basic profile (e.g.. name,
picture, user name, email address)

This is a permission requested to access your data in
Contoso.

. Maintain access to data you have given it access to

Allows the a2pp to see and update the data you gave it access
to, even when users are not currently using the app. This
does not give the app any additional permissions.

This is a permission requested to access your data in
Contoso.

If you accept, this app will get access to the specified resources for
all users in your organization. No one else will be prompted to
raview these permissions.

Accepting these permissions means that you allow this app to use
your data as specified in their terms of service and privacy
statement. You can change these permissions at
https://myapps.microsoft.com. Show details

Does this app look suspicious? Report it here
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OneConnect Setup

1. Go to hitps://my.oneconnect.ai

2. Configure the following integration: Tabular
Data Resources and OnePlan Resources
Import . Click the Configure button.

Integrations

i

Tabular Data To OnePlan Resource Planner
Synhcronize resources from Tabular Data into OnePlan Resource Planner

3. Complete the integration configuration form.

a.

&g Tabular Data

SharePoint or OneDrive Url
ps://tenant sharepaint. comysites sitename)

Folder Path (E.g. /Documents/Exports)

Username

Password

Check this box if using SharePoint MFA only (See additional options)

Additional Options

Advanced Options

Relay Options

Complete the Tabular Data section

K

NOTE

Expand the Additional
Options tab to see all
necessary fields for the
integration.

» SharePoint or OneDrive URL: Enter in
the SharePoint URL where file is located
(eg. https://org123.sharepoint.com/sites/

test).
* Folder Path: Enter the folder path
where the file is located.

NOTE

The folder path is
based on the front end
name, not the URL.

K

¢ Username: Enter in the username that

will be used.

Password: Enter in the password that
will be used.

Resource Import File Name: Enter the
file name.

K

NOTE

We strongly
recommend the file be
in .CSV format.

¥ Additional Options

Client Id (If using registered app auth):
Client Secret (If using registered app auth):

Resource Import File Name (E.g. Users.csv)

For Tabular Data Resources to OnePlan Resources Integratio

Financial Cost Impert File Name (E.g. Projects.csv)

For Tabular Data Cost to OnePlan Financial Planner Integration

Timesheets File Name (E.g. Timesheets.csv)

Exclude Column Headers
Include Previous Success Export

Email Copy To

Click Next.
Complete the OnePlan section.
* App Name: Enter/paste the OnePlan

app name from the earlier OnePlan
Setup steps.

Key: Enter/paste the OnePlan Key that
you saved from the earlier OnePlan
Setup steps.

(Optional) OnePlan URL: For clients
that have their oneplan.ai hosted
outside of the United States, please
enter the OnePlan URL used.

@ OnePlan
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NOTE

Options currently are:
https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

K

OrePlan

OnePlan Group Name (Enter the name of the OnePlan group that you are connecting

to here) *

OneFlan Authentication Key (Enter the OnePlan authentication key that has been

generated from the OneFlan integration admin page here}

Integration Key Name (Only use this when connecting to OnePlan OData, otherwise

please leave it blank)

» Additional Options
P Advanced Options

» Relay Options
d. Click Next.

Integration Information

Functionality

This integrations main use case for functionality is
to import bulk resource from tabular data.

Scheduled Jobs

The following scheduled jobs are installed by
default.

+ SynchResources
* Synchronize resources from Tabular Data
into OnePlan resources

Default Mappings

Because we have a file listed in the Users File
Name section, the Tabular Data Users to OnePlan
Resources field mappings will be made available.
At this time, we do not have default field mappings
for this integration.

However, the field names in the out of the box
OnePlan Resources drop down are:

» Display Name (Text): The user name displayed
in the OnePlan interface.

Display Name field mapping is intended
specifically for Generic Users (this is because
when we create generic users, there is no email
field available). If a user is marked as generic, we
only use the Display Name to create that user in
the OnePlan Resource Plan.

K

NOTE

The Display Name column in
the .CSV file (even if it is
mapped) will be ignored for any
non-generic users.

Email (Email):: The user's email address. The
email listed in this column should be the email
that is in the Tenants Microsoft AD. If the email
is not associated with the Tenants Microsoft AD,
the user will not come into the Resource list in
OnePlan.

The email field is the only mandatory field for
non-generic users. When bringing in the email,
Microsoft AD will provide the Name (Display
Name) section into the OnePlan Resource
Center. Every other field that is in the .CSV file
and is mapped is optional for generic users.

K

NOTE

The email field must be mapped
to bring a non-generic user into
the OnePlan Resource Plan.

NOTE

If in the .CSV file there are
mapped fields and the cell is
blank, the value will remain
blank as well.

K

Role (GUID*): The user's role within the
organization. See Locate Field GUIDs [129].
Timesheet Administrator (True/False):
Whether or not the user is a Timesheet
Administrator in OnePlan.

When mapped, the current values that can be
given are true and false (these values are not
case sensitive).

128

@ OnePlan



Integrations

NOTE

By default, if this field is not
mapped, the new user will
NOT be made a timesheet
administrator

K

* Global Permissions (Number): The user's

OnePlan environment permissions. See OnePlan

User Permissions for more information.
Currently, if importing users into OnePlan, if the
user is new, then the user will be created with
the permissions level number given if this field is
mapped:

» 0 gives user permission of None

» 1 gives user permission of Team Member

» 2 gives user permission of Contributor

» 3 gives user permission of Manager

* 4 gives user permission of Owner

» 5 gives user permission of Executive

N

NOTE

At this time, if there is no
value in this field mapping (or
if this is not something that

is mapped), the user will be
given a permission level of 2
(Contributor) by default.

NOTE

If a user already exists,

Global Permissions can now

be updated/changed. Please be
careful, as this will affect the
number of licenses in OnePlan
that you are allocating to your
users.

K

* Cost (Number up to 2 decimal places): The
user's cost.

* Rate (Number up to 2 decimal places): The
user's rate.

* Generic (True/False): Whether or not the user is

a generic resource.

Generic Resources in OnePlan ignore any listed
email or global permissions value. So if a
resource is marked as generic, there must be

a Display Name mapped in the OneConnect
field mappings, and the Display Name value in
the .CSV file for that generic user to show up in
OnePlan.

If a user is marked as a non-generic user initially,
and then the user is later changed to generic in
the .CSV file, there will be a duplicate resource
(one resource listed as generic and the other
listed as not generic).

K

NOTE

By default, if this field is not
mapped, the new user will NOT
be a generic resource.

Inactive (True/False): Whether or not the user is
inactive.

If this field is mapped, the values that are
accepted are currently true, false, active, and
inactive (these values are not case sensitive).

K

NOTE

By default, if this field is not
mapped, the new user will NOT
be marked as inactive, so the
user will show in the Resource
Center in OnePlan.

Quantity (Number up to 2 decimal places):
The number of resources for a particular user
role. For example, you may import multiple
Business Analysts.

Business Unit (GUID*): The user's business
unit within the company. See Locate Field
GUIDs [129].

Manager (Email): The email address for the
user's manager.

Locate Field GUIDs

Open the Admin pages by clicking on the
Settings gear.

If this field is mapped, the values that are 2. GoloFields > Resource Fields,
pped 3. Click on the Edit icon. The Edit Choices form
accepted are true and false (these values are not il
case sensitive). will open.
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4. Click on the drop down arrow, expand
Columns, and select Id.

5. The number value within the ID is the GUID for
the Role/Business Unit.

Edit Choices *

NOTE

If the ID for the Role and
Business Unit do not match,
or the text value is put

in the .CSV field, no value
will show in the OnePlan
Resource Plan.

K

OnePlan and Tabular Data for
Bulk Financial Data Import

This article explains the OnePlan and Tabular Data
for Bulk Financial Data Import integration, inclusing
how to setup the integration, and integration
information.

This integration was originally intended to bring in
financial costs in from a .CSV file and input these
costs into the OnePlan Financial Planner. This
integration can be run more than once.

What to know before integration setup

Before you begin integration setup, you need to
gather the following information:

* Plan External Id: The Plan External Id is not an
out of the box (OOTB) field. Plan External Id will
be used in place of Plan ID. This will be a custom
field that the user will have to create, modify, and
set themselves.

1. Create custom plan field.

a. Inthe OnePlan Configuration page, go
to Fields tab -> Plan Fields -> Click
New Field.

b. Give the field a name (e.g. "Plan
External Id"). This field type can be a
number field or a text field, whichever is
more convenient for the user.

2. Add custom plan field to the Plan Details.

a. While still in the OnePlan Configuration
page, go to the Plan Details Tab ->
Plan Type. Pick the plan type you wish
to have this new field in.

b. In the far-right column labeled Fields,
locate the custom field, and drag into
the plan section you wish to have this
field show up in the Plan Details page.

IMPORTANT

Be sure to save the
changes at the top of
the page next to the
Plan Type dropdown!

|

3. Set Plan External Id Field to the custom
field created.
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a. Stillin OnePlan Configuration, go to the
Financial Plan Tab -> Import.

b. Click on the drop down for the External
Id Field, and select the custom field
created.

» Cost Type Name: This can be found in the
OnePlan Admin Configuration page -> Financial
Plan Tab -> Expand Cost Types. In OnePlan, NOTE
default names are Budget, Forecast, Actuals, g
Benefits, and Program Budget. Admin can add/
edit/delete these cost types accordingly to their
company’s preference.

If there is a cost external id
that is in the .CSV file, and is
not in OnePlan, a notification
will appear within the logs: “No
Cost Category for Externalld:
XXXXXX”

¥

b |
S NOTE
Currently there is no built-in
check to ensure that external Ids
are unique at this time, so it is
» Cost External Id: The OOTB cost categories do advised that the user keep track
not have an External Id built in. However, the of these cost external ids.
External Id can be made by the Administrator
in OnePlan. To assign an External Id, go to the « Cost Value: This will take in a number value up
OnePlan Admin Configuration page -> Financial to 2 decimal places.

Plan Tab -> Expand Cost Categories -> click on . Cost Date: The cost date will be in

the edit icon for any of the cost categories. the format of 2022-05-22T00:00:00 (YYYY-MM-
DDTHH:MM:SS).

Integration Setup

This integration focuses on importing financial data
\ : into the OnePlan Financial Planner via a .CSV file.

OnePlan Setup

To do the OnePlan setup, you need to be an admin,
meaning you are a user with Owner permissions in
OnePlan.

The Edit Cost Category window will open, and

you can input a unique cost external Id of your 1. Log in to your OnePlan group with your

choice. This field is a text field, so the cost Office365 accqunt. o
external id can be numbers, letters, or a mix of 2. Open the Admin pages by clicking on
the two. the Settings gear IEA.

3. Select Integration in the admin navigation.
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4. Click the Add icon * in the Authentication T s s e oo [ -
Keys section. i B Bk B P oA e -
5. Save the key name and generated key
somewhere, as once you navigate away from prop—
this browser page, the key cannot be seen. B oo
This Authentication key is to be used at a later
step in the OneConnect configuration.
t“‘ Authenll(»a!fanl(eyD\ -

After the key is created, be sure to copy and store in safe location. You will .
ot be able to recover the key L 4

« SharePoint or OneDrive URL: Enter the
SharePoint/OneDrive URL where the file is
located (eg. https://org123.sharepoint.com/
sites/test).

» Folder Path: Enter the folder path where the
file is located.

OneConnect Setup

1. Go to https://my.oneconnect.ai.
2. Configure the following integration: Tabular
Data Cost and OnePlan Financial Planner

Cost External Import. Click the Configure * Username + Password: Enter the
username &amp; password that will be

button.
used, otherwise feel free to set up Modern
Integrations Authentication for SharePoint.
B e et bl e = * Financial Cost Import File Name: Enter
the file name to be used for the Financial
3. Complete the integration configuration form. Planner.
4. Complete the Tabular Data Section.
@ NOTE
We strongly recommend
@ AL . . the file bs i)rll .CSV format.
Expand the Additional Options Attached below is the

tab to see all necessary fields
for the integration.

recommended .CSV file that
has the designated column
names already set up for use.

5. Click Next.
6. Complete the OnePlan section.
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Oneflan Group Name [Enter the name of the OnePlan group that you are connecting
to hive) "

Oneflan Authentication Key (Enter the OneFlan suthentication key that has been
generated from the OnePlan integration admin page here]

Integration Key Name [Only use this when connecting to OnePlan OData. otherwise
please leave it blank)

+ App Name: Enter/paste the OnePlan Group
name from the earlier OnePlan Setup steps.

* Key: Enter/paste the OnePlan
Authentication Key that you saved from the
earlier OnePlan Setup steps.

» (Optional) OnePlan URL.: For clients that
have their oneplan.ai hosted outside of the
United States, please enter the OnePlan
URL used.

K

NOTE

Options currently

are: https://au.oneplan.ai,
https://ca.oneplan.ai, https://
eu.oneplan.ai.

7. Click Next.
Integration Information

Functionality

This integration main use case for functionality is to
import bulk financial data from tabular data.

Scheduled Jobs

The following scheduled job is installed by default.

» CostimportToFinancialPlanner: Synchronize
Cost from Tabular Data to OnePlan Financial
Planner

Default Mappings

Currently, we do not have default field mappings for

this integration.

The possible field names will populate on the
Tabular Data column when the file is read.

The OOTB field names for the OnePlan Financial
Cost import dropdown are:

* Plan External Id (Text)

» Cost External Id (Text)

» Cost Type Name (Text)
» Cost Value (Currency)

» Cost Date (Date)

Tabular Data to OnePlan

Resource Planner

This integration was created to bulk import OnePlan
Resource Planner information from a .CSV file.
Right now, this is a onetime bulk import, however if
desired, it is possible to create separate .CSV files
for different plans, so only the one plan (or set of
plans) will be modified at the same time.

How to Use OnePlan with Tabular Data

This integration focuses on importing Resource
hours into their relevant Cost Types within the
Resource Planner associated with a specific plan.

IMPORTANT

Strategy will erase all previous
data in the Resource Planner table
that is modified. At this time the
Resource Planner integration is
made to replace any data that
currently resides within resource
planner table with the values inside
of the .CSV file.

OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan. If the Advanced Settings
are enabled for your group, continue to the next
steps. If the Advanced Settings are NOT enabled,
contact OnePlan for assistance.

1. Log in to your OnePlan group with your
Office365 account.
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N

how

Open the Admin pages by clicking on the

Settings gear.

Select Integration in the admin navigation.
Click the + (plus) icon in the Authentication

Keys section.

Save the key name and generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.

OneConnect Setup

Go to https://my.oneconnect.ai

Configure the following integration: Tabular
Data To OnePlan Resource Planner. Click

the Configure button.

E‘] Tabular Data To OnePlan Resource Planner

Complete the integration configuration form.

a. Complete the Tabular Data section.

Tabular Data To OnePlan Resource Planner

Add Integration

.......

» SharePoint or OneDrive URL: Enter
the SharePoint/OneDrive URL where
the file is located (e.g., https://
{OrganizationName}.sharepoint.com/
sites/{SiteName}).

* Folder Path: Enter the folder path
where the file is located.

* Username: Enter the username.

@ NOTE
The username must

not have Multi-Factor
Authentication (MFA)
associated with it.
Because of this, we
encourage a service
account to be used to
access the SharePoint
site.

S NOTE
It is standard best

practice to have a
single service account
be associated to a
single integration. If
a service account

is associated to
multiple integrations,
throttling can occur
from Microsoft, which
can lead to strategy
failures.

+ Password: Enter the password.

* Resource Import File Name: Enter the
file name to be used for the Resource
Planner. We strongly recommend the file
be in .CSV format.

* (Optional- Checkbox) ) SharePoint
Modern Authentication: For more
information on how to Set Up Modern
Authentication for SharePoint.

* (Optional) Client Id: Enter the Client ID
generated from theSharePoint site. To
be used with the Modern Authentication
checkbox.
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* (Optional) Client Secret: Enter the
Client Secret generated from the
SharePoint site. To be used with the
Modern Authentication checkbox.

b. Click Next.
c. Complete the OnePlan section.

Oneflan Group Name (Enter the name of the OnePlan group that you are connecting
ta here) "

OnePlan Authentication Key (Enter the Oneflan suthentication key that has been
generated from the OneFlan integration admin page here)

Integration Key Name (Only use this when connecling to OneFlan OData. atherwise
please leave it blank)

* Group Name: Enter the OnePlan Group
name you will be integrating into.

» Authentication Key: Enter the OnePlan
Authentication Key generated from
OnePlan.

* (Optional) Alternate OnePlan
Environment URL: If using an
alternative environment than https://
my.oneplan.ai, please enter the
appropriate URL here.

@ NOTE
Options currently are:

https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

* (Optional) Do not remove existing
data: (Default) When unchecked, all
previously imported data will be
removed from OnePlan.

» (Optional) Select a Delete Scope:
This field is not to be used when
the Do not remove existing data
checkbox is checked. The Delete
Scope is in relation to what data
is desired to be removed each time

the ResourcelmportToResourcePlanner
strategy runs.
+ Default — All Resources. This option

will remove all resources from the
OnePlan Resource Planner and the
data will be replaced with the data
inside of the CSV document.
Included Resources. This option

will remove only the resources listed
inside of the CSV document and their
data will be subsequently replaced by
the values inside of the CSV file.

d. Click Next.

Integration Information

Default Scheduled Strategies

The following scheduled job is installed by default:

* ResourcelmportToResourcePlanner: This
strategy synchronizes Resources from Tabular
Data to the Resource Planner.

Default Field Mappings

Users — BulkResrcimport

OnePlan Fields Tabular Data Fields Direction
Plan External ID Plan External ID Both
Resource Resource Both
Type Name Type Name Both
Hours Hours Both
Fiscal Month Period Fiscal Month Period Both

K

NOTE

If the integration is made, and

the file cannot be found, the field
mappings will not be created here,
and will then need to be manually
created.

CSV File Columns

The CSV File will have 5 columns: Plan External ID,
Resource, Type Name, Hours, Fiscal Month Period.

Plan External ID
This is the Plan Id. There are multiple ways to find

this value:

@ OnePlan
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1. Using Developer Tools:

1. Open the Console.
2. Type Planld into the console.
3. Press Enter. The value will show in red
and in single quotation marks.
2. While inside a plan view:

1. Click on personal image of user (top right
of page).

2. Click Share With.

3. Goto end of text, locate Plan ID=
{PlanldValue}.

Resource

This can either be the Email (for non-generic users)
or the Display Name (for generic users) of the
Resource that will have time allocated to them.

Type Name

This is the Resource Plan Type that the information
will be brought into. The Out of the Box values in
OnePlan are Committed, Scheduled, Timesheets.

To create custom Resource Plan Type, go to
OnePlan Config > Resource Plan > Types. Add
the name of the Type you wish to see here, ensure
that Resource Plan is selected in the Available
Apps section.

Hours

Hours are merely the time spent in that fiscal time
frame. A number value.

Fiscal Month Period

The Fiscal Month Period will be in the format of:
YYYY-MM-DDTHH:MM:SS.

Tabular Data to OnePlan Plans

This integration was created to bulk import OnePlan
Plan information from a .CSV file.

OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan. If the Advanced Settings
are enabled for your group, continue to the next
steps. If the Advanced Settings are NOT enabled,
contact OnePlan for assistance.

1. Log in to your OnePlan group with your
Office365 account.

2. Open the Admin pages by clicking on the
Settings gear.

3. Select Integration in the admin navigation.

4. Click the + (plus) icon in the Authentication

Keys section.

5. Save the key name and generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.

i OnePlan
General
- Auihenti(atiunKEyD
App Name e
a

e sure you are logged in with  tenant admin and click here

" Add Key 4
fi

Befl
After the key is created, be sure to copy and store in safe location. You will
not be able to recover the key

Set Plan External ID

The Plan External Id is not an out-of-the-box
(OOTB) field. Plan External Id will be used in place
of Plan ID. This will be a custom field that the user
will have to create, modify, and set themselves.

1. Create a custom plan field. In the OnePlan
Configuration page, go to Fields > Plan Fields
> Click New Field. Give the field a name (E.g.,
Plan External Id).

NOTE

This field type should be a text
field.

2. Add the custom plan field to the Plan Details
form. While still in the OnePlan Configuration
page, go to Plan Details > Plan Type. Pick
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the plan type you wish to have this new field

in. In the far-right column labeled Fields, locate

the custom field, and drag into the plan section

you wish to have this field show up in the Plan 3.
Details page.

o IMPORTANT

Be sure to save the changes
at the top of the page next to
the Plan Type drop-down!

/

3. Set Plan External Id Field to the custom field
created. Still in OnePlan Configuration, go to
Financial Plan > Import. Click on the drop-
down for the External Id Field, and select
the custom field created. This setting will
automatically save.

OneConnect Setup

E NOTE
To complete the OneConnect

setup, you need to be an
Administrator or Editor in the
OneConnect group you wish to set
the integration up in.

1. Go to https://my.oneconnect.ai.
2. Locate the Tabular Data to OnePlan Plans
integration. Click the Configure button.

B G

Complete the integration configuration form.
Complete the Tabular Data section.

K

Tabular Data to OnePlan Plans

NOTE

Expand the Additional
Options area to see all
the necessary fields to be
filled in.

» SharePoint or OneDrive URL: Enter
the SharePoint/OneDrive URL where
the file is located (e.g., https://
{OrganizationName}.sharepoint.com/
sites/{SiteName}).

* Folder Path: Enter the folder path
where the file is located.

* Username: Enter the username.

K

NOTE

The username must
not have Multi-Factor
Authentication (MFA)
associated with it.
Because of this, we
encourage a service
account to be used to
access the SharePoint
site.

NOTE

It is standard best
practice to have a
single service account
associated with a single
integration. If a service
account is associated
to multiple integrations,
throttling can occur
from Microsoft, which
can lead to strategy
failures.

+ Password: Enter the password.

@ OnePlan
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» Financial Cost Import File Name or

Plan Import File Name: Enter the file
name to be used for importing the plans
into OnePlan.

E NOTE
We strongly

recommend the file be
in .CSV format.

(Optional — Checkbox) Using
SharePoint Modern Authentication:
See SharePoint Modern Authentication
for more information.

$ranePoint or Oweleive Url

Tolder Patt (Lg. /DeoementyTxpott

(LY LA

Click Next.
Complete the OnePlan section.
* Group Name: Enter the OnePlan Group

name you will be integrating into.
Authentication Key: Enter the OnePlan
Authentication Key generated from
OnePlan.

(Optional) Alternate OnePlan
Environment URL.: If using an
alternative environment than https://
my.oneplan.ai, please enter the
appropriate URL here.

@ NOTE
Options currently are:

https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

* (Optional) OnePlan Default Plan Type:
Should any plan not have a plan type
listed within the CSV file; the value listed
here will be the default plan type.

» (Optional) Create plan(s) if External
ID value does not already exist in
OnePlan: Should an external ID not
match a plan that already exists within
OnePlan, this setting will create the Plan
in OnePlan, with the Plan External ID
set.

ﬁ\} OnePlan

Group Name

Authentication Key

y it genarated in the integration tab within the OnePlan configuration

Authentication Key Name

whher connecting to CnePlan OData

»  Additional Options
¥ Advanced Options

» Relay Options
| s |
d. Click Next.
Integration Information

Default Field Mappings

Currently, we do not have default field mappings for
this integration.

Mandatory Fields to be Mapped

At minimum, only two values need to be mapped
on the OnePlan side for the data to come into
OnePlan: Name and Plan External ID.

Default Scheduled Strategies
SyncPlansByPrimaryKey: This strategy
synchronizes Tabular Data rows as Plans into
OnePlan.
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This strategy has been set to Enabled, however
the Schedule Type has been set to None. This
means that the strategy will not trigger on a set
schedule and will only run when manually triggered
through OneConnect.

If desired, a schedule can be set when clicking
on the pencil icon in the Schedules Tab within
the integration. The Schedule Type dropdown is
beneath the Properties section.

Important CSV information

Beginning the CSV row with a #

In the CSV file, should the row begin with a number
sign (#), that row will be treated as a comment, and
will not be processed.

Multi-Choice Values

If attempting to set a multi-choice field with multiple
values the values should be separated by a
semicolon and a number sign combination in the
CSV file: Value1;# Value2.

Estimated Start/Estimated End

Estimated Start and Estimated End dates in
OnePlan are special fields within OnePlan. These
dates will change if there are any tasks within

the Schedule section of the Work Plan, as those
values have a higher precedence than the values
within the integration/API call.

@ OnePlan
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Jira Integration

Jira Epics Integration - 1. Log into your OnePlan group using your
. . Office365 account.

Integratlon Overview 2. Open the Admin pages by clicking on the

This article describes the Jira Epics to OnePlan Settings (gear) icon.

Plans integration, and how it functions. 3. Select Integration on the Admin Navigation

The following viFieo detgils how the Jira Epics to 4. réTiZEI"[heﬂplus) icon in the Authentication

OnePlan Plans integration works. Keys

/player.vimeo.com/video/757711751 5. Save the App Name and the Keysomewhere
safe, as this will give any program access to

This integration has these main use cases for your OnePlan group. The key will no longer

functionality. be viewable once the page refreshes or you

navigate elsewhere.
1. Create/Update Epic level item type in Jira

2. On creation, user will be required to specify the
Project where the epic will belong in Jira

3. Create/Update plan in OnePlan Jira
4. Create/Update backlog in OnePlan from Jira NOTE: There are clickable links within this video.
issue types associated with the connected
project For the integration configuration, you will need to
5. Issue types synchronized are based on the collect the following information from Jira:

ones specified in OneConnect
« Jira URL (e.g.,https://

OnePlan Jira <organization>.atlassian.net)
Plan: Epic 1 Project 1 » Jira username
Epics User Stories . APl token
Tasks Bugs
Project 2 To generate an API Token in Jira:
Epics User Stories
i 1. Log into Jira.
6. 2. Navigate toatlassian.com/manage-profile/
security/api-tokens.
Jira Epics Integration - 3. Click Create API Token. A new window will
Integration Setup appear.

4. Give the API Token a unique Label.

5. Click Create. The API Token will appear.

6. Click Copy. Green text will appear below the
OnePlan API Token field saying: API token copied to
clipboard.

This article explains how to set up the integration
between OnePlan Plans and Jira Epics.

For the integration configuration, you will need to

collect the following information from OnePlan: 7. Click Close.
« the group name OneConnect
* an authentication key To complete the OneConnect setup, you need to be
« the authentication key name an Administrator or Editor in the OneConnect group

you wish to set the integration up in.
To complete the OnePlan setup, you need to be an

admin (user with Owner permissions) in OnePlan. 1. Go to https://my.oneconnect.ai
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2. Navigate to Jira Epics and OnePlan Plans.
Click the Configure.

= Jira Epies and OnePian Plans

OnePlan Section

1.  Group Name: Enter theOnePlan Groupname
you will be integrating into.

2. Authentication Key: Enter the
OnePlanAuthentication Keygenerated from
OnePlan.

3. (Optional) OnePlan URL: For clients that have
their oneplan.ai hosted outside of the United
States, please enter the OnePlan URL used

K

NOTE

Options currently

are: https://au.oneplan.ai,
https://ca.oneplan.ai, https://
eu.oneplan.ai.

4. ClickNext.

Jira Section

Expand the Additional Options area to see all the
necessary fields to be filled in.

1. Jira URL: Enter the Jira URL (e.g.,https://
<organization>.atlassian.net).

2. Username: Enter the Jira username to be
used to access environment.

3. Jira API Token: Enter the API Token to access
Jira account.

4. Jiralssues to OnePlan Backlog: Enter the
list of Jira issue types that will be brought into
OnePlan as backlog items. Defaults are Task,
Bug, and Story.

5. Jiralssue to OnePlan Plan: If no value
is brought into this field, Epic in Jira will
be brought into OnePlan at the Plan level
(regardless of Project).

6. (Optional - Checkbox) Sync with next-gen
Jira: (Default) When unchecked, only the older
versions of Jira can be synched between

OnePlan and Jira. If using next-gen Jira (aka
team-managed projects), check the box to
enable synching between Jira and OnePlan.

7. (Optional - Checkbox) Sync all issues in
the backlog: (Default) When checked the Jira
Issues to OnePlan backlog field will be ignored,
and all issues associated to the Jira Epic will
be brought in to OnePlan backlog.

8. (Optional - Checkbox) Roll up sub-tasks,
and resources to its parent: (Default) When
unchecked, Jira backlog items in OnePlan will
be assigned to their own task. If checked, all
the child backlog items that have unique user
assigned to them will “roll up” to the parent
backlog item.

9. (Optional - Checkbox) Utilizing Jira Server:
(Default) When unchecked, access to Jira will
go through the cloud.

10. (Optional - Checkbox) Always ignore
delta at Epic level sync: (Default) When
unchecked, if the scheduled job runs on
Deltas, the strategy will only pick up items
that have been modified at the plan level only.
When checked, the strategy will pick up the
task / backlog items that have been modified
as well.

The following video walks through each optional
setting.

Jira Epics Integration - Default
Field Mappings and Scheduled
Strategies

This article explains the Jira Epics to OnePlan
Plans default field mappings for your integration.

The following video walks though the default field
mappings for the Jira Epics and OnePlan Plans
integration.

Check the Field Mappings

After the integration is installed, it is best practice
to check the default field mappings for errors or
missing mappings.

After reviewing the field mappings, continue on to
Jira Integration - Custom Types Settings [144].
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Integration Information

Functionality

This integration has these main use cases for
functionality.

1. Create/Update Epic level item type in Jira

2. On creation, user will be required to specify the
Project where the epic will belong in Jira

3. Create/Update plan in OnePlan

4. Create/Update backlog in OnePlan from Jira
issue types associated with the connected
project

5. Issue types synchronized are based on the
ones specified in OneConnect.

Default Field Mappings

Plans - Epics

OnePlan Jira Direction Notes
Fields Fields
Name Summary Both Required
Jira Project Both Required
Project Name
Names (Epic)
Owner Assignee Both Recommended
Backlogs — Issues
OnePlan Jira Fields Direction Notes
Fields
Name Summary Both Required
Parent Id Parent Both
(Structure) Issues ID
Assigned To Assignee JIRA to OP
Start Start Date JIRA to OP
(Sprint)
Due End Date JIRA to OP
(Sprint)
Item Type Issue Type JIRA to OP
Points Story JIRA to OP
Points
Iteration Sprint JIRA to OP
(OnePlan Name (With
System) Board)
Status Status JIRA to OP
Effort Original JIRA to OP
Estimate

Lookup Tables — Lookup Tables

OnePlan Jira fields Direction Notes
Fields

Jira Project Project Both Required
Names (Plan) Names

Default Scheduled Strategies

The following scheduled strategies are installed by
default:

* SynchLookup - SynchLookup will synchronize
the list of Project Names from Jira into the Jira
Project Names dropdown within OnePlan.

* OnePlanUpdate - Publish data from Jira to
OnePlan.

This strategy will bring in all Jira Epics and

their associated issues into OnePlan. It is
recommended that a filter be put in place to limit
what Epics are desired to be brought over.

* OnePlanPublish - Publish data from OnePlan to
Jira.

This strategy has a filter within the OnePlan —
Jira > Plans - Epics section. This filter will only
bring plans from OnePlan over to Jira if the Jira
Project Names field has a value selected. If
this filter is removed (and not replaced with an
alternative filter), the strategy will fail for each
plan that does not have this field filled in within
OnePlan.

Jira Epics Integration -
Integration Recommendations
and Best Practices

Error: One of the specified issue type
does not exist in Jira!
OnePlanUpdate, in the GetEachlssueChildren

function, there is an error of: Error: One of the
specified issue type does not exist in Jira!

This may indicate that the client is using the next-
gen Jira. Also known as Team-managed.

Please go back into the Integration tab and check
the Utilizing next-gen Jira.
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Jira Project Integration -

Integration Overview
This article describes the Jira Projects to OnePlan

Plans integration, and how the integration is similar

and how it differs from the Jira Epics to OnePlan
Plans integration.

The following video describes the similarities and
differences between the two Jira integrations.

This integration has these main use cases for
functionality.

1. Create/Update project in Jira

2. On creation, user is able to select Jira project
types

3. Create/Update plan in OnePlan

4. Create/Update backlog in OnePlan from Jira
issue types associated with the connected
project

5. Issue types synchronized are based on the
ones specified in OneConnect

OnePlan Jira

Project 1

Project 1

Jira Project Integration -
Integration Setup

This article explains how to set up the integration
between OnePlan Plans and Jira projects.

OnePlan

For the integration configuration, you will need to
collect the following information from OnePlan:

» the group name
+ an authentication key
+ the authentication key name

To complete the OnePlan setup, you need to be an
admin (user with Owner permissions) in OnePlan.

1. Log into your OnePlan group using your
Office365 account.

2. Open the Admin pages by clicking on the
Settings (gear) icon.

3. Select Integration on the Admin Navigation
panel.

4. Click the + (plus) icon in the Authentication
Keys

5. Save the App Name and the Key somewhere
safe, as this will give any program access to
your OnePlan group. The key will no longer
be viewable once the page refreshes or you
navigate elsewhere.

i OnePlan
Authentication KeysD

Add Key

Aftar the key is created, be sure to copy and store in saf location. You will
otbe able to recover the key

Jira
For the integration configuration, you will need to
collect the following information from Jira:

« Jira URL (e.g., https://
<organization>.atlassian.net)

 Jira username

* API token

To generate an API Token in Jira:

1. Loginto Jira.

2. Navigate to atlassian.com/manage-profile/
security/api-tokens.

3. Click Create API Token. A new window will
appear.

4. Give the API Token a unique Label.

5. Click Create. The API Token will appear.

6. Click Copy. Green text will appear below the
API Token field saying: API token copied to

clipboard.
7. Click Close.
OneConnect

To complete the OneConnect setup, you need to be
an Administrator or Editor in the OneConnect group
you wish to set the integration up in.
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*  Go to https://my.oneconnect.ai

Navigate to Jira Project and OnePlan Plans. Click
the Configure button.

OnePlan Section

1.  Group Name: Enter the OnePlan Group
name you will be integrating into.

2. Authentication Key: Enter the OnePlan
Authentication Key generated from OnePlan.

3. (Optional) OnePlan URL: For clients that have
their oneplan.ai hosted outside of the United
States, please enter the OnePlan URL used.

K

NOTE

Options currently

are: https://au.oneplan.ai,
https://ca.oneplan.ai, https://
eu.oneplan.ai.

4. Click Next.

OneRian

OmnePlan Group Name (Enter the name of the OnePlan group that you sre connecting
to here) ©

OnePlan Authentication Key (Enter the OnePlan authentication key that has been

generated from the OnePlan integration admin page here)

integration Eey Name (Only use this when connecting to GnePlan OData, otherwise

please leave it blank)

Jira Section

Expand the Additional Options area to see all the
necessary fields to be filled in.

1. Jira URL: Enter the Jira URL (e.g., https.//
<organization>.atlassian.net).

2. Username: Enter the Jira username to be
used to access environment.

3. Jira API Token: Enter the API Token to access
Jira account.

4. JiralIssues toOnePlan Backlog: Enter the list
of Jira issue types that will be brought into
OnePlan as backlog items. Default values are
Task, Bug, and Story.

O i

Wouwr Jira URL.

Usermname

AP Token

b Addmionasl Options

5. (Optional - Checkbox) Sync with next-gen
Jira: (Default) When unchecked, only the older
versions of Jira can be synched between
OnePlan and Jira. If using next-gen Jira (aka
team-managed projects), check the box to
enable synching between Jira and OnePlan.

6. (Optional - Checkbox) Utilizing Jira Server:
(Default) When unchecked, access to Jira will
go through the cloud.

7. (Optional — Checkbox)Adding unassigned
issues: When projects are updated, it will set
the project’s assignee to Unassigned instead of
Project Lead (Default Value).

Jira Epics Integration - Custom
Types Settings

This article explains how to configure the custom
types settings for the Jira Epics to OnePlan Plans
integration.

Then following video walks through the steps to
configure custom types for the Jira to OnePlan
integration.

Configure Custom Types

Jira allows users to configure custom issue and
epic types. To allow those custom types to sync to
OnePlan via the integration, you must configure the
integration settings to allow the desired item types.
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Configure Issue Types

1.  Go to the OneConnect integration configuration
tab.

2. Go to the Integration tab > Jira.

3. Inthe Issue Types field, type in the desired
Jira issue types. Separate each type with a
comma.

NOTE: The default issue types are Task and
Bug.

4. To prevent a type from syncing to OnePlan,

remove the type name from the field.

Configure the Epic Type

If users are using a custom hierarchy, use this
setting to map OnePlan Plans to the desired Epic
type.

1. Go to the OneConnect integration configuration
tab.

2. Go to the Integration tab > Jira.

3. Inthe Epic Type field, type in the desired Jira
epic type.
NOTE: The default epic type is Epic.

Once the Issue and Epic types are configured,
continue on to Jira Integration - Essential Settings.

Jira Project Integration - Default
Field Mappings and Scheduled

Strategies

This article explains the Jira Projects to OnePlan
Plans default field mappings for your integration.

To complete the Jira integration setup, you must
complete:

1. Jira Integration - OnePlan Setup [140]

2. Jira Integration - Jira Setup

3. (You are here)Jira Integration - Projects Field
Mappings [145]

4. Jira Integration - Custom Types Settings [144]

5. Jira Integration - Essential Settings

Check the Field Mappings

After the integration is installed, it is best practice
to check the default field mappings for errors or
missing mappings.

After reviewing the field mappings, continue on to
Jira Integration - Custom Types Settings [144].

Integration Information

Functionality
This integration has these main use cases for
functionality.

1. Create/Update project in Jira

2. On creation, user is able to select Jira project
types

3. Create/Update plan in OnePlan

4. Create/Update backlog in OnePlan from Jira
issue types associated with the connected
project

5. Issue types synchronized are based on the
ones specified in OneConnect

Default Field Mappings

Plans - Projects

OnePlan Jira Fields Direction Notes
Fields
Name Project Both Required
Name
Jira Project Project Both Required
Types Types
Owner Lead Both Required
Backlogs - Issues
OnePlan Jira Direction Notes
Fields Fields
Name Summary Both Required
Parent Id Parent Both Recommended
(Structure) Issues ID
Lookup Tables - Project Types
OnePlan Jira Direction Notes
Fields Fields
Jira Project Type Both Required
Types (Plan) Name

Default Scheduled Strategies

The following scheduled strategies are installed by
default:

» SynchJiraProjectTypes -
SynchJiraProjectTypes will synchronize the list of
Jira Project Types to the OnePlan choice field
Jira Project Types.

* OnePlanUpdate - Publish data from Jira to
OnePlan.
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This strategy will bring in all Jira Projects
and their associated issues into OnePlan. It is
recommended that a filter be put in place to limit
what Projects are desired to be brought over.

» OnePlanPublish - Publish data from OnePlan to
Jira.
This strategy will bring in all OnePlan Plans
and their associated backlogs into Jira. It is
recommended that a filter be put in place to only
bring in Plans that have a Jira Project Type filled
in be brought over to Jira for the strategy to not
fail.

Jira Project Integration -
Integration Recommendations
and Best Practices

Set Jira Project Category As OnePlan
Portfolio Plan Type

For the Jira Project to come into OnePlan as a Plan
type (Epic, Project, Portfolio, etc.) there needs to be
a field at the Project Settings page in Jira that tells
OneConnect where to set the Project in OnePlan.

Most clients set the Category dropdown as the field
to use.

Jira

1. Log into Jira.

2. Click on a Project.

3. On the left navigation bar click on Project
Settings. This will load the Project Details
page.

4. Locate Project Category, expand the
dropdown or click on the i next to the
dropdown.

5. Click on Manage Categories/Add a New
Project Category. A new page will load with
all the current categories created.

6. Towards the bottom of the page, give the name
the title of the OnePlan Portfolio Plan type
(OOTB options are Portfolio, Program, Project,
Epic).

7. For each Project that is wished to be brought
in, make sure the Jira Project Category has the
correct OnePlan Plan Type.

OneConnect

1. Log into OneConnect.

2. Locate the integration and click on the pencil
icon to edit the integration.

3. Expand the Mappings dropdown, select
Fields.

4. Expand the Plans — Projects section

5. Map OnePlan Portfolio Plan Type to Jira
Project Category.

Add Jira Project Types to Plan Details
Form

For a plan that is created in OnePlan to be brought
into Jira, the Jira Project Types filed must be filled
in. To show the Jira Project Types field for any of
the OnePlan Plan types used, it must be added to
the Plan Details form.

1. Navigate to the OnePlan Configuration page.

2. On the left navigation panel, click Plan Details.

3. Inthe Plan Type dropdown, select the plan
type you wish to add the Jira Project Type field
to.

4. Locate the Jira Project Type field on the
top left box and drag the field to the desired
location.

5. Click Save.
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OneAnalytics Integration

. 3. Complete the integration configuration form.
OneAnalytics (SQL Server) a. Complete the OnePlan section.

Integration - Integration Setup

NOTE

Expand the Additional
Options area to see all
the necessary fields to be
filled in.

This article explains how to set up the OneAnalytics
for OnePlan integration.

OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan. If the Advanced Settings
are enabled for your group, continue to the next
steps. If the Advanced Settings are NOT enabled,
contact OnePlan for assistance. .

* Group Name: Enter the OnePlan Group
name you will be integrating into.
Authentication Key: Enter the OnePlan
Authentication Key generated from
OnePlan.

(Optional) Alternate OnePlan

1. Log in to your OnePlan group with your
Office365 account. .

2.  Open the Admin pages by clicking on the Environment URL: If using an
Settings gear. alternative environment than https:/
3. Select Integration in the admin navigation. my.oneplan.ai, please enter the

4. Click the + (plus) icon in the Authentication
Keys section.

5. Save the key name and generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.

appropriate URL here.

K

NOTE

Options currently are
https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

i OnePlan

+ OData ID: This can be found in
theintegration tab within the OnePlan
configuration page. The ID is in the
Reporting Info field. The ID should
look like this format: XXXXXXXX-XXXX-
XXXK-XXKX-XXXXK-XXXKXXXX.

+ OnePlan OData Table names: This will
be the list of OnePlan OData tables that
will be brought over to SQL.

+ Columns to Snapshot (Optional): This
field is optional for those who wish to
snapshot only specific fields
fromOnePlan. The format in which to
snapshot specific fields must be in

OneConnect Setup

To complete the OneConnect setup, you need to be
an Administrator or Editor in the OneConnect group
you wish to set the integration up in.

1. Go to hitps://my.oneconnect.ai Table{Field} format
) . pS.//my.- o (Resources{Name,Userld,Email, Generic
2. Navigate to OnePlan SQL Server (v2) . )

Click the Configure button. The integration
configuration form will open.
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* Choice Column for Time Tracking
(Optional): This field is optional for
those who wish to snapshot choice
field values. This is used when specific
fields can have time between their last
updates tracked. These columns should
be listed in this field.

b. Click Next.
c. Complete the SQL Server (v2) section.

» Server: Enter the server name that will
host the data being accessed.

+ Database: Enter the name of the
database that will be used for this
integration.

» Username: Enter the username of
the account that has access to the
database. This user must have read and
write access to the database.

» Password: Enter the password to the
username being used in the above field.

d. If using SQL Server On-Premises, a relay

may be required. To understand what a

relay is, see What is a Relay?. [19] For

information on a relay installation, see

Relay Installation.

e. Click Next.

OneAnalytics Integration -
Default Field Mappings and
Scheduled Strategies

This article describes the default field mappings
and scheduled strategies that are set up when the
OneAnalytics integration is installed.

WARNING

Please be advised that if

you want to use both the
OnePlan_to_SQL_OneAnalytics
and TakeOnePlanSnapshot
strategies, we highly recommend
that two separate integrations be
made. Both strategies use the
OData Table Name field, so if there
are different tables that are to be
snapshot than backed up, this can
cause unnecessary tables to be
created for the client.

A

Default Field Mappings

There are no default field mappings for this
integration. All fields will be brought over into SQL
automatically.

Default Scheduled Strategies

OnePlan_to_SQL_OneAnalytics: This strategy
allows you to sync data from OnePlan to SQL
Server for OneAnalytics.

Optional Strategies

TakeOnePlanSnapshot: This strategy takes a
snapshot of OnePlan OData tables to SQL Server
for OneAnalytics.

For more information on OnePlan oData tables,
please see oData Table Dictionary.

OneAnalytics Integration -
Snapshots

This article explains how snapshots function in the
OneAnalytics integration.

Snapshot Frequency
Snapshots can be taken up to once a day.

Snapshot Data Options

oData Table Names: Snapshots currently can be
done for all tables listed in the following table. All
tables that are listed within this field will be queued
up to be snapshot regardless of the other two fields
below.
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Activities Plan_Epic Plan_Project ResPlanLog
Assignments Plan_ldea PlanDependency StatusReports
Association Plan_KeyResult Planinsights Tasks

Costs Plan_Obijective Plans TimeOff
ModelerModel Plan_Portfolio RateTable TimesheetAudit
ModelerScenarioPlan Plan_Program Resources

S NOTE
Snapshots can be done for all out

of the box oData tables except
for Capacity, ResPlan, Timesheets,
and Teams.

Columns to Snapshot: To ensure that the proper
columns are being snapshotted, the value here
must be in Table{Field} format. This is to elaborate
further from the list of tables from the OData Table
Names field and focuses on specific fields that are
desired to be snapshot.

» What happens if no values are entered?

If no values are entered within this field, all
columns within the OData Table Names field will
be snapshot.

» What happens when values are entered?
When the values of TableName{Field1,Field2}
are entered within the Columns to Snapshot
field, those specific tables will be queried for
the snapshot. Once the TakeOnePlanSnapshot
strategy has run, a new table will be
created within SQL with the name of
OnePlan_Snapshot_TableName.

Choice Column for Time Tracking

* What happens when values are entered?
When choice fields are listed, a new Snapshot
table will be generated for any table that has the
choice field listed, regardless of the table that has
the choice value.
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Power Apps Entities to OnePlan

Plans

This article explains how to set up the integration
between Power Apps entities and OnePlan plans.

Before beginning, the following assumptions are
made in order for this integration setup to be
successful:

+ Office 365 is up and running

* A Power Apps or Dynamics environment is up
and running

* OnePlan group is set up in the same Office365
tenant

OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan.

1. Log in to your OnePlan group with your
Office365 account.

2. Open the Admin pages by clicking on the

Settings gear.

Select Integration in the admin navigation.

4. Click the + (plus) icon in the Authentication
Keys section.

5. Save the key name and generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.

w

i OnePlan

Users || Authentication Key
Pp N "

App Nam: y
Calendars P e ey
Reporting e
Fields
Reporting  \gree
Calculations e I

To allow integration to this tenant, p

st 7
" pgaxey N

Work Plan~~ Befy t

. . | Afte the key is created. be sure to copy and store in safe location. You will |

Subscription ot be able to recover the key

Key Neme:

OneConnect Setup

1. Go to https://my.oneconnect.ai

Power Apps Integration

2.

Configure the following integration: Power
Apps Entities to OnePlan. Click

the Configure button. The integration
configuration form will open.

Integrations

&

Power Apps Entities to OnePlan Plans
Connect and syncronize entities items from Power Apps to OnePlan plans

Power Apps Section

‘ Power Apps

Authorization

Click here to spprove consent to use the dafault Power Aops 3pp registration for this tenant (Admin

Required).

Client Id (Azure App Id)

Only use this if you're planning on using your own App registration.

PowerApps Url "

Enter the Url of the PowerApps environment you are connecting to, .g. hitps://aneplan.crm.dynamics.com/

Username

The sccount used needs to have the following: @ PowerAops License, snd thase permissions: System Admin

2ng System Customizer in the PowerApps environment you are connecting to.

Password

}  Additional Options
}  Advanced Options

}  Relay Options

Authorization: Click on the Authorize button
to approve consent to use the default

Power Apps app registration. Review the app
authorization information in the popup, and
click Accept.

NOTE

See How to approve consent
for more information.
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@ login.microsoftonline.com/common/reprocess?ctx=rQQIARA...

B= Microsoft

admin@m365x96431758.onmicrosoft.com

Permissions requested
Review for your organization

,.l OneConnect for Dynamics
®_¢ my.oneconnect.ai

This application is not published by Microsoft or your
organization.

This app would like to:

~ Signin and read user profile

v Access Common Data Service as organization users

If you accept, this app will get access to the spedified resources for all
users in your organization. No one else will be prompted to review these
permissions.

Accepting these permissions means that you allow this app to use your

data as specified in their terms of se and privacy statement. You can
change these permissions at https://myapps.microsoft.com. Show details

Does this app lock suspicious? Report it here

Client Id (Azure App Id): Only use this field if
you are not using the default Power Apps app
registration for this integration. Enter your App

Id. See Step 8: Complete the PowerApps setup

actions for instructions on how to create and
collect your own Application Registration Id.
Power Apps Url: Enter the URL of the Power
Apps environment you are connecting to.

Username: Enter your Power Apps username.

Account needs a Power Apps license, System
Admin and System Customizer permissions
in the Power Apps environment you are
connecting to.

Password: Enter your Power Apps password.
Additional Options: Enter the entity name to
be synchronized ("oneplan_project" entity for
adaptive PPM).

Click Test. If the connection test is successful
(you will see a natification), click Next.

- -
B® Sign in to your account - Google Chrome = O #

https://login.microsoftonline.com/common/reprocess?ctx=rQQIARAAUZDUYbU... -,

OnePlan Section

OnePlan

OnePlan Group Name (Enter the name of the OnePlan group that you are connecting to
here) *

OnePlan Authentication Key (Enter the OnePlan authentication key that has been
generated from the OnePlan integration admin page here)

Integration Key Name (Only use this when connecting to OnePlan OData, otherwise
please leave it blank)

» Additional Options
¥ Advanced Options

¥ Relay Options

1. OnePlan Group Name: Enter the name of the
OnePlan group that you are connecting to.

2. Authentication Key: Enter/paste the OnePlan
Key that you saved from the earlier OnePlan
Setup [150] steps.

Integration Key Name: Leave blank.
(Optional) OnePlan URL: For clients that have
their oneplan.ai hosted outside of the United
States, please enter the OnePlan URL used.

K

NOTE

Options currently

are: https://au.oneplan.ai,
https://ca.oneplan.ai, https://
eu.oneplan.ai.

5. Click Test. If the connection test is successful
(you will see a notification), click Next.

Filter and Field Mapping

A filter must be added to the OneConnect filters, to
distinguish which projects in Project for the Web are
to synchronize with OnePlan. Add a filter for only
Projects that don't have a blank ID, in other words,
don't include projects that don't have a mapped
OnePlan plan. The ID fields referenced in the filter
must also be mapped in the field mappings section.
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OnePlanUpdate

‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘

ccccc

Integration Information

Functionality

This integration has two main use cases for
functionality.

1. Create or Update plans from OnePlan as a
Project in Project for the Web

2. Create or Update tasks from Project for the
Web into OnePlan schedule

Scheduled Jobs

The following scheduled jobs are installed by
default.

1. SynchLookups
» Synchronize any mapped lookup/options set
fields’ choices from Dynamics into OnePlan
2. OnePlanUpdate
» Synchronize projects and tasks from Project
for the Web to OnePlan
3. OnePlanPublish
* Synchronize OnePlan plans into Project for
the Web as projects

Default Field Mappings
Plans (OnePlan) <--> Projects (Project for the Web)

OnePlan Fields Project for the Web Direction
Fields

Name Name Both

Effort Effort Both

Tasks (OnePlan) <--> Tasks (Project for the Web)

OnePlan Fields Project for the Web Direction
Fields

Name Project Task Name Both

Effort Effort Both

Assigned To Assigned to Both

Power Apps and Teams

Integration: Power Apps (Adaptive PPM Solution) to
Teams

* Only for use on 'Adaptive PPM Solution' - This
will only currently work if the Project entity name
is: oneplan_project

* Dynamics connector, same setup/config as other
integrations.

» Teams connector:

* Provide the following link to a Global Admin for

a tenant:

» OneConnect for Teams (App)

* https://login.microsoftonline.com/common/
oauth2/authorize?
client_id=f166764a-8e6c-433a-
adf5-41e00045b50b&response_type=code&
prompt=admin_consent&redirect_uri=https://
portal.office.com
* Once they’'ve ‘Approved’ the app, they’ll be

redirected to portal.office.com - that’s the
expected result.
+ Use the following Client Id:
f166764a-8e6¢c-433a-adf5-41e00045b50b

+ If using this client id, no Client Secret is

required.
* Under Additional Options:

» Default Owner Email: Can be left blank,
unless they want to have a specific person
be added as an Owner to any Teams created
from the integration.

* Group Name Prefix: Can be left
blank. Typically only used for DEV/QA
environments, e.g. ‘DEVENV_’ will be added
to any Team created from the integration.

» Tenant Id: Tenant ID for the tenant... If you're
logged in with one of their accounts, you can
get it from OneConnect > Settings > Tenant
Information > Id
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ServiceNow Integration

ServiceNow and OnePlan
Integration

' Serviceblow to GnePlan

) s ) ) . 3. Complete the Configuration form.
'tl)'h’:s artlclg exlgllalns hdog to _setNup the integration a. Complete the ServiceNow section:
etween nerlan and ServiceNow. + ServiceNow URL: Enter the client’s
This integration focuses on bringing in list items f_erv:ceNow msta:ce URL (i.e., https://
from a ServiceNow table into OnePlan. instance-name>.service-now.com).
* Username + Password: Enter the
OnePlan Setup username and password of the account
In order to do the OnePlan setup, you need to be . E:at v.wll Ze co.:_mslc t!nglto S.e;v |::el\:2w.
an admin, meaning you are a user with Owner erviceNow 1a ‘.a' ans. n ertne
o : . table name of the items that will be
permissions in OnePlan. If the Advanced Settings b ht into OnePI Plan level
are enabled for your group, continue to the next _trougThlntObl nertan as at bart\heve
steps. If the Advanced Settings are NOT enabled, ftem. The table name must be the
contact OnePlan for assistance backend table name (custom tables
' will often have the u _<customtable>
1. Log in to your OnePlan group with your format).
Office365 account. » ServiceNow Table: Tasks (Optional):
2. Open the Admin pages by clicking on the Enter the table name of the task
Settings gear. items created within OnePlan that will
3. Select Integration in the admin navigation. be brought into ServiceNow as. The
. . . o table name must be the backend table
4. Click the + (plus) icon in the Authentication .
Keys section name (custom tables will often have the
' <customtable> format).
5. Save the key name and generated key u_set )
somewhere (such as in a notepad doc), as (1) sereceicn
once you navigate away, the key cannot be
seen. To be used at a later step in the Bacviceon Uit
OneConnect configuration.
LT it
i OnePlan
oooo Prapcts - Crwy Fibas
= Plas Spact
Tark Ojrct
Integration Setup b Aduwnces
1. Go to https://my.oneconnect.ai. >
2. Locate the ServiceNow to OnePlan n
integration. Click Configure.
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b. Click Save.
c. Complete the OnePlan section:

* OnePlan Group Name: Enter the
OnePlan group name that this
integration will connect to.

* OnePlan Authentication Key: Enter
the OnePlan Authentication Key that
was created and saved earlier.

* (Optional) OnePlan URL.: For clients
that have their oneplan.ai hosted
outside of the United States, please
enter the OnePlan URL used.//

K

NOTE

Options currently are:
https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

Cralan

OnePlan Group Hame (Enter the name of the OnePlan group that you are connecting
to here) "

OnePlan Authentication Key (Enter the OnePlan authentication key that has besn
generated from the OnePlan integration admin page here)

Integration Key Name [Only use this when connecting to OneFlan OData. otherwise
pleaze leave it blank)

d. Click Save.
Integration Information

Scheduled Jobs

There are no scheduled strategies automatically set
up by default.

To add a schedule, click Add Schedule, choose
the strategy desired, and then fill out the
appropriate information. Click Save.

Field Mappings
Currently, we do not have default field mappings for
this integration.

All possible field names for the tables will appear
when selecting the dropdown list on either side,
select the fields desired to be mapped to, then click
on the blue plus button on the right.

To change the direction of the field mappings, click
on the arrows between the fields until the desired
direction has appeared.

Available Strategies
ServiceNowToOnePlan

The ServiceNowToOnePlan strategy brings in tasks
from ServiceNow into OnePlan as a plan level item.
The tasks being brought in will be from the table
that was listed in the ServiceNow Table: Plans field
when setting up the integration.

SyncOnePlanToServiceNow

The SyncOnePlanToServiceNow strategy will grab
all tasks created within OnePlan (tasks are in

the Work Plan — Schedule section) and move
those work items to ServiceNow table listed in the
ServiceNow Table: Tasks field.

IMPORTANT

It is highly recommended that
there is a field mapping

from ServiceNow to the

OnePlan Plan Id (that is
bidirectional), this will allow

the SyncServiceNowToOnePlan to
run.

SyncServiceNowToOnePlan

The SyncServiceNowToOnePlan strategy will bring
in any list item within the ServiceNow table listed
as the ServiceNow Table: Tasks, and if that item is
mapped to a OnePlan Plan Id, it will be brought into
OnePlan as a task.

Bring in a List Item from
ServiceNow into OnePlan

To test the integration against a single item from
ServiceNow, and bring that item into OnePlan, will
involve a few steps.
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Decode the ServiceNow plan Id.

a.

Open a new tab in your browser and
type: URL DECODER. Click enter. Select
any of the encoders available (we use
meyerweb.com).

While in a plan (viewing the plan form),
copy and paste the ServiceNow URL and
paste it in the text box for the decoder.
Click Decode.

Once the URL has been decoded, look
through the text for sys_id=. This will
signify the beginning of the plan id. After
the = sign begin to highlight and copy this
section of the URL until you find the &.
This number, &, letter sequence will be the
plan id.

Input the ServiceNow Plan Id into the
ServiceNowToOnePlan strategy.

a.

d.

While logged into OneConnect, navigate
to the ServiceNow to OnePlan integration,
and click on the schedules button
(Calendar icon).

While in the schedules area, click on the
lightning bolt icon to begin running the
strategy. A new window will appear.

Paste the ServiceNow plan Id in the item
id text field.

Click Execute.

Confirm data is coming into OnePlan correctly.

Look into OnePlan and locate the plan,
and all the relevant information that has
been mapped looks correct.

@ OnePlan
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Smartsheet Integration -

Integration Setup

This article explains how to set up the Smartsheet
with OnePlan integration.

This integration focuses on Sheets in Smartsheet
becoming Plans in OnePlan, and the rows within
Smartsheet will appear as Schedules items in the
OnePlan Work Plan. The reverse is also possible,
plans within OnePlan will become a sheet in
Smartsheet, and any Scheduled items in OnePlan
Work Plan will become a row item in Smartsheet

OnePlan Setup

In order to do the OnePlan setup, you need to be
an admin, meaning you are a user with Owner
permissions in OnePlan. If the Advanced Settings
are enabled for your group, continue to the next
steps. If the Advanced Settings are NOT enabled,
contact OnePlan for assistance.

1. Log in to your OnePlan group with your
Office365 account.

2. Open the Admin pages by clicking on the

Settings gear.

Select Integration in the admin navigation.

4. Click the + (plus) icon in the Authentication
Keys section.

5. Save the key name and generated key
somewhere (such as in a notepad doc), as
once you navigate away, the key cannot be
seen. To be used at a later step in the
OneConnect configuration.
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Smartsheet Integration

Smartsheet Setup

Generate a Smartsheet APl Access
Token

|§ NOTE
To generate an API Access Token

account must have either Pro,
Business, or Enterprise Plans.

1. Log into Smartsheet.

2. Goto Account > Apps & Integrations.

3. Click on API Access.

4. Click Generate new access token. A window
will appear.

5. Enter an API Access Token Name. Click Ok.

6. The API Access Token will be generated on the
next page.

Locate a Smartsheet Template Id

S NOTE
To find the Template ID, a

Template must be made in
Smartsheet.
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1. Click on the Browse (folder) Icon.

2. Locate the Template that will be used, right
click on the template name to expand options.

3. Click on Properties... The Template ID will be
in the last field at the bottom of the window.

| Smartsheet Template for OnePlan

OneConnect Setup

E NOTE
To complete the OneConnect

setup, you need have
Administrator or Editor privileges in
the OneConnect group you wish to
set the integration up in.

1. Go to https://my.oneconnect.ai

2. Locate the OnePlan to Smartsheet
integration. Click the Configure button. The
integration configuration form will open.

u OnePlan and Smartshest

3. Complete the integration configuration form.

@ NOTE
Expand the Additional

Options area to see all the
necessary fields to be filled in.

a. Complete the OnePlan section.
* Group Name: Enter the OnePlan Group
name you will be integrating into.
» Authentication Key: Enter the OnePlan
Authentication Key generated from
OnePlan.

b.
c.

* (Optional)) Alternate OnePlan
Environment URL: If using an
alternative environment than https://
my.oneplan.ai, please enter the
appropriate URL here.

|§ NOTE
Options currently are:

https://au.oneplan.ai,
https://ca.oneplan.ai,
https://eu.oneplan.ai.

o
\_1‘; CnelPlan

Group Name

Authentication Key

v Ky is generated in the integration tab within the OnePlan configuration

Authentication Key Name

whher connecting to OnePlan OData

»  Additional Optiens
»  Advanced Options

» Relay Options
[ |

Click Next.
Complete the Smartsheet section.

S NOTE
Expand the Additional

Options area to see all
the necessary fields to be
filled in.

* Username: Enter the username.

* API Token: Enter the APl Access
Token to be used with OneConnect.
See Generate a Smartsheet API Access
Token [156] for instructions.

» (Optional) Template ID: Enter the
Template ID to be used when importing
plans into Smartsheet. See Locate

@ OnePlan
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a Smartsheet Template Id [156] for
instructions.

K

NOTE

Check the Use
Template checkbox if
entering a Template ID.

NOTE

If no Template ID

is entered, any plans
that are created from
OnePlan to Smartsheet
will be created as a
simple sheet without
any columns except for
the Task Name.

K

Username

APl Token

d. Click Next.

OnePlan Changes After the Integration

is Complete

Once the integration is complete, three things will
occur in the OnePlan integration page:

* An integration line item is made.

* An integration event is created.

+ Smartsheet is now available in the Connected
Systems icon.

Integration Line Item
Each item within the Integration section shows the

OneConnect integrations connected to the OnePlan
Work Plan.

Integration Event

Integration events are automated responses that
will bring data over from OnePlan into Smartsheet.

What this event does is trigger the OnePlanPublish
strategy for any item that is connected to
Smartsheet. This will bring any values that are
mapped to go from OnePlan to Smartsheet to be
updated.

What triggers this event is after a connected item
has been saved in OnePlan. At the plan details
page, this occurs after an item has been modified
and then is automatically saved. At the task level,
this is done after editing a field, and then clicking
Save.

Connected Systems

Any plan item that is connected to Smartsheet will
show the Smartsheet icon at the My Portfolio page.

To connect an item from OnePlan into Smartsheet,
navigate to the Work Plan - Schedule page, click on
the plug icon (Connected Systems Icon) and select
the options of connecting to an existing item within
Smartsheet, or creating a new item. Once the

plan is connected, the Connected Systems window
can also be used to Import, Export, or Open the
Smartsheet item.

Smartsheet Integration - Default
Field Mappings and Scheduled

Strategies

This article details the default field mappings and
scheduled strategies installed with the Smartsheet
with OnePlan integration.

This integration focuses on Sheets in Smartsheet
becoming Plans in OnePlan, and the rows within
Smartsheet will appear as Schedules items in the
OnePlan Work Plan. The reverse is also possible,
Plans within OnePlan will become a sheet in
Smartsheet, and any Scheduled items in OnePlan
Work Plan will become a row item in Smartsheet.

Default Field Mappings

Plans — Sheets
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OnePlan Smartsheet Direction Notes
Fields Fields

Name Name Both Required

Owner Owner Both Recommended

Tasks — SheetRows
OnePlan Smartsheet Direction Notes
Fields Fields

Name Task Name Both Required

Status Status Both

Assigned To Assigned To Both

Start Start Both

Due Finish Smartsheet Recommended

to OnePlan

% Done % Complete Both

Task Predecessor Both

Dependency

NOTE

This strategy has a filter within the
Smartsheet - OnePlan &gt; Sheets
— Plans section. This filter will
only sync items that are already
mapped to OnePlan. Please talk
to your OnePlan Contact about
filtering the information being
brought in from Smartsheet. If this
filter is removed (and not replaced
with an alternative filter), all items
will be brought into OnePlan.

K

OnePlanPublish: Publish data from OnePlan to

Default Scheduled Strategies

SynchLookups: Synchronizes lookups from
Smartsheet to OnePlan.

K

NOTE

If there is no Template ID set in
the integration, all newly created
columns within Smartsheet will
appear at the Plans — Sheets table
and not the Tasks — SheetRows
tables for field mappings. Because
of this, SynchLookups will not run
as intended, and we do encourage
that the client turn off the strategy.

OnePlan Update: Publish data from Smartsheet to
OnePlan.

Smartsheet.

K

NOTE

This strategy has a filter within the
OnePlan - Smartsheet &gt; Plans
— Sheets section. This filter will
only sync items that are already
mapped to OnePlan. Please talk
to your OnePlan Contact about
filtering the information being
brought into Smartsheet. If this
filter is removed (and not replaced
with an alternative filter), all items
will be brought into Smartsheet.

Smartsheet Integration -
Best Practices and

Recommendations

This article describes integration best practices and
recommendation from the OnePlan team regarding
the Smartsheet with OnePlan integration.

This integration focuses on Sheets in Smartsheet
becoming Plans in OnePlan, and the rows within
Smartsheet will appear as Schedules items in the
OnePlan Work Plan. The reverse is also possible,
Plans within OnePlan will become a sheet in
Smartsheet, and any Scheduled items in OnePlan
Work Plan will become a row item in Smartsheet.
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End Dates on dependency-enabled
sheets cannot be created/updated
Unfortunately, Smartsheet does not allow updates
to the Finish Date on Project type sheets currently.
The finish date is automatically updated by the
duration and start dates defined beforehand.

To prevent this error from occurring in the future,
please either change the field mapping for Finish
date to only go from Smartsheet to OnePlan or
remove the field mapping completely.
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